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m editorial

Following the Tech Rainbow

very new piece of technology that comes to the fore today claims to be able

to improve our lives for the better. It promises to increase our productivity lev-
els with greater speed, the quality of our work through greater intelligence, and
eventually promises a complete transformation of our lives.

Quite obviously this isn't something that is always true. However, this is some-
thing that we seem to have grown to expect.

But is this expectation realistic? Or are we now just willing to accept any pipe
dream that is dressed as a technological advancement?

Has the technology that lies within each of our desktops today actually
improved the quality of work that we are producing? And do we now really have
more time to devote to our hobbies, friends and personal lives outside our

workplace?
e Many of us feel the need to upgrade to the latest version of applications like
Itis necessary for us Microsoft Word but many choose to ignore something as basic as the Template
to be more realistic functions in existing versions that could help us to organise ourselves better? Or
the Commenting feature which can make collaboration between people who
about what we expect share documents so much easier. We use software like Microsoft Outlook as an
from techn0|0gy” e-mail client, but choose to completely ignore the contact and time management

utilities, filtering features and the unified messaging platform that it provides.

To really unleash the potential of technology, it is necessary for us to be more
realistic about what we expect from it. We need to look at it as something that
can create opportunities, instead of expecting a magical packaged solution to all
our problems. Technology can help make our tasks easier, but it is too much to
expect it to provide us with a replacement for intelligence.

We need to look for smarter ways to utilise the technology that is already
available to us.

Ko, Maws

Karan Manral
Assistant Editor
karan_manral@jasubhai.com
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NEWS PULSE. ...

hypethesis

Microsoft .Net

A What is it?

Microsoft is building a com-
plete solution with .Net,
which transcends Web serv-
ices to deliver an Internet
experience, from desktop
and desktop services to con-
tent providers, Internet serv-
ices and ultimately, payment.

A What is the technology?
The new .Net strategy aims
to revolutionise the way
Microsoft and developers,
who work on Microsoft plat-
forms, deliver software.
Microsoft aims to phase out
delivering software per se,
and instead will deliver
these as Web services over
the Internet. Consumers of
those services will license it
as an on-demand service
and the software will, at
least theoretically, be
installed automatically.

A Should | care?

Microsoft’s desktop monop-
oly governs how over 96 per
cent of the people world-
wide access the Internet. If
it successfully ties the desk-
top monopoly to Microsoft-
held Internet properties,
.Net will be a major force to
reckon with.

SNAPSHOT

70 per cent

of all Internet porn traffic
occurs during the 9-to-5
workday (SexTracker)

The average time spent
online by workers at the
office (compared to average
9.5 hours at home) is

21 hours

Source: www.nielsen-netratings.com

14

Pump up the volume!

Loudspeakers conventionally
come in heavy, cumbersome
boxes that provide an air enclo-
sure to absorb unwanted vibra-
tion and give a fuller
sound. But now
UK-based Ellula

Sounds and US-

based SoundTube

Entertainment,

reckon an inflat-
able box will do the
job. SoundTube is
developing inflatable speakers

that bands can carry flat and
inflate when they arrive at the
venue.

A Loughborough Universi-
ty’s student spin
out company,
Ellula Sounds
has won the Best
Innovative
Product prize at
the National

Incentive Show in
UK for the new
speakers.

Adbusters get busted

Web site operators will soon
have a new tool to block the
blockers. Many Web surfers
have been weeding out banner
and pop-up ads by resorting to
software such as AdKiller,
AdSubtract, and Proxy.

Web site operators depend-
ent on ads for revenue are now
changing their act to counter
these filters. And here’s where

AdKey comes in. This software,
developed by MediaBEAM, is
currently in the beta testing
stage.

AdKey will allow operators
to deny access to users who
have installed ad filters. Such
users will will get a message
stating that they can either
switch off the filter or pay a fee
for advertising-free services.

Microsoft opens Passport ... a

Zaoson\

wee bit

[ )
Microsoft is being \

criticised for using
. . -
its might to get users -

port service. The idea

behind Passport is that users
can use it to have a unified
login to sites across the Web
instead of having five, 10, or 20
different usernames and pass-
words across a variety of Web
properties. To get the unifica-
tion benefit, users must put
their information into Pass-
port, and Web sites must also

[

C
to sign up for its Pass- e

=3 . use Passport to

= A -
= * =e— Offer a login for
NEE R .

=

their users.
A federated’ model
for Passport was
announced by Microsoft with
the goal being, “...to build an
Internet ‘trust network, where a
single, common authentication
system [is] to be used across
enterprise systems, Web sites
and services.” With this, users
will be able to choose a third-
party ‘Internet trust network
provider’ to store the data.

Diposable
Digital Camera

You don't have to drop the
camera roll at the photo shop
anymore. Just drop the entire
camera. Three Japanese com-
panies have decided to come
up with an experimental com-
mercial service involving dis-
posable digital cameras. Pentax
cameras, Sanyo Electric and
Altech have announced the
three-month trial.

- -
N
Illustrations: Farzana Cooper

The service lets users pick
up a 310,000-pixel Pentax
digital still camera, take their
photos, and then return the
camera to the store they
picked it up from. At the
store, they can view all the
photo images on a display
screen and choose the ones to
be printed.

These companies collect
the used cameras from the
stores, delete the image data,
and repack the cameras for use
again. Customers are under no
obligation to return the cam-
era to the store or collect their
prints, once the service fee is
paid. With the manufacturing
cost of the camera more than
the service fee, profitability
relies on how many cameras
can be collected and recycled.
The companies plan to
expand the services to the
Internet for data distributing
and printing.

& Salon.com begins charging ¢ Nero enables DVD creation, uses MP3PRO 4 Sony unveils DVD Walkman 4 Yahoo! to start charging for
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Redalert

KaZaA, the virus desktop
KaZaA, a file swapping appli-
cation, that is number three
on CNET for most popular
downloads, is quite likely to
infect your PC with a virus. In
fact, 6 per cent of all music
downloaded from KaZaA is
not music at all, but a virus.
Due to poor filtering, a file
like ‘I hate celine
dion.mp3.vbs’ would be dis-
played as ‘| hate celine
dion.mp3’ without displaying
the .vbs extension. Viruses
can be disguised as videos,
images and executables in a
similar fashion.

The FAQ for KaZaA says
“Not all file types can con-
tain viruses or Trojans.
Music, video, and picture
files are generally safe—that
includes files with the
extensions .mp3, .wav,
.mpg, .avi, .mov, .bmp and
.jpg. PDF documents (.pdf)
and text files (.txt) are also
generally safe. You should
be cautious of executable
files (.exe) and Microsoft
Word and Excel documents
(.doc and .xlIs). These files
are specified with an icon in
the search results on

Can you feel my
heartbeat, baby?

The Food and Drug Adminis-
tration in the US has approved
a new type of pacemaker capa-
ble of sending cardiac infor-
mation via remote
transmission. The first of its
kind, Biotronik’s Home System
can help doctors monitor a

And now MSN with vitamins!

Windows XP’s messaging
technology will undergo cos-
metic changes, allowing a

full range of emoti- _
cons, from the tradi- %
tional smiley faces to A
cats and coffee cups. 7y
Windows Messenger users n
will be able to organise con-
tacts by groups. Microsoft has
also increased the number of
contacts accepted by the mes-
saging client from 75 to 150.
Microsoft has signed on

Call Serve, Deltathree, Dialpad
Communications, Net2Phone
and Telus to offer peo-
ple equipped with
Windows Messen-
ger, the ability to
make Net-based phone
calls over their PCs. It has
also decided to collaborate
with Groove Networks. These
services will also be added to
MSN Messenger, which will be
available for download with
the XP messaging client.

Agile in a Crisis, Robots shows their mettle

Robots are proving their met-
tle at the WTC blast zone.
Their immunity to fatigue
means they can work longer
than even the most dedicated
rescue worker. Some of the
robots are small and compact
enough to go down sewage
pipes that are less than a foot
in diameter. Others can flatten

patient’s condition between
office visits. A short-range
radio frequency transmitter
sends data to a cell phone-like
device that patients carry with
them. The phone transmits the
information to a company
service centre, which correlates
the data and sends it to the
patient’s physician.

quicktake

Govind Misir, chairman and CEO, SLMSoft.com, talks about the
company’s e-commerce products

themselves to squeeze through
tight spaces or position them-
selves upright to look over
objects. Some have infrared
cameras and all have video
cameras, with images sent to
rescue workers on the surface
through a cable or wirelessly.
Most of the robots are
experimental prototypes.

A What is SLMsoft.com? Our end-to-end transaction breadth and convenience of KaZaA.com”
It is a leading Canadian global management solution, ESP-Link,  SLMsoft.com’s electronic bank-
provider of electronic financial empowers over 1,100 cus- ing and online transaction sys- BackdoorSlackbot.B

transaction solutions for the
e-commerce market. We pro-
vide e-commerce tools and
transaction management prod-
ucts and services.

A What is SLMsoft’s plan for
India in the long run?

We plan to take Design Expo’s
revenues to $5 million from
$1.9 million in the next 12
months. The first task is to
enhance our existing products
through R&D.

A What other technology solu-
tions is SLMsoft introducing?

tems, enabling them to build
rewarding relationships with
their customers and thrive in
today’s wired marketplace.

A What are the voice recognition
solutions you are planning to
introduce in India?

Right now, we are working on
different e-transaction products
like Smart Cards, and the new
products might use new tech-
nologies such as voice recogni-
tion solutions to enhance
user-friendliness, efficiency and
effectiveness of particular
products.

Govind Misir

Chairman and CEO
SLMSoft.com Inc

tomers in 55 countries. Financial
institutions, retailers, govern-
ment agencies and healthcare
providers benefit from the

Backdoor.Slackbot.B is a
backdoor Trojan that allows
a hacker to control your
computer using Internet
Relay Chat (IRC). It can
update itself by checking for
newer versions over the
Internet. This backdoor Tro-
jan contains its own IRC
client, which allows it to
connect to an IRC channel
coded into it by its creator.
Use updated anti-virus
software to delete all files
detected as Backdoor.Slack-
bot.B and remove the value
that it adds to the registry.

FIER 15

->

online dating service ¢ Samsung cranks up RDRAM chip speed by four times 4 Sanyo develops CD-ROM copy-protection system to
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L& A\ bsolute anonymity breeds absolute
irresponsibility. We need a

thumbprint Java card in the hand of

everybody in the country”

Scott McNealy, chairman and
CEO, Sun Microsystems, voicing
his long-held belief that the US
needs a national identity system

L& J think the Sun thing has absolutely
no probability of mattering to the
world. That’s my non-emotional view”

Steve Ballmer, outspoken president and CEO of
Microsoft Corporation, dismissing Sun Microsys-
tems’ efforts to compete with his company’s Pass-
port identity service as “craziness” built on a
“weak foundation”

e are delivering twice the per-
formance at every price point”

Jen-Hsun Huang, president and
CEO at nVidia, after announcing
three new graphics chips: the
GeForce 3 Ti 500, GeForce 3 Ti 200,
and the GeForce2 Ti 200

thumbnall

Streaming Media: Cost and Applications

Yeah JAVA! Not
Microsoft!

And my emotion-
al view is: | WANT
YOUR MONEY!

This new tech-
nology won't
remove lag or
make the story-

line any more
interesting for
FPS games

Sue-age

Last month Intel sued Via, fol-
lowed by Via counter-suing
Intel, but October saw a lot
more action.

Imation filed a $450 mil-
lion suit against storage rival
Quantum, accusing the latter
of monopolising the market
for the digital tape used in its
DLT drives. Daum Communi-
cations, Korea’s biggest Inter-
net portal, is seeking to ban
the sale of Microsoft’s new
Windows XP operating sys-
tem in South Korea, arguing
that it will stifle its own Inter-
net messaging product. Music
and film studios in the US
have filed a lawsuit against
three file-swapping Web sites
that enable users to download
copyrighted music and films
for free—MusicCity.com Inc.,
MusicCity Networks Inc and
Consumer Empowerment BV,
are in the line of fire. Novell
Inc filed suit in federal court
to stop competitor Microsoft
Corp from spreading “false
and misleading” statements
that Novell was shifting away
from software development to
consulting services.

Various uses of streaming media in an enterprise setting versus
consumer willingness to pay for online music services

Wieara Ara the Stresme Flowing?

Payhack scenarins for sales and marketing

“Call ya later,
I'm outta gas!”

Researchers at Motorola have
demonstrated a methane gas-
powered fuel cell, which can
provide enough juice between
two successive chargings for a
month of cell phone calls. The
fuel cell is essentially a minia-
ture electrochemical plant
where methane is stored for
producing electricity to power
the cell phone. Consumer
electronics giants NEC and
Sony are developing similar
batteries. Motorola isn't pre-
dicting when it will sell the
batteries on a wide scale. NEC
expects to begin production
between 2003 and 2005.

thermometer
Hot

MusicCity
Morpheus

This P2P network
grabs top spot in
RIAA's hit list as
Napster is crushed

Gprshot

It seems to be
going far
stronger than 3G
as of now

Cold

Transmeta
It's expecting
lower sales for its
third quarter and

and bandwidth coste is having trouble

Enterprise streaming media seetor sizes
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»$92.6875

Microsoft’s stock price

Bill Gates’ wealth

»$105 hillion

project still
moving

Shoppers may soon be assaulted with
the digital equivalent of mid-air
blimps, thanks to a Hun-
garian-US firm that
plans to manufacture
a new type of pro-
jection device. An
appliance the size
of a vending
machine will
or
images
about 16 inches in size, which the
human eye will perceive as floating in
mid-air. The two-dimensional, high-

In your face, dude!

=

definition colour images can be seen
only at certain angles in front of

the projection device.
The long-term plan is to
have many of these ter-

= minals installed and

managed by central
servers and with thou-
sands of such termi-
nals installed it could
bring in a lot of marketing

dollars. The terminals will be
installed in shopping centres and will
sell airtime rather than the appliances
themselves.

Mitnick warns fellow hackers against
‘Scapegoat sweepstakes’

Who is?

Carleton S. (Carly) Fiorina
A Who is she?

One of the few women to

The world’s most notorious hacker says the US
government should focus on securing its com-
puter systems rather than snooping on citizens.
Kevin Mitnick stresses that hackers should take
extreme care given the sensitive political envi-
ronment and the new laws defining hacks as acts
of terrorism. He also warned that any hacker
could win the ‘scapegoat sweepstakes’ at any
time, receiving a harsh sentence to serve as an
example to other hackers.

Mitnick firmly believes the newly proposed
Patriot Act is just an excuse for law enforcement
to further its own agenda.

tomorrowstechnology

Biometric ATMs

Mitnick calls the Patriot Act ludicrious, say-
ing, “Terrorists have proved that they are inter-
ested in total genocide, not subtle little hacks of
the US infrastructure. Yet the government wants
a blank search warrant to spy and snoop on
everyone’s communications. The government
does things like insisting that all encryption
programs should have a backdoor. But surely no
one is stupid enough to think the terrorists
are going to use encryption systems with a
backdoor. The terrorists will simply hire a
programmer to come up with a secure encryp-
tion scheme.”

hold a top post in the tech
industry—or in corporate
America, The Sunday Times
called her “the most suc-
cessful American woman of
the decade”.

a Why is she in the news?

A while ago industry experts
were speculating whether
Fiorina would be dismissed
as chief executive of
Hewlett-Packard. In an
apparent vote of confidence,
less than two weeks after
the announcement of the
acquisition of Compag, Fior-
ina was elected to H-P’s
board of directors. Now she

The analysis of certain unique
body ‘signatures’, such as fin-
gerprints and retina scanning—
known as biometric technolo-
gy—could soon be put to use in
ATMs for security purposes. The
idea has for long been consid-
ered a viable option to person-
al identification numbers
(PINS). Such ATMs, powered by
BiolD, could soon be providing
service to Australian bank cus-
tomers, with a promise of

reducing personal identification
overheads drastically.

BiolD is a relatively cheaper
option as compared to hard-
ware-dependent biometrics
requiring expensive hardware,
as it just involves installing a
regular Web camera and micro-
phone. BiolD 3.0 uses face,
voice and lip-movement recog-
nition for identification and
authorisation.

The technology only

requires the user’s cooperation
while being recognised and
doesn’t need him to give away
any information. In compari-
son, fingerprint scanning
means a user’s fingerprints can
be used and recognised with-
out him actually being present.

There are already quite a
few installations of biometric-
enabled ATMs in the US and
Europe that use fingerprint and
iris recognition.

is handling the second-
largest computer company
after IBM.

4 What's her new role now?
Her task now is to follow
through with the Compag
takeover. The key would be
if the merger exploits cost-
savings and service
enhancements at the $87
billion merged company.

@ B2B to reach $4.3 trillion 4 Qualcomm ships its first Bluetooth-ready chipset 4 Microsoft phases out Windows NT 4.0 ¢
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ARIEZ RAVI THOMAS
Via e-mai

digit
Dear Ariez,
Guess we did manage to miss something out.

We find that getting buying advice on certain product cat-
egories is of more importance to the majority of our readers.
These categories usually also feature a larger range of products
for us to compare.

At this point in time, since there are several other cate-
gories that we feel meet these criteria better, we have not
planned for a digital camcorder comparison test.

However, look out for reviews of these products in our
stand-alone product review section (Radar).

S.
history o0 these component

Dear Ashlyn,
If you consider the October issue of Digit in particular, you would
find that we already do a lot of what you have requested for.

If, for instance, you're looking to understand the choices available -'
in motherboards, then just refer to the special Smart Buyer’s Guide
in the October issue. If you need more detailed information, howev-
er, then refer to the comparison tests in the Test Drive section, or \ue
some of the Insight articles. Of greatef Va

Also keep an eye out for our workshops in the Wired section or
the Hands-on video workshops that are included in the Digit Inter- Hello, tion in Digit informs us

. . -List sec A
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So please consider changing the focus of

CHINMAY PANDIT
via e-mail

didit

think that most Indians Dear Chinm_ay, o _
ot attacks from happen- As you mention, the A-List is about _the best_ performing prod-
uct that we have tested up to a particular time.

The problem is that the perception of value is something
that can differ according to the personal preferences or
requirements of an individual. So even though we think that

d their prices.
e best products an
a?lil);\l; t(;‘on‘t you also Jist the products that

gafety first

our editorial titled
From what |

for Safety’.
i em to be o
attacks or any s!
oesn't mind if someon

willing to give up their
h danger-
e sits

Trading Free

5 gN ,most people s
rom future terrorist
nt of saying thath hre“ d

i is checking them.
ide hi his e-mail as he is ¢ L
e an(i(r?:idosn‘t see why privacy is such rz‘at t;gy -
T(r; . frs: sc‘>meth‘mg similar if it could preve!
would acce

ing here. ‘ _
" geems to Me like we are Ju

i
| ready

st making @ big deal outofa small issue.

PRASANTH
Via e-mail

digit

Dear Prasanth,
Most of us are willing to give up certain liberties that are otherwise taken for
granted because we feel insecure. While this is especially true in the United States
at this point in time, there are many others in that country who consider this a
mistake.

This is because while an environment like this might seem acceptable now,
eventually it leads to an atmosphere devoid of trust and is not something that
people in normal times will reconcile themselves to.

a 100 GB disk drive that costs Rs 14,000 is a great value offer-
ing (considering the low cost per megabyte), this might not be
true for someone who is quite happy with the 20 GB of disk
space that a drive costing Rs 5,000 would give him. Basically,
whether a product offers great value depends on the user’s
specific needs. This is something that can be explained in
detail in the course of a comparison test, as we do using the
Decision Maker, but is not possible in a product listing.

Performance on the othr hand, is something that can be
objectively calculated and compared, which is why it will
remain the focus of our A-List.
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Dear Guru,

Let’s start with your point about Opera. While as you say
all of those features (e-mail client, instant messenger, etc)
have been included in new versions of Opera, it just has
a fraction of the functionality that is offered by similar
components in other programs. In addition to just
checking whether a feature is present, it is important to
consider whether it is implemented well enough for you
to consider shifting over to it. In that sense Opera does
not challenge the likes of Internet Explorer and Netscape,
at least not yet.

We believe Opera is a really neat piece of software
that excels as a standalone browser. This is the reason that
it ended up winning in the other category.

As you mentioned, Netscape 6.1 took nearly twice as
long as IE to render Web pages. However, if you consid-
er that most of us use dial-up connections where the
availability of bandwidth is what eventually determines

0 sell off
new Duron gsp MHz system

However, whe
~» WNen [ got o .
Road, I got intg 4 bit of 4 jamMTL;lne]ba, < Darduare e
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October issue, Firstly, the

performance, then it doesn't really make sense to give an
extremely high weightage just to the performance in the
rendering speed tests.

The skinning feature in IE, even using Hotbar, is
limited to being a simple background for the toolbar,
whereas Netscape 6.1 lets you modify the appearance
of everything ranging from the icons, the mail client,
the menus and even the progress-indicator bar. Thus
the customisation can give the browser a completely
new look and feel.

And let’s not turn a blind eye to the security issues
that IE and Outlook come with. Vulnerabilities in these
have been repeatedly exploited by a variety of worms and
viruses. Also, IE uses a crippled version of the JVM, and
doesn’t entirely comply to W3C specifications when it
comes to HTML rendering.

So...we know that Netscape 6.1 is the best browser
around, at least for now.

Dera Billi,

Agent 001 would have loved to have answered
your question himself but was called away on
another assignment. But he did ask us to say
that it's great to hear that you got what you
wanted for your PC. Anytime that you find
yourself in a situation like this again and need
advice on how to get a good deal, just flip to the
Undercover article in the magazine for Agent
001’s take. And if you still can’t make head or
tail of the situation, we're just an e-mail away.

Jadesh R. has rightly point-
ed out that the price of the
Intel Pentium 4 1.8 GHz
processor is Rs 26,668 as
mentioned in the A-List and
not Rs 11,868 as mentioned in
Radar (Hardware).

In the browsers’ compari-
son test (October issue of
Digit), Arun Das has pointed
out that on page 146, in the
table, we have indicated the
installation size of Opera 5.12
as 36 MB and in the write up
below as 39 MB. The correct
installation size is 36 MB.

Notice any goof-ups? Write
to goof@jasubhai.com

—
-F_.l ‘ - "
Short Bytes

Diverse drivers

Dear Karan,

It would be nice if you could
include the latest versions of
popular hardware drivers on
the Digit CDs once in a while.
| am certain this will be wel-
comed and appreciated by
many readers.

T. Chinnadurai

Via e-mail

Peek-a-boo

Hi Digit,

You guys have really improved
on this magazine since the
first issue of Digit. The CD
contents have improved
remarkably and the new look
in October is phenomenal. It
would be nice to receive
information on the forthcom-
ing issue of Digit via e-mail
every month.

Anshul

Via e-mail

If you have suggestions on how to
make Digit better, come partici-
pate in the reader survey at
http://www.thinkdigit.com/sur-
vey/betterdigit

il be glad to know th
f at my PpC . :
hted th, IS working gr
e at you have gych helpful gy 9 great and gs 5
al thanks to the Test Cont uys on your team,

Te, and to Agent 007/

So, here’s
BILLI KASH

Via e-maj|

Send your letters marked ‘Readers Letters’ to the Digit office:
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul,
Navi Mumbai 400 706, Phone: 022-7629191/9200; Fax: 022-7629224
E-mail: readersletters@jasubhai.com
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A deadly gang

They've got a PhD in pain and a Masters in disaster. Quake masters and
quad gods—that’s The Unholy Alliance in a nutshell

SRIRAM SHARMA

aturday afternoon. Semi-finals at the

Counter-Strike (CS) tourney at Surf’s Up. In

progress is one of the most exciting CS

games ever played. The map is de_dust.
(TUA) Wile is the last man standing from the
Terrorists camp. All the CTs (Counter-Terror-
ists) are storming the bomb defusal spot. Wile
snipes a CT 100 feet away, switches to his pistol,
guns down another CT at close range, grabs his
assault rifle, and shoots another CT with it. He
throws the rifle and picks his AWM back again
to snipe another CT. Four dead bodies in less
than three seconds. Terrorists win.

No other gaming clan elicits so much fear,
admiration and respect as TUA—The Unholy

“We've been
watching and
studying matches
played at most large
international meets
and feel that we do
match standards
favourably”

The Unholy Alliance:

(S“-ZR)S\),/-/[\mggl Alliance. To the FPS
Frt:gg;it e clique at Kawabonka,

they are gods.

TUA started off as a
UT CTF/DM (Unreal
Tournament Capture the
Flag /Deathmatch) clan
on Kawabonka.com in
late 2000 when Kawabon-
ka.com was only a few months old and UT was
the game to play. The name ‘The Unholy
Alliance’ was suggested by CyAnide, a TUA
member and picked from an old strategy game
called Dominus—“Deep within the craggy
mountains of Kplithor, an Unholy Alliance was
forged....”

Seeing them dominating the UT CTF scene

Mad_Toothbrush

pZ 8 didit!

every night, the rest of Kawabonka quickly
realised what TUA was all about. They were
beating the living daylights out of the opposi-
tion and they were here to stay. A few members
of the initial line-up dropped out and new
members came in. Today the TUA stands as
Wile (Dhruv Parpia, Pune), JBI (Rahul Rohira,
Mumbai), Strider (Siddharth Seth, Delhi),
Fragbait (Sameer Shetty, Mumbai), CyAnide
(Prashanth Raju, Chennai), Mad_Toothbrush
(Ram Balmur, Pune), Ricky (Ricky Kapur,
Delhi).

Geographically far apart, the members come
together at kawabonka.com to practice. And
each one brings along his own flavour. Wile used
to lead ‘Massive Destruction’, the best Quake 111
CTF clan in the world while he was in the US.
Mad_Toothbrush is another Quake master, who
gets calls to join foreign clans every time he
cleans base with a 150 ping on foreign servers. A
natural leader, he comes up with the TUA calls
and strategies. Ricky, who runs kawabonka.com,
is versatile with all weapons, while JBI aka Chief
has a ‘take no prisoners’ attitude. Strider is the
silent sniper, CyAnide, the elite-speak techie and
Fragbait is the wisecracking smart guy. Individ-
ually they are powerful, but as a team they’re
invincible.

The TUA is a generation weaned on Ataris
and Spectrums. They know their PCs like the
back of their hands and their gaming arsenal
includes special configurations, binds, over-
clocked PCs, and gaming mice and they are pas-
sionate about graphics cards and bandwidth. As
far as their game is concerned, Mad_Toothbrush
says, “It’s practice, practice and more practice.
Nothing is easy.”

TUA is all set to take the step from being an
elite clan to pro-gaming. World Cyber Games,
the gaming Olympics, will begin in Korea in
December 2001, and TUA will be there to find
out where they stand. Wile is optimistic about
their chances: “We’ve been watching and study-
ing matches played at most large international
meets. | have played in Singapore, and feel that
we do match standards favourably.” Right now
TUA is busy getting more proficient in CS and
preparing to take part in the Games. “The
future’s  bright, the future’s definitely
not orange,” quips Mad_Toothbrush. Way to
go, TUA! fil
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Activating products or problems?

Windows Product Activation is the latest implementation by Microsoft against software piracy.
Vidyaramanan S. speaks with industry representatives to gauge if it will be a success

he underlying principles of

Microsoft’s software licens-

ing policy have not

changed. Microsoft’s End
User  License  Agreement
(EULA) has always stipulated
the number of PCs that soft-
ware can be installed on, and
this remains the case for Win-
dows Product Activation
(WPA) as well.

Karthik Padmanabhan
Marketing Manager,
Microsoft Corporation India Pvt Ltd

WPA can tolerate a certain
degree of change in hardware
configuration, which allows
users to change their hardware
without the software believing
it is on a different PC from the
one it was activated on. How-
ever, if the hardware is sub-
stantially different, reactivation
may be required. Reactivation
in this case, is easy and can be
completed by contacting a
Microsoft customer service
representative to obtain anoth-
er confirmation ID.

Microsoft gives increasing
importance to protecting cus-
tomers’ privacy and user priva-
cy was a paramount design goal

W.yanoo.co.in

while building the WPA
technology. Under WPA, no
personally identifiable infor-
mation is collected.

Product Activation is not a
single ‘silver bullet’ solution to
global piracy and is not
designed to target sophisticated
and organised criminal coun-
terfeiters. Itis aimed at counter-
ing casual copying by ensuring
that the copy of the software
product is installed on a PC in
compliance with the EULA.

“WPA is aimed at
countering casual
copying. This simple
process requires
minimal effort by the
end user”

udos to WPA! The blue

screen of death is now going

to be succeeded by Windows

Product Activation (WPA)
as the most annoying experi-
ence. Most anti-piracy schemes
end up causing problems rather
than aiding the consumer and
preventing piracy. Microsoft’s
WHPA scheme is also headed the
same way. Software hackers and
pirates will always find a way to
crack the encryption schemes
used to protect software.

“Most anti-piracy
schemes end up

causing problems
rather than aiding
the consumer and
preventing piracy“

What do you think? Come, speak your mind at www.yahoo.co.in

The process for Product
Activation is a simple four-step
procedure that requires mini-
mal effort by the end user—
there is no reason a genuine
customer should find it tedious.
It is unobtrusive, significantly
more sophisticated than past
methods and is not easy for
would-be pirates to circumvent.

Additionally, we have tested
this technology with our Indi-
an customers with the launch
of Office XP, where the product
activation system allows a user
to install a copy of Windows
XP only on one computer, and
haven’t received any negative
feedback from them. fil

Activation can be done via
the Internet or the phone. For
this, Microsoft’s  activation
servers will have to be accessible
round the clock. Nothing could
be more annoying than getting a
cryptic error without competent
help at hand. And if you choose
to activate the product over a toll
free number, you would have to
read out the key on the CD or
the accompanying pamphlet
and there is enough room for
confusion while doing so. A sim-
ple mistake would force you to
go through the process all over
again. Though Microsoft claims
that minor upgrades will not
require you to re-activate the

Catch ‘em live on Yahoo!
Karthik Padmanabhan November 10 at 4 p.m.

installation, you might end up
in quite a tug of war on
installing a RAM module or a
new graphics card.

Piracy is a big threat to any
software ~ company  and
Microsoft is trying to defend
itself by introducing WPA. But
it will cause unnecessary hassles
right from getting the product
registered and all along the

Mayank Sarup
Partner,
Periclestech

course of its use. Every time you
re-activate your installation,
you have to contact Microsoft.
Yes, no private information is
transferred but it also means
that any time Microsoft decides
not to support XP, you could be
left in the lurch. Corporate cus-
tomers are in a two-year loop—
why not the same for the retail
customers?

People are too comfortable
with Windows, which is why
Microsoft is not too worried
about a mass defection to other
OSs. The way | see things, even-
tually people will upgrade to
XP, experience the annoyance
named WPA, sigh and go on.f
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Imaging: Ram

The industrial
revolution, electricity,
airplanes, computers,
nuclear power, the
Internet and now the
next big thing:
Nanotechnology. Get
ready for the atomic
world

ANIL PATRICK R.
t would help if you've seen the movie Inner
Space. Try imagining a small doctor travelling
inside your body fixing up whatever’s wrong.
Or envisage yourself stuck in a traffic jam and
being guided by the computers in your shirt’s
threads to a clear road. Or alternatively, think of
chameleon-like soldiers blending in perfectly
with their surroundings and sensing all oncom-
ing attacks. All these are not mere imagination—
they would be realities in the brave new world of
Nanotechnology, a technology that would usher
in this and so many more things we haven’t even
dreamed of. All this is going to happen sooner
than we expect.
Nanotechnology, which deals with matter at
atomic levels, is not just restricted to the field
of medicine. In fact, it will change almost

everything we are used to—right from the roads
we walk every evening to the food we eat every
day and down to the clothes that we wear.

Nanotechnology puts the power of creation
into human hands. But contrary to popular per-
ception, the immediate goals of Nanotechnology
are not to further life and conquer death. It is more
of a quest for discovering nanostructures that may
have excellent electrical, chemical, mechanical or
optical properties. Don't wonder too hard about
what it is. Come take a look.

Small, smaller, smallest...

When we think of small things, there is a limit to
how small we can think. A speck of dust or
maybe particles, which can be seen only with a
magnifying lens. This is where Nanotechnology
differs. It deals with the most basic building

Designed for the senses.
Engineered for the |

intellect...
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blocks of matter, at the atomic and molecular
levels. Think of taking each molecule one by one
and arranging it to get what we want—some-
thing like Lego. This is exactly what Nanotech-
nology can do. Build from the basic building
blocks.

Nanotechnology deals with particles of size
in the nanometer range (10° metres). More pre-
cisely, it deals with particles of the size of 1 to
100 nanometers. These particles are manipulat-
ed and controlled to build materials to the stan-
dards we need.

This means that many of the micron level
technologies being called Nanotechnology do
not really fall into this group at all. When com-
pared to a nano-sized particle, a particle of
micron size is nearly 1000 times larger. That’s
almost like comparing a 1-metre diameter
sphere to one with a diameter of 1 km. Or think
of a nano particle as something solid, which is
one-billionth of a meter in size. Ergo, think twice
before reading or listening to someone who is
talking about Nanotechnology in the micron
range.

Nano tools

So how do we get down to the molecular level and
tinker around with atoms? Researchers use tools
such as Scanning Tunnelling Microscope (STM)
and the Atomic Force Microscope (AFM) for this
purpose. STMs and AFMs belong to the group
called Scanning Probe Microscopes (SPM).

The STM has a very fine metal tip, which is
used to get the images of surfaces to be scanned
by applying voltages. When voltage is applied,
electrons jump or ‘tunnel’ across the gap between
the tip and the surface. This results in a small
detectable current. The current will vary as the
distance between the tip and the surface being
scanned changes. Researchers get an accurate
image of the particles (atoms and molecules)
that make up the surface, their behaviour and
properties this way. STM can also move individ-
ual atoms and molecules into desired positions.

There’s a limitation when using STMs: the
surface under study has to be a good conductor
of electricity. AFM takes care of this since it
involves actual contact between the tip and the
surface for the imaging. Imaging of the surface is
done by measuring the tiny force of contact
which has to be kept constant while the tip
moves up and down over the surface. This mode

of operation of the AFM is called the contact
mode. In addition to this, AFMs also have the
‘tapping’ mode of operation where the tip is low-
ered to a particular point and then pulled up and
lowered to the next point of the surface. AFMs
are used to get the image of non-conducting sur-
faces such as biological tissues, plastics, glass, etc.

Now let’s see what’s possible with these tools
at the nanometer level.

Nanocomputers
As of now, Nanotechnology is focusing on proj-
ects which can be implemented in bettering our
lives. Pervasive computing is an area where a lot
of Nanotechnology projects are currently active.
For example, if you want to design a chip to fit
into your fingertip for controlling a music sys-
tem, then the solution lies with Nanotechnology.
While making a microprocessor, we handle
big groups of semiconductor molecules and
structure them into the form we need. This form
of handling of matter produces severe limita-
tions as to how small these circuits can be made.
Present day lithographic technologies (used in
the latest desktop processors) are at 0.13
microns. After the 0.13-micron limit, it is very
difficult to etch the circuits precisely and effec-
tively on the silicon substrate. This is where Nan-
otechnology steps in. Whether it is a matter of
using DNA for computing or arranging semi-
conductor atoms to form logic circuits, Nan-
otechnology offers convenience hitherto
unknown to bulk technology (most of today’s
technology can be termed as ‘bulk technology’
as it involves manipulation of atoms and mole-
cules in bulk rather than one by one).
Computing giant IBM has come up with a
new kind of memory called ‘Millipede technol-
ogy’, which makes use of an array of AFM probes
to make marks on a polymer surface for storing
data. Each tip writes a ‘bit’ of 50 nanometer on
the polymer which stores the data. Reading and
erasing of data is also done by the same arrays.
Today’s best storage devices are capable of a
memory capacity of 2 gigabits per square cen-
timetre, whereas this technology has made pos-
sible densities up to 80 gigabits per square
centimetre using a single AFM tip. This is about
40 times greater than the memory densities
available now. These devices are not so far away
either. One of the first steps in this direction was
the Microdrive from IBM, which has 1 GB mem-

On the Nano Path

The term ‘nanotechnology’
was popularised by K. Eric
Drexler in 1986 when he
came out with a book called
Engines of Creation in which
he described what is possi-
ble with nanotechnology.
However, one of the first
practical nanotechnological
advances can be traced back
to 1968, when Bell Laborato-
ries developed molecular
epitaxy, a technique to
deposit single atomic layers
on a surface. One of the
most practical ways to effec-
tively use nanotechnology
happened in 1981 when
Gerd Binnig deployed the
scanning tunnelling micro-
scope to image individual
atoms. This was followed by
the creation of Buckminster-
fullerenes or buckyballs in
1985. Buckyballs measure
about a nanometer in diam-
eter and are used widely for
nanotechnology applications.
Sumio lijima of NEC dis-
covered carbon nanotubes,
yet another major nanotech-
nological advancement, in
1991 and in 1998 the first
transistor was made from a
nanotube by Cees Dekker.
The fact that single molecules
can act as molecular switches
was demonstrated in 1998
according to research held at
Rice University. The start of
2000 saw a great boost to
nanotechnology in the form
of the National Nanotechnol-
ogy Initiative (NNI) in the US.
NNI aims to provide more
funding and greater public
participation in the field of
nanotechnology.
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Ethics in
Nanotechnology

Nanotechnology deals with
the most basic assembly of
matter. This is like delivering
the power of creation into
human hands.

Consider the concept of
self-replicating robots that
traverse the human body
providing all sorts of cures.
The only self-replicating
mechanisms we know of
are the reproductive mecha-
nisms of living cells. Even in
their case, we are not really
clear about the intricacies
involved. So it is quite possi-
ble that accidental damage
could be caused by unleash-
ing something which we
can’t control, as our under-
standing of the complexities
involved is limited.

Chances of a deliberate
misuse of this technology
are even higher. One only
has to think of the immense
destructive potential that
biotechnology has brought
about through weapons of
biological warfare.

Some experts have called
for banning nanotechnology,
but this will be like killing
one of the greatest develop-
ments in technology even
before it's happened. This is
where ethics takes the cen-
tre stage.

The Foresight Institute
has laid down a set of
guidelines for nanotechnol-
ogy research and develop-
ment. The guidelines are
reviewed yearly and new
guidelines are formulated as
research brings up newer
issues.

Monitoring Malignant Cells

Nanotechnology
can help monitor
and cure abnor-
mal cell condi-
tions using
‘nanorobots’
which can travel
inside the body

ory capacity in a matchbox-sized drive. Big Blue’s
next step is to make gigabyte drives as tiny as one
square centimetre. This means that music afi-
cionados can store their entire music collection
on something the size of a watch a few years from
now. There are also plans to build a smart ver-
sion of Millipede. This will have electronics cou-
pled to the Microdrive so that the whole package
can act as an independent system on a chip.

That was just the tip of the iceberg. Molecular
switches and transistors were first developed in
1998. These breakthroughs are showing a path on
which a completely new kind of computer archi-
tecture is being developed. This approach makes
use of objects called Quantum dots for their oper-
ation. (See Box: Quantum dot cell operation for
more information on this new architecture.)

The main advantage of using approaches
such as the Quantum dot cell, other than the
small sizes, is the power consumption. In an era
where we are strapped for power, nano-powered
devices will be a big help as they consume next
to nothing in terms of power.

Here, there, and everywhere

Materials technology is another major area which
will be affected by Nanotechnology. A nanotube is
one such innovation which can change almost all
the areas that we are familiar with. These are sin-
gle walled molecules made from buckyballs. We'll
see what buckyballs are in detail later on. The main
advantage of using these nanotubes is that it is pos-
sible to control the way these crystals are devel-
oped for particular applications. Electrical and

other properties of materials made using nan-
otubes can be made to fit precise specifications.
This makes it possible to use them for practical
applications, from clothing to superconductivity
applications to spacecraft design.

Nanotechnology has been in the market for a
while now. Toyota and Nike use Nanotechnology
in some of their products. Toyota started using a
nanocomposite material early in the 1990s in their
engines. This material, made out of reinforced
nylon, withstands high engine temperatures and
is cheaper than other forms of similar plastic. The
Nike trainers, which are so commonly available,
make use of nanoengineered cushioning materi-
al in the soles of some Nike shoes.

Miracle drugs
We all dread operations, but we might not have
to in the near future, not with Nanotechnology.
The concept here is Microencapsulation, a
Nanotechnology concept, which will help doc-
tors control precisely the rate at which medicines
are supplied to the patient’s body. One of the
major medical breakthroughs in this area is a
composite structure of carbon called buckyballs,
or C60 molecules. Buckyballs were discovered by
Richard Smalley of Rice University in Houston
for which he got the Nobel Prize in 1985. The
main advantage of using buckyballs for medical
purposes is that they are extremely small and are
non-toxic. These spherical particles are a
nanometer long and very smooth. They are eas-
ily excreted by the body, which makes them per-
fect as drug delivery mechanisms. Researchers
have developed a family of structures known as
Fullerenes based on buckyballs. These are tube-
like structures which could turn the entire med-
ical field around because of their immense
potential in the way treatment is administered.
Using Fullerenes, medicines could be delivered
to the body orally and the body then eliminates
the Fullerenes without any side effects. It is possi-
ble to attach the needed drugs on the buckyball
structure as required for the particular disease.
This is much easier and effective than the con-
ventional capsule approach. In capsules, a mix-
ture of drugs is delivered into the body, a major
part of which is eliminated by the body. When
using mechanisms like buckyballs, it is easy to
ensure that they are tailor-made to deal with the
specific cell disorder that the disease causes.
Drugs that make use of buckyballs for the
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treatment of AIDS could be out by 2003. One of
the daunting challenges faced by researchers in
fighting the HIV virus has been the inability of
drugs to attach themselves to the virus and stop
it from reproducing any further. Nanotechnolo-
gy-powered medical techniques like buckyballs
have the ability to fix themselves to the virus,
thus preventing further reproduction.

Yet another exciting (though futuristic)
prospect that Nanotechnology presents is the
ability to have minute machines travelling inside
our body protecting us from the inside. These
‘nanodoctors’ will be able to find and repair
damage at the cellular level. For this to be possi-
ble, molecular assemblers—with better capabil-
ities than the current scanning tunnelling
microscopes—are needed. They have to have the
capability to move atoms and molecules faster
and more precisely than present day STMs.
However, these nanodoctors won't be calling on
you for the next 15-20 years, to say the least.

The concept of Nanotechnology-powered
doctors inside the human body has a long way to
go before it can become a reality. The Centre of
Biotechnology at the University of Michigan is
working on a technology that could diagnose and
monitor malignant cancer cells. This is more of a
monitoring use of Nanotechnology for detecting
and monitoring tumours. (See illustration, ‘Mon-
itoring of Malignant Cells’ for more details.) The
technology is aimed to target cancer cells and
sometimes even suggest cures. It will then mon-
itor the effect of the medication taken by the
patient on the cells.

One such attempt is being made by IBM’s Dr
Christoph Gerber, one of the inventors of AFM
on biological cells. His group makes use of an
AFM’s imaging tip along with ultra-small lasers.
The tips are attached to cantilevers, which are
small springs with movements that help measure
the force of each atom. Another researcher, Peter
\ettiger, from IBM’s Zurich Research
Laboratory, believes that this movement can be
used to build nanomachines that will be able to
act independently. These nanomachines could be
used to deliver treatment to cells in the form of
microcapsules. For example, specific proteins of
cancer cells will be producing a certain amount of
force which will help identify that cell. The
nanomachine will detect that cell and attach itself
to the cell. Then it can release the right amount
of anti-cancer drug to the exact location.

Quantum Dot Cell Operation

Quantum dot cells are basically small
semiconductor or metal boxes that
hold a defined number of electrons in
them. Remember that small means
cells just a few nanome-
ters across. Electrical
fields or insulation is
used to hold electrons in
place in these dot cells.
A string of dot cells one
next to the other is pro-
posed to act as a wire
across which data can :
be sent. " "
As you can see from
the figure, each cell has
two electrons in them with two of the
quantum dot cells left unused. This
arrangement of quantum dot cells was

INPUT ™ ®

Life after death?

Did you dismiss Austin Powers coming back to
life after 30 frozen years as science fiction that hap-
pens only in movies? Welcome back to reality.
People are already queuing up to have their bod-
ies frozen in cryonic suspension facilities after they
die, hoping they’d be back to see life again in the
future. Cryonic suspension basically freezes dead
bodies to —3200 Fahrenheit using liquid Nitrogen.
The body fluids are replaced by a glycerine-based
solution, which protects the body systems from
damage due to freezing. However, remember that
Nanotechnology won't be bringing you back to
life anytime soon.

Many of the concepts that Nanotechnology
presents may look impossible now, but they may
not be so far away after all. Could any of you
who've been through the 1970s have predicted
that the computers of 2001 would have been so
powerful? Or would you even have thought of
something like a television in the 1960s? Like-
wise, Nanotechnology is nearer than you can
think. The nano-storm will catch you quietly.
The only difference being that it will come in a
silent and subdued manner, much like how we
embraced and used artificial fibres over the years
without knowing it. And it will make a tremen-
dous impact on our lives.l

* - DUTRUT

proposed by Lent and Porod of Notre
Dame. Now if a signal is applied to the
left end, the signal propagates itself
through the wire as shown. It simply

passes on through
each of the cells when
one cell exerts a force
on its neighbouring
one to pass on the
signal.

Lent and Porod
have also come up
with an inverter gate
which will produce
the opposite of the
input signal as the

output. Combining the inverters and
other forms of gates will eventually
make nanocomputers a reality soon.

hittpt/ /W

www.foresight.org/
Foresight Institute answers
all the questions you
might have about Nan-
otechnology
www.techreview.com/nan
otech.asp

Look up Techreview’s Nan-
otechnology site for the lat-
est in Nanotechnology
www.foresight.org/EOC/i
ndex.html

Have a look at the book
which started it all—Eric
Drexler’s Engines of Cre-
ation.
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SET YOU
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Welcome to November. This time around, we pick the coolest toys
from the personal tech spectrum. Hot memory-free MP3 players,
shrinking PDAs, portable printers, the works. Go ahead, indulge

Archos Technology MiniCDRW

The Ultimate in Portability
The MiniCDRW provides a solution to
store data, music, video or other
large-capacity files at home or
while on the road. Its flexibility
allows it to connect to a variety
of interfaces such as USB, PC
Card, CardBus and Firewire. In
addition, you can use MiniCDRW
across platforms, be it the PC or
Mac. The maximum burning speed
rates are 8x/4x/24x and you can
write a maximum of 700 MB
of data. Adaptec’s Easy CD
Creator software is included
with this sleek portable
writer weighing 500 grams.

Web site: www.archos.com

Trium Mondo Pocket PC
A Cool Combo

The Mondo will catch the fancy of those who
need a multi-purpose solution. The unit’s
small size disguises what lies within this cell
phone-Pocket PC combo. For starters, Pocket
Explorer and Pocket Outlook, followed by a
WAP 1.1 browser, voice recorder and an MP3
player. And in PDA fashion, one can synchro-
nise data with their desktop PC through a
USB cable. GPRS is also available to keep
you on track globally. The Mondo provides
three hours of talk time and 100 hours of
standby. This powerful gadget weighs in at a
slight 200 g (including battery).

Web site: www.trium.net
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Ricoh RDC-7 Digital Camera

A Visual Treat

This multi-function camera not only takes still pictures but captures
320x200-pixel full motion video as well. And if its 3.3 megapixel reso-
lution isn’t enough, the RDC-7 features a ‘Pro’ resolution mode that
effectively doubles CCD pixel count producing 3072x2304 pixel
images. A 2-inch TFT LCD viewfinder is featured which swivels around
270 degrees. An 8 MB SmartMedia card is included for storage

BPL-Loewe
Designer Tel

Digital
syiskans

of images and video and can be upgraded to 128 MB.

Images can be then transferred back to your
PC through USB or serial interfaces. The
RDC-7 can also be connected to a TV in
order to watch captured videos.

Web site:
www.ricohzone.com/Product_RDC7.html

Sensory Science rave:mp 2300

Something to Rave about
This MP3 player uses lomega’s Clik! disk to pro-
vide 40 MB of storage on each disk (capable of
storing about 75 minutes of music). This play-
er features a built-in microphone to record
2.5 hours of voice messages. In addition,

you can download MS Outlook names,
phone numbers and e-mail addresses on

to Clik! Media. The rave:mp 2300 offers

USB connectivity and features

upgradeable firmware which provides
support for future music formats.

Web site: www.sensoryscience.com

IBM BlueEyes Emotion Mouse I

Understanding Mice

Can a mouse ever know how you feel? Yes, says IBM. You need to simply
touch the Emotion Mouse Il, and the computer will be able to determine your
emotional state, says Big Blue. Sensors in the mouse sense the physiological
attributes, which are correlated to emotions using a correlation model. The
application of this technology in games could help one add personalised
challenges, adding to realism. Automobiles also benefit from this technology
by taking crucial decisions based upon a person’s emotional state.

Web site: www.almaden.ibm.com/cs/blueeyes/mouse.html
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What makes us Tick?

That’s the question scientists are trying to answer while working on the human gene,
aided by supercomputers and biotechniques

he world is filled with nearly 6 billion people,

each different from the other and yet sharing

a lot of traits in common. These traits are

handed down from one generation to the
next through genes, the units of information
inside the cells of your body.

What if we can modify the gene itself for a
stronger build or affect the gene such that it is
more resistant to diseases? How does a set of
instructions work to create humans and other
forms of life? A quest to the answer of these ques-
tions led to the formation of the Human Genome
Project (HGP) in 1990. This project is coordinat-
ed by the United States Department of Energy and
il National Institutes of Health. It was initially sched-

uled to last for a period of 15 years.
More than 18 countries are now participating
in this quest which involves identifying
ﬁ% et the genes that are believed to make

L } " up the human DNA. The
éﬂi%:ﬁﬁ‘ ] / 'Human Genome Organiza-
i -_-::_",:f'.--- /f tion: (HUGO) helps to

i e Accordinatethewidespread

.= international collaboration

in the genome project.

Where does it stand today?

Numerous sections of the genome map have
been completed and an entire human genome
sequence, together with its analysis was released
in February this year. The outcome from HGP
would comprise a resource of detailed informa-
tion about the structure, organisation and the
functionalities of the human DNA. But let’s first
understand what a genome is.

The nucleus of each cell in the human body
contains the set of genes that provide a complete
set of instructions for making you you—sex,
colour of eyes, physical structure and even your
temperament and talents. This set of codes is the
genome. The information of the genes is organ-
ised into strings of DNA called chromosomes.
Each chromosome carries several thousand
genes. Identifying on which chromosome a spe-
cific gene is located and where along that chro-
mosome it can be found is called ‘mapping’

DNA is made up of four similar chemicals
(called bases or nucleotides), which are abbrevi-
ated as A, T, C, and G. These bases are repeated
millions of times, as combinations, throughout
a genome. The human genome for instance has
3 billion base pairs that are arranged in an order
that’s unique to each individual. The process of
finding out the exact order in which the base
pairs occur is called ‘DNA sequencing’.

As you can imagine, it is a Herculean task. It
is estimated that a hundred thousand patterns of
the DNA would be revealed by simulating the
process of DNA sequencing using the informa-
tion already gathered in the databases.

Computers and biotechnology
Considering the sheer volume of data that
researchers working on the HGP have to deal
with, computers and other advanced electronic
technology are an essential part of the Project.
Laboratory automation involves the use of
robots to handle the genetic material along a
‘production line’ Electro-mechanical systems,
lasers, sensors, and sophisticated computers all
play key roles in analysing and recording the
results. For speed, efficiency and accuracy, com-
puters are used in the process of DNA sequenc-
ing, which involves reassembling small fragments
of DNA into a complete sequence to find the
shortest sequence containing all the fragments.
Dynamic programming is used during the
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mapping process. First, two DNA sequences
(fragments) are aligned. Then, to determine the
accuracy of the alignment, the computer takes a
random alignment of genes at any location, in
any sequence, and assigns scores to each charac-
ter-to-character comparison. The aligned pair
with the highest score is then reported.

Another aspect of the use of computers in
biology-related sciences is the use of informa-
tion management systems, analysis tools and
communication networks. Collectively known as
bioinformation infrastructure, it incorporates
bioinformatics (the use of huge databases of bio-
logical information) and computational biology
(the use of algorithmic tools to facilitate biolog-
ical analyses). Basically, bioinformation infra-
structure bridges the gap between observations
(the raw data), the analysis of this data to arrive
at an understanding (information) of how the
processes function and finally, the application
(knowledge) of this information. Put simply, it
helps us discover new, hitherto unknown rela-
tionships between data.

The tools

The study of the complex genetic structures that
living organisms are made up of require special-
ly developed software tools that would assist in
the analysis of the large quantities of biological
data. Special design tools are required to adapt
commercial databases to meet the special needs
of genome researchers. One such tool is called
ERDraw, which is a graphical editing program
for describing data in biological terms.

The scientists at Lawrence Berkley National
Laboratory have been engaged in building large-
scale data management systems, of which one of
the first was the Chromosome Information Sys-
tem (CIS). It works in a manner similar to CAD
(computer-aided design) software and lets biol-
ogists study chromosome maps and related data
with the help of pictures and text.

In the CIS, data is easy to access and manip-
ulate through an interface called GenomeGuide
which is shareable through a management sys-
tem called GenomeBase. Researchers can trace
back information on a map to its experimental
origins, and get more information about specif-
ic entries with this interface.

Other computer language based tools such as
OML (Ontology Markup Language) are being
developed by open source software groups, uni-
versities and software development firms to fur-
ther the research and development on the
biological fronts. Big Blue has been making super-
computers for this effect; the Department of Ener-
gy’s Oak Ridge National Laboratory (ORNL) has
acquired an IBM RS/6000 SP supercomputer sys-
tem. The initial system, configured to perform 100
GigaOPps (1 billion calculations per second), will
later be upgraded to 400 GigaOPps.

Computer scientists from ORNL and IBM are
also working on developing new programming
tools and techniques to support this highly
sophisticated machine. They will also be expand-
ing their collaborations in data storage and dig-
ital libraries to include parallel programming
environments and Web-based supercomputing.

Compag, Sandia National Laboratories and
Celera Genomics are collaborating on develop-
ing system hardware and software solutions to
address the demands of computational biology.
The alliance will use Compaq Alpha proces-
sors—a family of RISC-based, 64-bit CPUs and
computer systems—connected in a massively
parallel configuration with extremely high
bandwidth and low-latency mesh interconnects.
The goal is to achieve 100 trillion operations per
second (100 TeraOPps).

What next?

After the proper sequencing is complete and we
get an actual map of DNA sequences, are we
ready to retell the human story? Not quite. The
quest doesn’t end here; mapping the human
genome is just the first step. Analysis of the
human genome could help scientists in develop-
ing new medicines, crops, materials and solu-
tions to challenges in energy development and
environmental cleanup.

The information gleaned from HGP can be
used to pinpoint the source of the dysfunctions
that cause certain diseases, including cancer. This
would lay the foundation for enormous advances
in diagnosis and treatment of diseases.

Take, for example, the research on drugs.
Many drugs used in treatment target the proteins
at the cellular level. They bind with certain pro-
teins to either enhance or inhibit their activity,
thus controlling intracellular reactions.

The effectiveness of a drug depends on its
ability to specifically bind to the target protein in
order to minimise undesired side effects. Drug
companies are hoping to employ the knowledge
gained about the genetic code to predict which
protein a particular gene sequence produces and
which drugs or diagnostic tests may be effective.

Computers are playing an increasingly
important part in helping researchers use mod-
els of the genetic, nucleic and other biological
data to simulate the effect that new experimen-
tal drugs will have. Computers can help find out
about possible biological functions of a protein
by comparing it to databases of proteins with
known function. Understanding the biological
or biochemical mechanism of a disease often
suggests the types of molecules needed for
new drugs.

We still don’t know what makes us tick, but
computers can help us get mighty close to it.
Till then, let’s be content with what’s in the
genes. Us.fil

DNA Computers
and Us

The need for speed has
prompted miniaturisation of
the conventional silicon
wafers used in computer
processors and prompted
researchers to look for
materials that could surpass
the existing speed limits.

Living organisms have
millions of supercomput-
ers—DNA molecules—in
their body. DNA resembles a
computer’s hard drive in the
way it stores data. Data
transfer using DNA mole-
cules is much faster than
that in even the fastest
supercomputers.

Adleman, a computer
scientist, was the first to dis-
cover the computing poten-
tial of the DNA. He used
DNA to solve the well-
known Hamiltonian path
problem. This revealed the
computational and storage
capabilities of DNA mole-
cules in solving complex
mathematical problems.
Logic gates, which form the
basis of all calculations in a
computer, were formed
using DNA molecules.

Developing microchips
embedded with DNA
instead of silicon poses
many advantages: they are
cheap, do not use toxic
compounds, and are abun-
dantly available. Further-
more, using DNA,
miniaturisation of computer
processors is much more
feasible. Unlike the normal
serial computing computers,
DNA computers perform
parallel computations. Soon
computers with tens of giga-
bytes of speed would be
available even for home
users.
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Are you a whiz at
processing
information and
visualising graphical
representation of
data? A career in GIS
could be right up
your street

AVINA LOBO
hink maps, and we’ll bet what first pops up in
your mind are all those humongous, dusty,
tattered maps from your eighth standard
geography class. Most of these paper maps
carry all the information right there on the sur-
face. But now picture a digital map containing all
necessary information in a database—for
instance, a city map packed with information on
its transport network, census information or even
its sewage plan. The digital map integrates all this
data in different layers within the same map. So
you can do away with hunting for the right map
to find what you want. Simply select the
information you want

Imaging: Solomon Lewis

to view and a map representing the requisite data
will be generated accordingly. Behind such
dynamic and versatile digital maps are program-
mers, data architects and analysts who use GIS or
Geographic Information Systems. GIS is a set of
powerful tools and processes to capture, manip-
ulate, analyse and display spatial or geographi-
cally referenced data. Today, GIS is being
projected as a field that holds enormous poten-
tial for growth in the days to come in the Indian
IT sector.

Sowhat’s GIS all about?
GIS isn’t simply ‘mapping software’ nor is it the
same as cartography. Cartography has just one
aspect to it—using data to design a map. There
are two distinct aspects to GIS: one has to do
with the graphical output (the map or
screen display) and the other with the data-
base, which contains all the data. A database
used in GIS contains both spatial (geographic)
and attribute (statistical) data. With this data-
base attached to a map, you can generate a map
carrying the information you want based on a
‘geo-query’. A geo-query works like a search
engine, usually involving clicking your mouse
anywhere on a map with all data for that field
instantly popping up.

GIS is flexible enough to map any kind of
terrain, not just physical geography, right from
mapping the human body to a graphical
representation of instructions to assemble
machine parts. And all this on the basis of the
available data.

GIS s a field encompassing various other dis-
ciplines such as cartography, CAD, remote sens-
ing, photogrammetry (aerial photos), operations
research, surveying techniques and other allied
spatial data processing technologies.

There’s no simple or clear-cut methodology
involved in GIS work processes—it differs from

I

November 2001



project to project and according to the applica-
bility of GIS in different industries. Broadly
speaking, there are three distinct work areas:
data conversion, GIS Application Development
and GIS Analysis. Let’s look at each stage in rela-
tion with the work areas to understand the
processes and people responsible for getting a
GIS project up and running.

Where's my data?

Data input, both spatial and statistical, for a GIS
project varies according to industry require-
ments and the company for which the GIS solu-
tion is being customised. Data can be sourced
from existing digital maps, satellite remote

into GIS

Yogendrans. 00000000

T GIS analyst, 1IC Technologies, Hyderabad

i

sensing, photogrammetry, purchase of databas-
es from commercial data vendors, surveys or
even paper maps. In India, physical data isn’t
readily available or accessible. Besides, most of
the data is not available in a digitised form.
Hence, a chunk of the manpower involved in a
GIS project is involved in digitising data and data
conversion—processing and digitising images
from remote sensing and aerial photos, map
digitisation or digitising manual records. Map
digitisation involves scanning or digitising exist-
ing paper maps to a vector or a raster format,
which can then be loaded onto a GIS platform.

Digitisation is a low-end job for which you
need proficiency in CAD software such as Auto-
Cad, AutoLisp or Microstation. “Map digitisa-
tion is more labour-intensive and the technical
skills and domain knowledge required to do the
job are comparatively limited,” says Maneesh
Prasad, Director of Gisdevelopment.net. “The
pay is not high and one can become a supervi-
sor, a data editor, or be in charge of QC (Quali-
ty Control). If you're involved in digitisation,
you should enhance your skills as it will give you
more options for career advancement,” adds
Prasad. “Diploma engineers fresh from college
with skills in Microstation, or GIS software such
as Arcinfo or Geomedia can opt for data
conversion,” says Manoj Thakur, president and
CEO of Nucleus Netsoft & GIS India. “As far as
aptitude is concerned, an analytical mind and
the ability to extract information from maps are

T professionals can easily make
the transition to IT-enabled GIS. A
fair knowledge of GIS fundamentals
and software will serve as an easy
passport for software professionals

needed. A background in mathematics would
help you with the mathematical analysis in GIS
projects.”

Programmed to customise
GIS application developers or programmers of
varying skills are required on spatial projects for
coding applications or customisation after a map
is digitised by a CAD operator for graphical dis-
play. Customisation can be in the form of creat-
ing menus or algorithms to find the shortest
route between two points to facilitate easy deci-
sion making for users.

To become a developer, you need to have
a background in computers with thorough
knowledge  of
software  engi-
neering tools and
programming
languages such as
Visual Basic, C,
C++, Visual
C++, COM, EJB
and JSP. For
complex applica-
tions, you must
have a knowledge
of MDL (for
Microstation),
AutoLISP (for Autodesk), Arc Macro Language
(AML) in ARC/INFO (for ESRI platforms),
Avenue in ArcView XML and GML or software
such as MapObjects or ArcSDE. Knowledge of
GIS fundamentals and familiarity with spatial
databases and database systems is essential as is
awareness of algorithms and data structures.

“GIS application development is getting
diversified into two areas: Application GIS and
IT-enabled GIS,” says Yogendran S.,a GIS analyst
at [1C Technologies, Hyderabad. “IT profession-
als can easily make the transition to IT enabled
GIS irrespective of their field. A fair knowledge
of GIS fundamentals and software such as
ArcInfo, Mapinfo and GeoMedia will serve as
an easy passport for software professionals
into GIS”

Designs on data

A GIS closely integrates two databases: a spa-
tial database containing coordinates related to
location and an attribute (statistical) database
comprising, for instance, demographic data or
statistics about a particular location. Database
design includes the planning and development
of a database for storage of spatial and non-
spatial data attributes, data structures, linking
the database model to the application model,
and so on. Database building involves differ-
ent spatial database structures (both vector
and raster), topology, search algorithms and
trees (binary and spatial). The role of the data

Location-based
Services

You're driving through an
unfamiliar area when your
car suddenly breaks down.
You get your mobile phone
out and, through the use of
interactive maps, access a
database which tells you
where the nearest service
station is. This is one of the
ways in which LBS or Loca-
tion Based Services work.

The elements involved in
LBS technology include
positioning, GIS and loca-
tion management function.
The ‘positioning’ element is
similar to GPS, except that
network positioning is used
to determine the location of
a mobile device.

GIS systems are used to
map the geographical data
around the position of the
user, and to map the loca-
tions of the places and serv-
ices that a user might need.

The location manage-
ment function is used to
process the location of a
mobile device and the GIS
data around it. It acts as a
gateway between the posi-
tioning equipment and the
LBS infrastructure.

The LBS application on a
user’s handset could work
with other location tech-
nologies to determine the
user’s location and provide
a list of services within a
certain proximity to the user.

LBS technology is used
mostly for personalised cus-
tomer service, which could
extend into location based
information and billing—a
user can be charged differ-
ent airtime rates relative to
whether he is at home or
office. LBS can also be used
in fleet management sys-
tems to track the position of
vehicles. Emergency services
is another area where
there’s tremendous demand
for LBS.
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GIS Training Courses

Indian Institute of Remote
Sensing (IIRS), Dehra Dun
Post graduate Diploma
courses and short-term
courses in GIS and Remote
Sensing

WWW.isro.org/iirs-
training.htm

National Remote Sensing
Agency (NRSA), Hyderabad
Courses on Remote Sensing
technology and applications
WWW.nrsa.gov.in

Anna University, Chennai
Post graduation in Remote
Sensing

www.annauniv.edu
www.engr.uky.edu/~arunp/
anna/irs.html

Jawaharlal Nehru Universi-
ty (JNTU), Hyderabad

Post graduate degree in
Spatial Information Technol-
ogy and Doctorate in
Remote sensing
www.jntu.ac.in/crs.html

GIS Institute, NOIDA
Short-term courses in GIS
software and applications. It
is run by the Centre for Spa-
tial Database Management
and Solution
www.gisinstitute.net

ESRI India

Short-term courses in GIS
software and database
design

www.esriindia.com
Pentasoft Education
Short-term courses in GIS
software and database inte-
gration
www.pentasoftech.com

Note: This is a listing, not a
recommendation.

40 R

architect is to develop, design and maintain
spatial databases. If you plan to step into the
shoes of a data architect, familiarity with spa-
tial data models and their architecture is essen-
tial. “Since Oracle is a popularly used database,
proficiency in Oracle is sufficient and knowl-
edge in the latest version of Oracle Spatial is
advantageous,” says Yogendran. Robins John, a
GIS professional with Speck Systems, says that
attribute data linked with spatial data makes
‘intelligent data’, which aids decision-makers in

Manoj Thakur

An analytical mind and
the ability to extract
information from maps are
essential. A background in
mathematics would help
you with the mathematical
analysis in GIS projects

Engineering is desirable, supplemented with
knowledge of CAD and GIS software.
Yogendran’s job profile as a GIS analyst in
Marine GIS involves project planning, execution,
management and client interaction. He works on
digitisation, data capturing and creation of nau-
tical charts using a GIS software called CARIS as
well as compatibility of charts with standards
adopted by the International Hydrographic
Organization. “GIS application development and
GlIS analysis are the hot and happening areas and
promise growth,” he states.

Is there a business
opportunity ?

If GIS fascinates you but you
don’'t want to be involved
with the technical aspects,
there’s another avenue
open—nbusiness  develop-
ment. “Opportunities exist
for marketing GIS software
and ‘concept selling’ of the

President and CEO, Nucleus Netsoft &

GIS India

querying and analysing information. The
attribute data related to the spatial data may be
stored in any RDBMS such as Oracle, MS
Access or mySQL.

Analyse this!

Data analysis in GIS uses the spatial and non-
spatial information in a database to answer
queries and provide solutions. Data analysis is
done in the following areas: database query
(selectively retrieving and displaying informa-
tion from a database), overlaying of maps (vec-
tor-to-raster and raster-to-vector conversions),
network analysis, surface modelling, geo-calcu-
lations, geo-statistics and others.

GIS analysts or professionals are the ones who
carry out data analysis in a project. “A key
requirement for a GIS analyst is domain expert-
ise and the ability to visualise G1S-based struc-
tured solutions,” says Prasad. “A crop monitoring
system needs an expert in agriculture with a doc-
torate in one of its sub-domains and good
knowledge of image processing and GIS,” he
continues. Strong analytical skills and versatility
to adapt to project requirements on an industry-
to-industry basis have to be the strong points of
a GIS analyst. “Formal qualification definitely
comes into the picture with GIS data analysis.
This needs specific educational qualifications
and experience in the related field,” says John.
According to him, for analysis, a degree or post
graduation in Geology, Geography, Environ-
mental Science, Remote Sensing, Geo-Informa-
tion Technology, Town planning or Civil

technology and its applica-
tions,” says John. The qualifi-
cations required would be an
MBA with sufficient knowl-
edge of the GIS field. John adds, “The career
advances are like that of any marketing execu-
tive.” He started out in the data conversion field
but is Resident-in-charge of the Botswana office
of Speck Systems, a GIS company based in
Hyderabad.

What must I do to go the GIS way?
Sufficiently interested to consider GIS as a career
option? You can now avail of formal education as

Tools of the Trade

The software and tools used in a GIS system
range from creating the front end map to GIS
software used for data analysis and visualisa-
tion. For the front end graphical output or the
maps, CAD software such as Microstation and
Auto CAD Map is used. The most popular GIS
packages are Arcinfo and ArcView GIS from
vendors like ESRI, Geomedia from Intergraph,
CARIS GIS, SICAD, MaplInfo, MapObjects and
ArcSDE. The choice of software depends on
the industry applications. For instance, CARIS
is used for marine GIS and electronic naviga-
tion systems.

ERDAS is the software used for processing
satellite remote sensing images and aerial
photographs.

GIS data can also be Internet enabled. For
this the software used are Auto CAD Map
Guide and MapXtreme.
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well as a wide variety of short-term training
courses in GIS software. The qualifications and
training required depends largely on the area
you want to work in—application development,
analysis, data conversion, etc.

Courses offered by most software training
institutes concentrate more on training in GIS
software, rather than on the applications of GIS.
However, some institutes do offer training in the
applications of GIS technology. If you're serious
about a career in data analysis then you should
consider a formal degree or a post-graduation
in earth sciences from a reputed institute. (See
box on GIS training courses)

The buzz about GIS

GIS has been used in India since the mid 1960s
primarily by government and research sectors in
areas such as natural resource management and
environmental planning, urban planning, trans-
portation and civil engineering. With data repre-
sented graphically in the form of maps acquiring
importance in many industries as a decision mak-
ing tool, GIS technology is finding wider accept-
ability in many industries—health, business
management (where it is used to map existing
and potential clients), assigning sales territories,
distribution facilities and so on. And here’s the
bright side. “The global market for GIS has been
estimated at over $7 billion and the domestic

market in India itself is worth over Rs 750 crore,”
says Prasad. But there is a shortage of skilled tech-
nical manpower to execute GIS projects.

Thakur says, “Around 30 to 40 per cent of the
domestic GIS market is concentrated on the sale
of software, applications and hardware and
approximately 70 per cent of the business comes
from providing services.” He adds that most of
the GIS services in India cater to the overseas
market, particularly the US. “There’s very little
work being done for the Indian market and most
of the GIS projects are commissioned by the
government sector.” Prasad, however, estimates
that in India alone over Rs 6,000 crore will be
spent on GIS in the next five to seven years. He
says, “Municipal planning, forestry and envi-
ronment, telecommunications and rural land
records are the areas wherein the action is
already on.” The GIS project for Bangalore Water
Supply and Sewerage Board, GPS based trans-
port system for Banaglore, Early Warning Sys-
tem for crop monitoring by the Ministry for
Agriculture, Disaster Management for Delhi are
some of the examples of projects carried out in
India. Thakur feels that areas such as location-
based services, remote sensing and pho-
togrametry are areas in which demand will
outstrip supply and Prasad agrees with this. So
what’s holding you back? Get set to ride the
GIS wave!fl

hitptZ 1WA,

www.gisdevelopment.net
For more information on
GIS in South Asia
www.csdms.org

Centre for Spatial Database
Management and Solution
Www.geocomm.com

A portal on GIS
www.giscafe.com
Information on job oppor-
tunities in this field
WWw.esri.com

For information on GIS
software
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Don't reach for the
phone the next time
you want to call a
friend—instead just
get out your headset
and start
videoconferencing

42 R
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VIDYARAMANAN S.

he telephone was a milestone in the field of

communication, but it has now been over-

shadowed by Internet chat. Voice over Inter-

net, although illegal, gives you a minimal bill
for frequent overseas calls. But now you no
longer have to be content with just listening to
the voices of your near and dear ones—thanks to
videoconferencing, you can see and talk with
your son or daughter settled abroad, over the
Internet, right there on your PC.

The right gear

The first thing that you need to do is check the

hardware. The bare essentials you would need

are a PC, an Internet connection, a Web camera

and a speaker-microphone combination.
Choose a camera that would give you the best

performance (see box, ‘Buying a Web cam?’).

There are certain tweaks that could help your
camera take better pictures, but tweaks don’t
always work. A cheaper camera wouldn’t deliver
agood image to the recipient and you would just
be adding another piece of hardware to your col-
lection. Opt for a better camera, though such a
camera would be priced higher.

After you've arranged for all the hardware
requisites to start a videoconference session,
what you need is software that will help you use
all of these gadgets together and talk with a per-
son in another corner of the world. A search on
the Internet can get you a good number of video
chatting software.

Videoconferencing software can broadly be
classified into two categories: software that
evolved from Instant Messengers and programs
that started off as a video chat client itself. Yahoo!
and MSN messengers fall into the former
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category while other software such as Eyeball,
Im4cam, Paltalk and the like fall into the latter.
Though all these software integrate text, voice
and video, they differ in the balance of the fea-
tures that they offer.

Go fishing on the Web

First up, the chat tools that we are familiar with.
Yahoo! and MSN both provide the facility for
video and voice chat. You can choose either of
these conventional clients depending on which
one you are more used to. All chat software
recognise the default video input device and
auto-configure themselves to the available input
device.

Installation isn't a major hassle with Yahoo!.
It has an easy-to-grasp interface, which doesn’t
confuse you with too many options to choose
from. To enable video chatting, all you have to do
is plug your camera into the appropriate socket
in your computer and choose ‘Start Web cam’
from the Tools menu. A small window pops up
in which you can see the image captured by the
camera. Camera adjustments such as brightness,
contrast, gamma, saturation, etc can be done
from the Preferences option in the Tools menu.

Once your camera is all set up, you will see
two buttons pop up in the window. If you want
your friends to see you on the Web cam, click on
the broadcast button and the messenger con-
nects you to Yahoo! video server, which delivers
the video directly to the person who requests to
see your camera. Viewing privileges can be setin
the same Preferences option as above.

Once you start broadcasting, your status mes-
sage automatically changes to the default mes-
sage, ‘View my Web cam’. This message can be
changed or disabled from the Preferences for the
Web cam. Disabling the status messages while on
camera helps you avoid unwanted peeping toms.
Yahoo! also lets you report any abuse that you

might come across while videoconferencing by
simply clicking on the Report Abuse option in
the video window of any person who is trying to
send you objectionable material.

Netmeeting is Microsoft’s proprietary soft-
ware for videoconferencing. MSN uses Net-
meeting, which is a separate program that
launches when you start videoconferencing. You
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can download Netmeeting from Microsoft’s site.
You don’t need any additional installations to use
this program, except for a one-time configura-
tion, which might require you to fill in a regis-
tration form, certain details regarding your
connectivity and related information.

After launching the software, enter the MSN
passport of the person you would like to confer-
ence with and click on the Call button. Once the
connection is established, the person’s picture
will be visible on the right-hand window.

Others in the Net

Now on to video chat clients. Installing Eyeballs
software is very simple. Register with the Eyeball
service and login with your 1D and password.
Eyeball has a glamorous, graphics-rich and com-
plex interface. You can add friends as in any
instant messenger and also search for chat

Buying a Web cam?

Be smart. Apart from good looks you should
check out other features while purchasing your
Web cam. The list given below will give you an
idea of what kind of Web cam you should

opt for:

Resolution: A camera’s quality is weighed
against the resolution that it supports and
offers. So choose one that offers a good resolu-
tion. Look for one that offers the capability of
capturing images at 640x480, at the very least.

Connectivity: Check for USB connectivity as
USB is faster and is far easier to configure than
other interfaces.

FPS at high resolution: Watch out for the
frame rates that the camera supports at high

resolutions. This is important as otherwise the
video quality would be poor when in high-reso-
lution mode—15 fps is a good frame rate for
videoconferencing.

Software and drivers: You might get a bet-
ter deal for a cheaper price but may not be able
to get the accompanying drivers and software.
You would do better to buy a camera that
comes with software drivers, which would
reduce the headache of hunting the Net for the
desired drivers.

Price: Needless to say, buy something that
suits your pocket but keep the above points in
mind while making an investment so that you
get your money’s worth.

Video Broadcasting

Video broadcast over the
Net has been made much
simpler for home users.
There are lots of free servic-
es on the Net, which allow
you to stream or broadcast
video. These are basic serv-
ices that you can use as an
evaluation before upgrading
yourself to the premium
services offered by these
companies.
www.webcamnow.com provides
you software that is free for
download, with the aid of
which you could broadcast
live video over the Net. Go
to the site, create an ID and
download the broadcast
software. Install the soft-
ware and login with the ID
you created, and you are
ready to broadcast. You can
see your broadcast in the
community area you joined
while creating the ID. The
site hosts livecams, which
can be viewed from any
Java enabled browser.

You can use the iClips
service (www.iclips.com) to
create and upload stream-
ing movies on your Yahoo!
profiles. A free registration,
and you are entitled to 20
MB of free space on the
iClips streaming servers. You
could request for more
space and streaming fea-
tures by contacting iClips.
Share a preview of your new
house or your baby walking,
with friends all over the
world. You could even put
up an advertisement for
your product with a small
video on your profile.
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http://www.im.co.kr/Eng-
lish/index.htm

Gives you all the services
offered by Im4cam
www.iclips.com

Download software for cre-
ating and streaming video
www.eyeball.com
Download the software
and check out other offers
www.paltalk.com
Download the Paltalk
videoconferencing software
for free

VY digit]

groups at www.eyeball.com. Clicking on the Groups
button in the interface takes you to the site where
groups are listed. You can enter any of these chat
groups and start video chatting with people
instantaneously. The site tells you a user’s status,
using different colours in the displayed names.
For example, a name displayed in orange would
indicate that the person is in a videoconferenc-
ing conference with another user, blue indicates
that the person is logged onto the Eyeball soft-
ware and is available for video chat and grey
indicates that the person has just come to the site
to chat but is not logged on to the software. You
can browse the room and if you wish to video
chat with a particular user, click on the video
button and the software automatically launches
from your computer. Once you log in , a request
is sent to the user you want to chat with and if
the user accepts, a chat window pops up and you
can see him/her.

All at once!

Im4cam stands apart from the conventional
videoconferencing software. It isn’t a one-to-one
videoconferencing software; instead, it is more
like entering a video chat room. It has an array
of 10 windows, which help you see the people in
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Colour differences in Eyeball show user status

a particular room. You could either use the com-
mon window to send messages or right-click the
user name to send a personal message. What’s
different about this software is that each user can
hear all the others. This is an excellent piece of
software for personal videoconferences and
could prove useful to an organisation which
requires its personnel from various parts of the
world to collaborate. You can create a personal
room, and you could restrict access to a chosen
few by applying a password. You can get togeth-
er with relatives or even your girlfriend abroad,
without anyone else butting in!

Let’s get pally!

While Paltalk functions similar to Im4cam, it
doesn’t have a multi window display. This, again,
is a chat room setup where you can click on any
user and initiate a chat. The best thing about
Paltalk is that it has child protection enabled.
Hence, if someone types an obscene word in a
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Collaborative use of Im4cam

general chat room, it automatically boots
him/her from that room. This is a good feature
if your children use Paltalk to talk to their friends
or relatives. If you subscribe for Paltalk’s premi-
um services, you can see the video in the main
window, which reduces the hassles of going to
private chat to see a person’s cam. This software
also lets you create locked rooms and you can
choose to invite people to join your group. There
are other benefits that you could gain if you
become a premium services member by paying
an amount upfront.

How to pick?

So how do you go about picking the best? Some
software boast distinct features but lack in cer-
tain aspects. For example, Im4cam lets you have
multiple people in a conference but lags in speed
of text delivery and is also prone to crashes.
While choosing a videoconferencing software,
you should base your judgement on your
requirements and certain other parameters. For
example, if you want ease of control and also the
ability to hold multiple one-to-one conferences
simultaneously, then Yahoo! serves the purpose
quite well. Netmeeting doesn’t allow you to have
multiple video exchanges simultaneously but it
has a unique ‘picture in picture’ feature that is
missing in the others.

Organisation-based videoconferences can be
held using the Im4cam multiple window soft-
ware. Voice and video can be exchanged simul-
taneously between 10 people at a maximum.
But, neither of these software has the facility to
report abuse on the usage of Web cams, except
for Yahoo!.

Videoconferencing is a huge tidal wave
engulfing people all over the world. Choose the
software that suits your purpose, get the basic
gear in place and start conferencing with your
pals and peers, one-to-one or one-to-many. The
best part is it doesn’t leave much room for para-
noia; so the next time you're chatting with foxy-
chick_22, you can find out for certain if the
person belongs to the female species!f
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Trapped In the Web

Bookitty: I m new here don t borg me o
saoes of lotekville.
Topgun: Hey, poccd You still here? Get a

SRIRAM SHARMA
t's 1.00 in the night, and you meet the same
bunch of anonymous names at IRC. Behind

Instant Messengers: a
boon or a bane?

the pixelated glare of the screen, the distinc-

tion between inner and outer worlds almost
disappears. You sit almost motionless, your
hands typing away to cryptic names who are as
immersed in this world as you are.

Topgun: Hey lock guys we got a newbie in
axr midst!

Necromancer :
here boddtty?

How often do you come

Tife!

Poots: I dm t have ae, topd
Necromancer: Hiya Smokey!
again? I saw you this moming.
Sir Swkalot: I needed another fix... IOL!
(Wdter s rote: sic sic sicl)

You back

Studies conducted of late seem to confirm
various anecdotal accounts of people being
‘hooked’ to the life online, at the cost of their
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personal or professional life. The sweet lure of
instant communication technology is stimulat-
ing, hard to resist, rewarding and thrives on the
fact that most people don’t know when to stop.

What was once considered a disorder for com-
puter enthusiasts and college kids high on band-
width is now a widespread social phenomenon. A
report, ‘Teenage Life Online’ details the rise of
what it calls “the instant-messaging generation”.

Internet usage has multiplied many times
over with the rise of instant messengers or 1Ms.
It all began as a simple, quick way for teenagers
to swap brief, synchronous messages over the
Internet—make small talk, crib, complain, and
flirt. But in four years, instant messaging has
grown to become the biggest ‘killer app’ of the
Internet after e-mail. And the market is growing
every day: AOL's IM and ICQ services alone
account for about 750 million messages each day.
AOL's AIM and ICQ software claim to have 130
million users, while Microsoft reports 18 million
users. Yahoo!, another leader in the field, declines
to reveal its total instant messaging user base.

For the uninitiated, instant messaging allows
you to maintain a list of people you wish to inter-
act with. You can send messages to any of the
people in your list, often called a buddy list or
contact list. Sending a message opens up a small
window where you and your friend can type in
messages that both of you can see.

IMs allow you immediate, quick-hit commu-
nication, just like a phone conversation, and pro-
vide ability to converse with many people at the
same time. IMs bring the best of both worlds,
the expanse of the Web and the instantaneous-
ness of the phone. This is why instant messaging
has gained such unprecedented popularity.

Raahila, an Internet veteran, who started
using messengers about two-and-a-half years
ago to chat with friends abroad says it has
become an indispensable part of her daily rou-
tine now: “My friends abroad don’t seem so far
away and that includes online friends too since
they’ve become a part of my everyday life. It's an
easy and cheap way to keep in touch.”

Humans have an intrinsic ability to multitask;
it's no surprise this seemingly benign technology
has enmeshed itself into our lives. Rukmani
Saradha, an EEE student, always keeps her mes-
senger on whenever she surfs, be it for fun or aca-
demics. She feels that chatting has helped her
know a lot about people. “I've got so many new
friends—people who study in my college. | was
not so close with them earlier, but after chatting
I've come to understand a lot more about them.
It's not just the matter of getting new friends, you
learn facets about people you didn’t know before.”

Chat in the workplace
No longer just a tool for exchanging information
and interacting, instant messaging has swamped

the workplace where professionals swap industry
information and gossip—all in the blink of an
eye. Instead of traipsing down the hall, making a
phone call, or waiting for an e-mailed response,
employees can communicate with one another
via online text, ‘pinging’ each other questions and
requests, speeding up reaction rate and increas-
ing productivity. According to a recent Jupiter
Media Metrix report, more than 11 million peo-
ple use instant messaging services at work. For
employees working on location and supervisors
stationed outside of home offices, instant mes-
saging is rapidly becoming indispensable.

Using IM at the office does have significant
advantages, as long as it’s a planned part of your
infrastructure. For brief, immediate communi-
cation, it beats a phone call or e-mail. So what’s
the problem with free IM programs? Productiv-
ity, for starters. Are your employees gossiping
with their friends or using IM strictly as a means
of business communication?

Tripti Awade, CEO of Alnishsoft, feels that
IMs have extended the professional grounds for
her business contacts and considers it a wonder-
ful CRM tool. But she remains sceptical about
its purpose. “Chat should be banned in the work-
place as it hampers productivity and slows down
work, especially among junior members who
tend to use it for whiling away time.”

Picking favourites
The spillovers in the battle for the instant mes-
saging market have left many users confused with
arange of software applications. Yahoo! and MSN
were clear favourites; many people loved Yahoo!’s
feature of leaving offline messages and MSN for
its simplicity. The early adopters, however,
depend on ICQ because of the sheer number of
contacts and applications possible. But heavy
Internet users pick no favourites among messen-
gers; they just turn them all on. Companies like
Trillian, Jabber and Odigo provide some relief by
making instant messengers interoperable.

Chandrashekhar, an avid Linux enthusiast and
long time netizen, uses GAIM when he’s on Linux
and Jabber when he’s on Windows. Laila, on the
other hand pledges her loyalty to ICQ because, as
she says, “with ICQ you can see exact-
ly what the person types without any
corrections, it has a history log, and
it's the closest you can get without
actually being face to face. Yahoo!’s
beta version is cool too” She was not
too keen on chatting in public chat
rooms though: “You hardly find any
interesting people. It’s like a free-for-
all”

Messengers are getting more
indispensable thanks to connectivi-
ty on mobile devices like cellular
phones and PDAs. It won’t be long

Get a Life!

A 10-step recovery program
for online addiction

M Use a timer or alarm
clock. Use software that
keeps track of online time
and Net usage.

M If possible, make sure
your computer is not in an
isolated room.

M Rearrange furniture, set
things up so it's not so easy
to lose track of time while
using the computer.

B Have the radio on, per-
haps a TV program that
regularly mentions the time
of day.

B Change your habits. If you
tend to get online first thing
upon awakening, choose
something else to do first.
M Try taking a holiday,
unplug every now and then
and use that time to sort
out priorities and goals.

B Make sure you finish all
your important chores first,
and then perhaps allow
yourself some online time
as a reward.

H Cultivate other interests,
hobbies, and passions.

B Take a walk rather than sit
down and log on.

B Turn off auto sign-ins, use
busy signals, and don't be
afraid to delete and block
people.

Habbo Hotel: a virtual five-star hotel
for teenagers
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Are you Addicted?

Internet Addiction Disorder
(IAD) refers to pathological,
compulsive Internet usage.
The criteria for this disorder
are similar to those for sub-
stance abuse disorders.

IAD is different from
Pathological Computer Use
(PCU), a condition where
someone is pathological
about any aspect of com-
puters, and includes uses
that are not social in their
nature.

The following criteria
were used for assessing IAD
in a large initial study of this
problem. If a person meets
four or more of the 10 crite-
ria, he can be diagnosed as
suffering from IAD.

m Do you feel preoccupied
with the Internet or online
services and think about it
while offline?

H Do you feel a need to
spend more and more time
online to achieve satisfac-
tion?

B Are you unable to control
your online usage?

m Do you feel restless when
attempting to cut down or
stop your online usage?

m Do you go online to
escape problems or relieve
feelings such as helpless-
ness, guilt, anxiety or
depression?

H Do you lie to conceal how
often and how long you stay
online?

B Do you risk losing a signif-
icant relationship, job, or
educational or career oppor-
tunity because of your
online use?

H Do you keep returning
even after spending too
much money on online
fees?

H Do you go through with-
drawal when offline, such as
increased depression,
moodiness, or irritability?

H Do you stay online longer
than originally intended?
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before instant messengers start to offer seamless
connectivity. Platform, software and connectiv-
ity are all issues, which will sort themselves out
soon. It’s only a matter of time before computer,
telephone and video technology will merge into
one—perhaps highly addictive—beast.

Why the addiction
E-mail discussion groups, chat rooms, bulletin
boards and MOQOs (Object Oriented Multi User
Dungeons) offer people an opportunity to expe-
rience a form of social contact and make virtual
friends. But none of them match the industrial
strength addictiveness of the GMUKS (graphical
multi-user konversations). GMUKS, or visual
chat in simple terms, are something of a cross
between a MOO and a traditional chat room.
As social environments, GMUKS are unique in
that they are graphical. Rather than limiting users
to text-only communications as in most chat
rooms, multimedia programs add a visual element
that creates the illusion of movement, space, and
physicality. It allows people to express themselves
visually, rather than just through written words.
The opportunities for self-expression and social
interaction are much better, giving room for sub-
tleties and complexities not seen in text-only chat
rooms. One such haunt is the online multimedia
community known as the ‘Palace’. Combining fea-
tures of MOOs and chat rooms, the Palace is a
visual and spatial environment where members

Chandrasekhar

Pathological Net addict things

interact with text, sounds, and graphical represen-
tations of themselves called ‘avatars'

GMUKS have had a huge impact on
MMORPGs (Massively Multiplayer Online Role
Playing Games) like Everquest, Ultima Online, and
Asheron’s Call. These games focus entirely on the
social aspect of multiplayer gaming, and most of
the time is passed making acquaintances and
socialising. The team element is extremely vital to
getting ahead; you have to partner up to destroy
fire breathing dragons and monsters. It's the social
aspect that makes the games so addictive.

Isthe Web addictive or do addicts use the Web?
The significant difference between Net relation-
ships and ones maintained by other existing tech-

Invisible says:

well, it wasn'’t really bad,
it just prevents you from
having a real life
Invisible says:

if you do it too much
invisible says:

but that applies to most

nologies (telephones, mail, fax) is that the Inter-
net allows for, and even encourages contact with,
relative strangers. The probability of any real-life
repercussions for online social activity is very low,
and that makes people feel free to express them-
selves in an unrestrained manner. This is a natu-
rally exciting, stimulating and reinforcing aspect
of the Internet.

However, finding regular escape in cyber-
space also has side effects—missed deadlines, lost
jobs, low grades and loss of weight. It's only after
you get unplugged that you realise the ramifica-
tions of this addiction, especially when they
manifest themselves in the form of phone bills.

John Suler, PhD and faculty member in the
Rider University Psychology department, has
written some extensive papers on the psychology
of cyberspace relationships. In his papers on
Computer and Cyberspace Addiction, he writes,
“A teenager who plays hooky from school in
order to master the next level of Donkey Kong
may be a very different person from the middle
aged housewife who spends $500 a month in
AOL chat rooms—who in turn may be very dif-
ferent from the businessman who can’t tear him-
self away from his finance programs and
continuous Internet access to stock quotes. Some
cyberspace addictions are game and competition
oriented, some fulfil more social needs, and some
simply may be an extension of workaholicism.”

A person by the name Solz in #bookwarez (a
channel in IRC) spoke at
length about being a chat
addict. “It's a wolf in sheep’s
clothing, really. Sure, it's
fast. It’s free. It's easy. You
can leave it on all day if you
have cable Internet like |
do. Everyday, | wake up, |
turn on my computer, |
check my e-mail, and | sign
onto Instant Messenger.
Then | start chatting. It’s
an addiction, really. I have
to, almost need to, be at my
computer when in its presence.”

Chandrasekhar messages me in the wee hours
of the night as | write, “You know what really
sucks? You can't really make out anything about
the person on the other end when you really
want to, and you don’t know if any of it is true.
It freaks out paranoid people like me ”

Net evangelist Howard Rheingold makes a
good defence: “One might think the Net a cold
place, and yet it need not be. In the impersonal
isolation of our large cities, where people often
live separated from kin or lonely amid the mul-
titudes, the Net can become a surrogate social-
life—a vital source of interpersonal contact
despite its non-physical nature.fl
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The best Indian dotcoms

ying dotcoms, flagging e-commerce sites—they’re all around
us. So does the Internet still make a difference? Or have peo-
ple given up hope in the Internet as a medium that can make
our life easier, enabling us to take care of tasks that used to
be expensive and time-consuming? Wrong! If you look beyond
the R.1.P signs in the dotcom graveyard and the ‘not-so-sunny’
outlook for anything online, you'll realize that the Internet is
growing and maturing. People in India and across the globe are
using the Internet more than ever, not just for information and
communication, but also for education and entertainment. This
is corroborated by numerous Internet surveys conducted by firms
such as Gartner and IDC, as well as by online polls conducted by
us for the Popular Choice Awards, which saw an unprecedented
number of Internet users voting for their favourite sites.

What are Web Awards 2001?
The Digit Web Awards 2001 confer hon-
ours on the most popular Indian Web
sites—those sites which have kept their
promise of delivering quality to the
audience—from fields as wide as infor-
mation, aesthetics and usability to serv-
ices like shopping, education and travel.
Digit Web Awards 2001 acknowledge
these achievements, tell what’s really
good in the various sites, and try to bring
the masses closer to the Internet.

The Digit Web Awards 2001
have nominations in 12 cate-
gories: Health, Entertainment,
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Shopping & Auction, Sports, E-learning & Education, Search
Engines, Information & portals, Communication & Mail, Jobs &
Careers, Travel, News & Analysis, and Banking & Finance.

These sites have been picked by our editorial team from the
plethora of popular Indian sites keeping in mind parameters like
content, aesthetics and usability. ‘Made in India’ is the most
important criteria to make it to this space; hence the absence of
Indian versions of prominent International Web sites like
msn.co.in or monster.co.in.

The judging process
The final judging process to select the winners of the Digit Web
Awards involved the examination and evaluation of all the nom-
inated sites—a total of five in each of the categories—across
parameters like Quality of Content, Ease of Navigation, Aesthet-
ics and Design. The judges were in-house and selected by the
Digit editorial panel.

Popular Choice Awards

Almost 10,000 Internet users voted for their
favourite Web sites during the course of our
online polls for the Digit Popular Choice Awards.
The voting, which took place over a period of 15
days beginning from the 1st of October 2001, saw
close to 10,000 people vote. While some cate-
gories like Information & Portals and Jobs &
Careers witnessed really close battles, others
like Communication & Mail and Sports had
the popular sites winning by a consid-

=  erable margin.
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tlmesofmoney com

Banking & Finance

of finance and money management or a seasoned
hand at trading, these sites can offer you value for
money. They pack in useful tips on how to put your
money in the right places, tutorials on the basics of
insurance, tax planning, shares and stocks, mutual
funds and so on. For the more experienced, they offer

THE ABSOLUTE WINNER
JUDGES CHOICE & POPULAR CHOICE

Whether you're a newcomer to the complex world

/

" Scout for the
best personal
finance options
with Click and
Compare

Does talk about NAVs, equity or insurance befuddle you? If you need
to learn more about investing and where to put your money then Time-
sofmoney.com is a great place to start. The site is divided into sections
such as consumer finance, investment and an NRI centre. Scouting
around for information on where to get loans at attractive interest
rates? The consumer finance section has all the dope—from personal
loans, home loans and auto finance to applying for a credit card
online. You can also read up on the basics of how to apply for loans,
compare loans and read tips and handy pointers on shopping for the
best deal and what to look for in the fine print before you sign on the

dotted line.

If you want to make your money grow, then you should head to
the investments section which has information on how to put your
money in mutual funds, apply for insurance, stocks and bank
deposits. The site has tutorials on how to get started that function
like a ‘how-to’ of investing in mutual funds and shares. It also has
stock quotes, fund search, fund analysers, market commentary and

Top of the Web (% votes)

Timesofmoney 34
Apnaloan 22
Kotakstreet 15
Equitymaster 15
Personalfn 14

hot trading tips.

You can buy and sell
shares online and manage
your portfolio too. Besides
this, Timesofmoney also has
online bill payment, tax
planning and ‘Remit to India’
services.

online.

- [ www.kotakstreet.com

Kotakstreet offers online trading
services as well as news and
information about the stock mar-
kets. The site provides market
commentary, in-depth analyses,
stock trading tips and company
research. You can trade, buy and
sell stocks and make payments
online. It has tools to manage
your portfolio and keep track of
the buying and selling record in
your online account. Sign up for
Kotakstreet’s daily bulletin to be
updated with the latest happen-
ings in the ring and hot juicy tips
on what stock to pick up.
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Think stocks and equity and
Equitymaster is what comes to
mind. This site is one of the best
online resources for research
on stocks and equity. It has
detailed stock quotes and online
trading, besides detailed market
reports, graphs and analyses to
help you make all the right deci-
sions. Trade online from the
convenience of your desktop
and keep track of your choicest
stocks through Equitymaster
Portfolio Tracker. The site also
keps you updated with stock
tickers

detailed and reliable research on securities and mar-
kets, and insurance and portfolio management. No
more standing in queues to pay your bills or to file
your taxes or visiting banks endlessly to procure loans.
From online loan approval to bill payment to filing tax
returns online, these sites will get it all done for you

{ www.personalfn.com

Personalfn has information,
news and services on everything
to do with personal finance—
insurance, mutual funds, loans,
housing, credit cards and so on.
The content on the site is com-
prehensive and every subject is
explained in a manner that’s easy
to understand. You can shop
around for the best options as
well as apply online for loans,
credit cards and insurance. Per-
sonalfn has handy tools such as
loan calculators, marriage plan-
ners, education, retirement and
PPF calculators.

Wwww.equitymaster.com [ www.apnaloan.com

Apnaloan is perhaps the best bet
if you are seeking to satisfy your
personal finance needs. The site
has tie-ups with some of the
biggest banks and financial insti-
tutions in the country in order to
bring you loans at reduced rates
for a variety of purposes—
homes, automobiles, household
goods, for the purchase of land
and for travel. You can apply for
aloan online (which is sanc-
tioned after furnishing the
relevant documents) and you
can even check your loan

status online.
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» Communication & Mail

-mail has transformed communication in the
twenty-first century. And the Indian sites offer-
..... ing e-mail services have held their own against
the mighty ‘foreign’ sites and created a decent num-
ber of user base. These sites offer more just an e-mail
services; they present communication solutions that

are reliable and, more importantly, fast. Message
composing options, advanced folder management,
mail filtering, and integration with your other mail
accounts are just few of the services that they
provide, besides the ability to send mails in any
language.

( mail.indiatimes.com

- [ mailssify.com

¢ wwyv.rediffmail.com%
COID e

THE ABSOLUTE WINNER
JUDGES CHOICE & POPULAR CHOICE

/4
7 Use voicemail;
grab a mike, hit
‘record’ and
attach a voice
message to your
e-mails

Lightning fast e-mail that reaches its destination seconds after you
Hit ‘Send’. That’s Rediffmail. The inbox has an uncluttered design and
a neat layout. The pages are light and don't take forever to download

into your browser.

Rediffmail offers folder management to store your mail. You can
also create your own folders. The address book has options to store
mails of individuals or groups so that one can send out group e-
mails. You can change your display name in messages according to
your preference—it doesn’t depend on what name you entered in
the registration form. You can also add your signature to e-mail

messages.

Rediff has a mail filtering option which lets you block senders by
entering their e-mail address. In case you are going on vacation or
are so swamped with work that you can't reply for a while, set your

vacation mail to notify your friends.

You can also send voicemail from Rediffmail. All you need is a
microphone and a couple of clicks and in seconds a voice message

Top of the Web (% votes)

will reach your friends.
You can use Rediffmail to
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Sifymail has helped bring e-mail
to a wider Indian audience.
Apart from English, it supports
mail in eight Indian languages.
The interface is intuitive and has
options for you to customize the
appearance of your inbox by
using different colour schemes.
It has an address book and set-
tings for signatures as well as
mail filters and the mail search
option. You can also access your
POP3 mail account through
Sifymail.

. www.epatra.com

Epatra is a multilingual e-mail
service that supports Hindi,
Marathi, Gujarati, Punjabi,
Malayalam, Assamese, Bengali,
Tamil, Telugu, Kannada and
Oriya, besides English. Even if
you use another e-mail service,
you don’t need to download Indi-
an language fonts to read a mail
sent through Epatra. It lets you
choose the language you are
comfortable with as your default
language, and you can use other

Indiatimes offers 10 MB of free
space and a whole host of inno-
vative features and services. The
latest is the ‘Videsh se Sandesh
Seva’ for NRIs in the US who can
send letters anywhere in India
through their Indiatimes mail.
Indiatimes also has calendars,
appointments, reminders and a
briefcase where you can store
your files online. Indiatimes mail
composer is really good with for-
matting options for your mes-
sage text like background, fonts,
etc and you can send HTML mail
through your Indiatimes account.

* mail.indya.com

The e-mail service at Indya
looks like just another e-mail
service with the usual features,
but it's not. It comes packed
with an address book, a calen-
dar, a To Do list with features
like spam filter, safety filter,
vacation reply, automatic filing,
and tools to manage your mail-
box better. Indya mail has some
pretty good external mail set-
tings—you can activate up to
three POP3 mail accounts and

Rediffmail 51 download mails from other languages as well. It also has a assign a colour to them to know
Indiatimes 22 POP3 accounts. Just add in post-a-mail option that lets you instantly which mailbox the mail
Epatra 10 the settings and you'll be able send a mail by post. is from.

d 9 to keep track of multiple
Ir! ya accounts through one
Sify 8 account.
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WINNER — JUDGES CHOICE

oing homework certainly has
Dchanged, thanks to the Net.
Education and e-learning sites
leverage the power of the Web to
enrich the learning environment
of students in schools and col-
leges. Utilising study tools like
online encyclopedias, tutorials,
and informative articles, these

sites do a great job of networking
teachers, parents and students.
They also make education fun
and provide aid for college stu-
dents to pursue studies further.
They also facilitate professionals
to get a shot at continuing educa-
tion and upgrading their skills
online at affordable rates.

Is your day so busy that you can’t make time for a full time
course or even spare a couple of hours a day to upgrade your
IT skills?

Netvarsity is the perfect place to learn at your own pace.
It has a wide range of both short and long-term courses as
well as IT certifications like MCSE and MCSD at affordable
rates. Netvarsity also has online tests to help you test your
understanding of subjects. The site offers tips on e-learning
which helps you get accustomed to learning on your own.
Chill out at Netvarsity’s ‘Coffee Shop’ where you can try your
hand at fun tests, post graffiti on the Wallmag, read up on
book reviews and bond with other students at Netvarsity.
Techrag helps you catch up with the latest news and updates

[ www.netvarsity.com
Bty o
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on what's happening in the IT world, while you can read up on
how to make the right career choices at ‘Career Post'.

Test your knowledge
with online tests and
then read up in the
library
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Top of the Web (% votes)

WINNER — POPULAR CHOICE

Egurucool 36

Netvarsity 277 \\‘i‘\ ~ www.egurucool
Gurukulonline 16 \ 2 T fr
Schoolnetindia 11

Zeelearn 10 :

S

eGurucool leverages the Net to enhance your educa-
tion and learning experience. The site’s ‘Smartstudy’
has e-courses to match the requirements of different
school education boards like ICSE and CBSE. Smart-
study is available for schools in India and in the Gulf.
You can pay for the course and get it activated online.
The site also has resources to help students prepare for
entrance exams like test papers for medical entrance
exams. It has a wide network of learning centres all

eConnect service connects teachers, students and par-

( www.zeelearn.com

Zeelearn brings together some of
the best educational resources on
the Web like Campusmatters.com,
schoolsahead.com and e-learning
from Zeduniv which has courses
and modules on IT learning—all in
one window. The link to Campus-
matters displays information on
universities in India and abroad;
Schoolsahead has online tutorials
and learning aids. Zeelearn has a
section on offbeat careers and
offers the facility to chat with
career advisors.

‘wwwi.schoolnetindia.com
Homework will never be boring
again, not if you get it done at
Schoolnetindia. This site makes
learning fun with projects,
quizzes, interactive tools and
utilities, online tests, tutorials
and links to sites that aid learn-
ing. There’s a section for parents
with articles and ways on how to
help their kids enhance their
education online. You'll also find
directories and Web pages of
schools, e-dictionaries and
online encyclopedias.

‘www.gurukulonline.com

Gurukulonline provides interac-
tive e-learning solutions for IT
skills and online training for the
corporate sector. The site has a
wide range of courses, from
computer basics to solution
architecture. Gurukulonline
online courseware is compre-
hensive and supported by graph-
ics for comprehension. Virtual
classrooms ensure that your
online experience is fruitful. You
can download applications like
the Gurukulonline e-learning
assistant to aid learning.

over India to supplement online courses. The site’s

ents with services like eAssignments and eClassnotes.
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Entertainment

f you think there’s not enough
entertainment online, these sites
will prove you wrong with online
games, contests and promos, and of
course, the added lure of prizes.
These entertainment sites keep you

music, and theatre—with news,
views, reviews and interviews. You
can also catch up on movie release
dates and trailers, and sing along to
hip new numbers as well as golden
oldies. For the couch potatoes,

in touch with the latest buzz in the
entertainment industry—movies,

there’s news on the hottest soaps
and movies on the boob tube.

WINNER — JUDGES CHOICE

You'll never get tired of freaking out at Hungama. This site has
loads of attitude. Cool contests and promos which get updat-
ed on a regular basis give you a shot at winning some great
prizes. Hungama'’s Trivia section has questions on Bollywood,

www.hungama.com

CLAEK HERE TOODRIWVE A |
FIRRWLLA ! LAR TGODAY -

e o R Y business, sports, movies, and history. Questions are updated
e b e several times a day to give you a chance to win Hungama
BIr s points, besides preparing you for the ‘hotseat’ at KBC. If triv-

i i ia’s not enough for you, chill out and win loads of points at the
P e i, Hungama Gaming Zone. You can redeem your points at the

Redemption Centre or enter the Hungama Sweepstakes and
bid for stuff like cell phones and music systems with your
Hungama ‘Cyberpoints’. Hungama also has sections where
you can catch up on Hollywood and Bollywood buzz. Read up
on book reviews at the Hungama Bookshelf and buy some of
your favourite titles. You can also send e-greetings and buy
music and CD titles.

Win cool stuff like
mobile phones at
the Hungama
sweepstakes

Top of the Web (% votes)

Indiafm 63

Hungama 18 \\ www mdlafm com
Contests2win 1 N\ e <'- =
Indiagames 5 - Bk Ly | N ]
Glamsham 3 ll"#fﬂﬁ"l

This site has the juiciest gossip in tinsel town, plus .-..; -
reviews, news, trailers, and movie stills of the latest
flicks. A watering hole for the star-struck and the gog-
gle-eyed—one can read and listen to interviews, catch
up on favourite actor’s birthday and head for links to
Web sites on stars in the film industry.

The online jukebox at Indiafm has clips of the latest
Indipop songs. The site also has lyrics to sing along x
with the audio clips, in addition to downloads, wallpa- ST
pers and screensavers of the latest Hindi flicks.

WINNER — POPULAR CHOICE

THE OTHER NOMINEES

( www.glamsham.com

Tinsel town, glamour, music, and
theatre—that’s what Glamsham
is all about. The movies section of
the site has reviews, previews,
trailers, news snippets and links
to movie sites. It also has a list of
star birthdays and interviews. If
you're a theatre buff, there’s plen-
ty happening in English, Marathi,
Hindi and Gujarati drama, includ-
ing a listing of schedules and
reviews. Glamsham also has
music charts, lyrics and audio
files of popular songs.

‘www.contests2win.com

This is the place to try your luck
at winning prizes. Contests2win
hosts some well designed inter-
active promos and contests and
lets you keep track of points and
credits that you win while partic-
ipating. From the Contests2win
family come sites like Quiz2win
and Polls2win where you can
answer trivia questions and win
prizes.

‘www.indiagames.com

Indiagames’ genre lies in videshi
action games with an exclusive
‘made in India’ tag. Examples are
Yoddha (the warrior) and Aakra-
man (attack) and several multi-
media games with a Bollywood
or a festival theme. The site has
games for kids as well. You can
sign up, create your profile, and
keep track of your scores. The
site also facilitates interaction
with other online gamers through
message boards and instant
messaging.
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portal a day keeps the doctor
" Aaway. You might still need a nervous visit to the family doctor
doctor in real life but updating to settle anxieties or minor queries

people-friendly. What used to be a

..... ¥ yourself on health and fitness will is now supplemented by online
ensure that you maintain a well- heath portals which update you

balanced lifestyle.

about ailments, solutions available,

Online portals have demystified and how to contact doctors
medicine by making it more for help.

rveda. oo
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The site which
can help you
adopt Ayurveda
inyour life

Top of the Web (% votes)

Healthlibrary 27
Apollolife 26
Doctorsaab 23
Allayurveda 14
Askdrshah 10

The virtual medical library at Healthlibrary.com is a one-
stop resource for information on health and medicine.
The site has the world’s largest consumer heath library
online as well as fully unabridged medical textbooks and
health magazines available absolutely free for reference.
Healthlibrary has reading rooms that you can enter
to research specific topics on ailments and diseases.
The library also contains directories of hospitals and
doctors in India as well as medical equipment manu-

WINNER — JUDGES CHOICE

Everything you ever wanted to know about Ayurveda and how
it can help you live longer is present in Allayurveda. The
ayurvedic approach to diagnosis and treatment of ailments
and diseases helps you understand your body and incorporate
this ancient Hindu science of health and medicine in your
lifestyle through food and diet planning, Vastu Shastra, medi-
tation and spiritual remedies like mantras and music therapy.

The different sections of the site contain Ayurvedic solu-
tions for common ailments, home remedies, health tip of the
week and recipes for eating healthy. Allayurveda has a Herb
dictionary listing the A to Z of herbs used in Ayurvedic treat-
ment. You can also buy herbal products at Allayurveda. The
site has alternative treatments like Acupressure, Reiki, Aro-
matherapy and even Laughter Therapy.

Then, you can keep yourself updated on the latest
research findings of ayurvedic physicians and institutions in
India and abroad.

WINNER — POPULAR CHOICE

\\% ( www.healthlibrary.com
fealth fibrary ceim
Erapmesior o it o I i .,-
|

[%2]
Ll
Ll
-
=
o
=
o
(1T}
I
=
(@]
Ll
I
~

facturers, pharmaceutical companies and blood banks, tions in India.

medical bookstores and libraries and medical associa-

(www.doctorsaab.com

This site takes care of questions
you wanted to ask but didn’t
know whom to approach. From
human health and diseases to fit-
ness and nutrition, and from the
basics of medicine to applying
first aid, Doctorsaab explains
everything simply and clearly.
Don’t miss the ‘Home remedies’
section which lists panaceas for
common disorders and illnesses.
‘Doctor’s corner’ is a place
where doctors can exchange
views and information.

{ www.apollolife.com

Apollolife caters to people seek-
ing medical information as well
as doctors, hospitals, and NRIs.
The homepage lists information
of health and diseases while
links on the homepage take you
to separate sections for the rele-
vant target audience. Navigate
through the Cancer or the Aller-
gy Centre or read up on Ayurve-
da. Apart from information,
Apollolife has useful health tools
like a calcium calculator or a
diabetes risk test.

 www.askdrshah.com

For those who prefer to take an
alternative path to medicine,
AskDrShah is all about the use of
homoeopathy to cure illnesses
and staying healthy. The site has
information about homoeopathy
and its advantages, and strives
to provide a better understand-
ing of the science through FAQs,
myth-busters and information on
sources of homoeopathic medi-
cine. It displays information on
health and diseases and how
homoeopathy can be a panacea
for bodily disorders.
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around in cyberspace, haven't you wished that
there was a single site through which you could
access the best? That’s what portals do for you. Online
portals are our windows to the Web world. They are
single-access points, which help us explore the Net and
find what we’re looking for. These Indian portals bring

With hundreds of thousands of Web sites floating

- [ www.123india.com

123india.com has a wide variety

you all that you need from content to online services
like e-shopping, auctions, as well as communication
tools like e-mail, chat rooms, instant messengers,
forums, message boards, etc. These portals are also
popular hubs where surfers can converge together and
be a part of an online community where they can
exchange ideas and views online.

_ www.indiatimes.com

This portal from the Times Group

7 With its posi-

services and

to the Web’

Rediff is the undisputed king of Indian portals. It’s probably one of
the few sites to live up to its name in Indian cyberspace in terms of
the quality and services offered to online users. The site is fairly
well laid out. Whether it’s producing content in-house or partnering
with other Web sites, Rediff is constantly innovating to offers users
nothing short of the best, be it news, buying information, finding a
job, making financial decisions or just meeting people. The site also
has an online shopping section featuring books, music, apparel,
cassettes and CDs. It has services such as e-mail and Rediff ‘Bol’,
an instant messenger.

Rediff has channels on news, finance, money, astrology, contests,
e-cards, movies, women, contests, matrimonials and auctions. Red-
iff's Guide to the Net is a neat tool and so is Rediff Matchmaker. The
latter is a great place to find the love in your life. If you are looking for
information on a particular topic and have absolutely no clue as to
where to start, then the Rediff search should be helpful. The search
results are fairly accurate and it also has a fairly good Web directory.

And don’t miss Rediff’s ‘hot

L] N RU RV GO keywords'—use this to locate

Rediff 37 some great sites.
Indiatimes 34
123india 11
Indya 11
Sify 7
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of sections—cricket, contests,
games, jokes, shopping, movies,
music, news, finance, horo-
scopes and others. The online
clubs are an interesting feature
of 123india. They enable you to
bond online with people who
share the same interests as you.
If clubs aren’t your scene, then
find the love of your life at the
‘Love and Romance’ nook. The
site also offers services like e-
mail, forums, chat, e-greetings,
homepages, but you need to pay
to use these services.

. wwwasify.com

Sify has a large number of sec-
tions in addition to an aggrega-
tion of a number of sites
belonging to the Sify network.
The site is quite well laid out and
doesn’t confuse you. Navigation
is a breeze with drop-down
menus and a well-categorised
homepage. It provides services
such as search, e-mail, e-greet-
ings, shopping, news and so on.
Check out ‘The Café’, which
offers you a medium for commu-
nication with people online
through clubs, messengers, chat,
and mail services.

offers an exhaustive range of
sections covering information
on a variety of topics ranging
from entertainment to finance to
services such as shopping, auc-
tions, travel, bill pay and online
education. It's also a great place
to hang out, virtually speaking,
and make friends using online
dating clubs and chat rooms.
Play your favourite strategy and
word games online and if play-
ing alone bores you, you can
play games online with your
friends.

{ www.indya.com

Apart from the usual sections
found on a portal, Indya also has
channels such as Law, Health
and Art. Couch potatoes will defi-
nitely love the TV guide in Indya,
which features channels from the
Star TV network. Read up on pre-
views, schedules and even sign
up for reminders for your
favourite ‘not to be missed’ TV
programs. If you are in search of
screensavers or wallpapers or
would like to take a sneak peek at
cricket scores while you're work-
ing, you'll get all the necessary
tools and utilities at ‘Downloads’
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Get an instant
job alert as
soon as a
vacancy arises

Jobsahead is the perfect place to drop anchor when it comes to
advertising and searching for jobs. The site has a job search which
helps you look for jobs using a three-criteria approach—Ilocation,
function and industry. The search results display a brief description
of the job with links to find out more, as well as a brief description
about the company. You can also search within results and do a ‘One
click search’ where you just click on a link to view jobs for freshers or
even for senior management positions.

Jobsahead sees itself as more than just a job site—it’s a site
that makes the entire experience of looking for a job easy. The
Resume Builder makes creating CVs a breeze. All you need to do is
fill out various fields like personal details, education and work expe-
rience. Jobsahead also offers services like Right Resume, a profes-
sional resume writing service and Resume Blaster, a resume
forwarding service. You can track your applications, interview calls
and rejected applications from ‘Myjobsahead’. You can also sign up
for Job Alert newsletters which keep you notified about new job
openings, or the Job messen-
ger which sends you job
alerts suited to your skills.

Top of the Web (% votes)

Jobsahead 36

Naukri EY) Fzr employer?, Jo:sahead

Careerindia 1 provides access to a huge

Peool 1 database as well as ensures
eopie-one visibility to job seekers

Deevajobs 7 for a fee.

classifieds in a newspaper, put resume in an envelope,
post it, and then start the wait. Not so with online job
sites. All you need to do is use tools to build your resume,
browse for lob listings and apply for the job with a cou-

-I-ime was when one had to scan ‘recruitment’ ads and
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Search for job openings at
Careerindia through a simple
search by location, job function
or industry. You can create up to
five resumes, hide or activate
your resume or set up job alerts
according to your requirements.
You can even read up on employ-
er profiles.

Careerindia has information
and interesting articles on
career development and career
options in various industries.
The site also offers career coun-
seling and the best ways to
succeed.

 www.people-one.com

People-one has job openings
spanning a number of industries.
It also has resume creation tools.
The site features some insightful
articles on career development,
relocating and working abroad,
interviews with HR managers,
and tips on job hunting. This site
also has good articles on what it
takes to get into different
careers or lines of work.

If you're confused and can't
figure out a career option, ‘Ask
Anjali’ and she’ll help you sort
out your choices and come to a
decision.

ple of clicks. These sites make you accessible to thou-
sands of potential employers all over the world who
might have a dream job for you. For employers, job sites
are a cost effective way for selecting personnel from
thousands of resumes to fit the profiles exactly.

 (www.careerindia.com www.naukri.com

Put your resume on Naukri and
you can be pretty sure that it will
be seen. This famous job site has
a huge database of job vacan-
cies which can be searched by
location or a keyword search.
You can also browse through
jobs by category or upload your
CV to the Resume Manager at
Naukri which brings you job
alerts. Want your resume sent
out to 800 placement agencies?
Sign up for the Resume Zapper.
The site also has career advice
for students as well as for
professionals.

{ www.deevajobs.com

Deevajobs lets jobseekers
browse for job openings and
employers find good workers
with absolute ease. You can
search jobs by category or skill
and read guides on how to cre-
ate an e-resume and how to han-
dle interview questions. The
research desk carries articles on
companies. The site also has
resume builder and a ‘job flash’
for job seekers while employers
have tools to manage applicants
and an e-secretary to help

them correspond with job
applicants.
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f you're a news junkie who can’'t
wait to get your hands on taaza
khabar as it happens, then your
doorstep isn’'t the only place where
you'll get it.

Online news sites aren't just
about reporting news. They're about
leveraging the versatility of the Web
and using different means such as

WINNER — JUDGES CHOICE

B T T R e T S
SR et e o) P

waarn

OIS ey killal in livd .';.I_ﬂl.lllihlllll.lu e

to your desktop.

News & Analysis

multimedia, infographics, video or
news tickers to give users their dose
of current affairs, business or opin-
ion on what's happening in the
world. Apart from catching up with
news, these sites are a forum for peo-
ple to exchange views and opinions
through message boards, chat and
instant messengers.

This e-newspaper is truly a great place to catch up on news
updates on politics, business, sports, travel, entertainment,
weather and people. The site is well designed and easy to
browse through, considering the volume of content online.
The layout is attractive and the navigation is well planned to
let you sift through what you want with ease.

Apart from reports, interviews and exclusives, you'll find
interactive info-graphics, maps and photo-essays. Check out
the video clips of recent important events that you can stream

The Newspapertoday also features live chat with
celebrities, weather updates and polls. You can also sign up
for its newsletter to get news delivered and you may even

download the news ticker that will run news on your desk-

Customise your

newspaper and

catch news as it
happens

messenger.

Top of the Web (% votes)

Timesofindia 30

NDTV 23 \\

Rediff 22 \

Tehelka 13 b e
Thenewspapertoday 12

If you missed reading your morning newspaper, you can
catch it online and you won’t miss a thing. It's all here at
Timesofindia.com. This site isn’t just about articles from
the newspaper uploaded on to the Web. It offers you
the complete experience of reading a newspaper
online—the interface has a feel similar to a newspaper.
The news coverage is extensive and it covers the same
sections as in the newspaper.
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top. Newspapertoday can be customised to your needs—
just sign up and select the topics that you want to keep
yourself informed about. The site also offers tools such
as tax planners, portfolio tracker, e-mail and instant

WINNER — POPULAR CHOICE
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You can also read the supplements with the news-
paper online as well as check out the classifieds

section. You don’t even need to miss your daily cross-
word—it’s all there.
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{ www.rediff.com

Which is the place you're most
likely to head to for to catch the
latest news in India? Rediff's
news coverage is vast with
reports, analysis, interviews and
commentary on the happening
events in India as well as world-
wide. The site has an image
gallery with slide shows of the
latest news events. It has a good
archive that you can browse
through to catch up on what
you've missed. Rediff's news spe-
cials are their best feature.

{ www.ndtv.com

NDTV, better known for its pres-
ence on television, has a fairly
good online presence. It offers
extensive coverage on politics,
business, sports and entertain-
ment. NDTV has video clips and
live news broadcasts that you
can stream to your desktop.
Check out Photofeatures for
‘news in pictures’ and videos
of NDTV special investigations
and exclusives. NDTV.com also
has a news ticker that you can
download.

. www.tehelka.com

Always in the eye of a storm,
Tehelka has marched into areas
where others fear to venture.
Investigative reporting and news
analysis is its forte. But Tehelka
also has a great lifestyles and
entertainment section covering
the buzz on what'’s happening in
tinsel town, society and travel. If
you love reading you'll find it
hard not to like the literary sec-
tion on Tehelka with its extracts,
reviews, profiles on authors, and
essays on the written word.
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www.khoj.com B

i g

Search Engines

crazy hunting for sites on a particular topic? Or
nearly torn your hair out exasperated with search
results that were exactly the opposite of what you were
looking for? Powerful search engines help us navigate
through the maze of information in cyberspace avoid-

How many times have you been on the verge of going

tories build huge repositories of Web sites categorised
into different sections that are a ready reference point.
All you need to do is browse through and you'll find
what you're looking for. The search engines listed here
bring you the best of the Indian Web with the least
effort. They are your ‘compass’ helping you navigate

ing dead ends or dead links. Comprehensive Web direc-

The India
Directory in

selection of

Khoj, part of the Sify network of sites, packs in a Web search powered
by Google, a Web page search for Indian sites and a news headlines
search which searches news headlines from Sify. The results are fair-
ly accurate.

But Khoj is best known for its Web directory service. It has has
two comprehensive Web directories. The India directory is well cate-
gorised and has a good selection of Indian sites. The categories cover
government, sports, science, engineering, veterinary science, and
online communities of Indians, to name a few. There’s a brief descrip-
tion of the site with a link that opens up in another window, ensuring
that you don't lose track of where you started out. The world directory
has a large number of sites categorised alphabetically and subject-
wise. If you're simply browsing around and not looking for anything in
particular, check out the site’s ‘what’s hot’ keywords to update
yourself on what's new and happening and what everyone else is
looking for.

‘Ask Sify’ question search is another great way to look for informa-
tion and sites. This directory has
more than 10,000 questions for

Top of the Web (% votes)

Khoj 42 which you'll find the answers

123india 31 here. You can either ask Sify a

Searchindia 13 question or browse through

Appuonline 7 sites category-wise. Khoj also

BED oo 7 has links to the Open Directory
aratnsee

Project at www.dmoz.org.
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Khoj has a great

indigenous sites
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~ (www.searchindia.com

Searchindia is a good search
engine for locating Indian sites.
Although, the homepage has
only a search box with a couple
of links, don't let that fool you.
This site has a Web directory
that carries some neat sites and
it offers easy navigation that
helps you ferret out the best
sites you want. You can choose
to search through the Web direc-
tory using the keyword search or
browse by category. The site
also has a city guide, a directory
of hotels in India and weather
forecast for Indian cities.

‘www.bharathseek.com

This site contains a search serv-
ice and a Web Directory.
Bharathseek search is a key-
word search, but its Web direc-
tory is pretty good, covering a
variety of categories from enter-
tainment and culture to science
and society. These categories
contain a fairly large number of
sites (but Indian only) and Web
pages. You can also use the
search box to search through the
Web directory. The site has
news, weather as well as links to
other sites on music, e-greetings
and forums.

through the tangled web of online information.

_ www.123india.com

The search feature at 123india
has a simple keyword search.
The advanced search option lets
you define how you want the
keyword to be matched and
offers case sensitivity too. You
can browse through the Web
sites in the directory either by
category or use the directory
search—a feature that lets you
search for Web sites through the
directory or even within a partic-
ular category. If you want to find
the latest Indian sites, all you
have to do is head for ‘What’s
New’ at 123india.com.

 www.appuonline.com

Appuonline is one of the best
online guides to Indian sites. The
keyword search throws up
search results containing sites
that are both Indian and non-
Indian. Appuonline’s Web direc-
tory is its best feature, providing
links and descriptions of the Web
pages. Another good feature of
the site is its categorisation of
Web pages from the directory all
through the site in a manner so
as to suit a particular interest
(such as shopping or travel) or a
certain section of the population
(women, children and so on).
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few clicks without having to
elbow your way through crowded
shops. It was about creating an
entire  community of people

WINNER — JUDGES CHOICE

Fabmart couples
good reviews and
a choice of prod-
ucts with reliable
service

Top of the Web (% votes)

Baazee 48
Fabmart 18
Rediff 15
Bidorbuyindia 11
Easybuymusic 8

Baazee.com is a virtual paradise if you are scouting for
stuff that you can’t simply enter a store and buy off the
rack (alternatively it’s also a great place to get rid of
stuff you don’'t want). Coins and stamps, antique
furniture to second hand cell phones and musical
instruments—it’s all here and you can end up buying

something at a throwaway price.

The bidding process is made easy on Baazee with
features such as Autobid, which you can set to
increase your bid by a particular amount so you don’t

Shopping & Auction

nline shopping promised a
smooth path from your desk-
top to your doorstep. It was
about getting the best deals on
everything, right from cars to a
pack of detergent, online, in justa

using the Net as a medium to buy
and sell products and services.
Online shopping and auction
sites today have come a long way
from being merely Web pages
with a limited range of products

and a telephone number to
online malls which provide you
the best products and brands,
convenience, prices and security.

Slow but steady. The tortoise in the crazy race among the vari-
ous shopping and auction sites promises to offer consumers
everything they need online. Fabmart started small, with only an
online music store, but today has expanded into a number of
categories such as books, computers, jewellery, groceries,
movies, toys and watches. On Fabmart, you can find what you
need quickly with its well-planned navigation and searches.

Every product here has extensive information listed, like
reviews on music, songs, or books. Titles in the music store
have 30-second audio clips so you can sample a song before
buying it. This site ranks high on personalisation—you can cre-
ate and save shopping lists, make wish lists, maintain address
books or view purchase history. Little extras such as free gift-
wrapping for toys make it a delight to shop here. It has a wide
range of payment options and ships goods to over 850 locations
India. Efficient customer service is one of Fabmart’s strong
points.

WINNER — POPULAR CHOICE
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have to manually enter a bid each time. Bazee is a good

place to shop for that special something.
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‘www.easybuymusic.com

Whatever e-commerce pundits
had visualised e-shopping would
be, Easybuymusic seems to have
come the closest to achieving it.
The site sells cassettes and CD
titles of various genres of
music—reggae, film music, clas-
sical, instrumental music—as
well as movies and CD ROMs.
Music buffs will enjoy reading
the latest on the music scene in
India and abroad. Easybuymusic
also offers excellent discounts
on certain titles on the site.

“www bidorbuyindia.com
Bidorbuyindia has a large num-
ber of categories and products
and is always buzzing with activ-
ity, contests, crazy auctions—a
glance at the homepage will tell
you that. Navigation is a strong
point here. The City Search fea-
ture helps you search for auc-
tions within your city, and the
efficient site map ensures that
you don’t get lost in Bidorbuy. It
also has a gift shop. The best
feature of this site is its bargain
hunter.

( Shopping.rediff.com

Rediff’s vast product range, con-
venient payment options and
reliability make it an ideal place
for shopping online. You can buy
music, food, clothes, furniture,
flowers, etc. Rediff also has a
number on online stores featured
such as The Bombay Store, Nike
and Compag. Rediff’s gift centre
has gifts for almost all occa-
sions. Use the Gift matcher to
help you make a decision
according to the person you
want to give a gift to and the
occasion.
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can offer in terms of action, but online sports sites
come pretty close with live updates, scoreboards, play-
er profiles as well as game or match statistics.

So the next time you miss a match on TV while at
work, don’t curse and wring your hands in despair! Just
log on to your favourite sites and catch some action
online.

on the days there’s a cricket match or a Wimble-
don tournament going on? Are you in heaven
when you see Tendulkar crack the ball way beyond
the boundary or Kournikova work her magic on
the courts?

The Net can’t really compete with what television

THE ABSOLUTE WINNER ~ ( www.golfindia.com
JUDGES CHOICE & POPULAR CHOICE Do you consider golf a boring

Can no one come between you and your television

{ www.criclive.com

The homepage contains the

4

Khel, a part of the Sify.com network, is the one-stop guide if you want to
stay tuned to events in the world of sport. It provides excellent coverage
of sports such as cricket, tennis, golf, football, hockey, chess, motor
sports and cue sports such as billiards. All sections on Khel, from tennis
to hockey to Formula One, are filled with news about the tournaments,
news updates, match schedules, photos, columns and several links to
player profiles, statistics, rankings, interviews and quizzes.

The cricket section offers live cricket scores for one dayers as well
as test matches and is updated every minute. It has a desktop score tick-
er which refreshes every 2 minutes to give you the latest scores. Khel
has a section on golf that not only carries information on the Indian golf
scene, but also covers the origins of the game. The motor sports section
mostly covers Formula One racing with news on races held around the
world and in India too. You can sign up for Khel sports updates and
download screensavers and wallpapers with sports themes. Khel spe-
cials contain polls on your favourite sportsperson, and you can read
about what it takes to be a sportsperson, and about young and budding

Top of the Web (% votes)

sportsmen in ‘Little Khiladi’. Don’t
forget to check out entertainment
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sport? That's probably because
you don’t know much about it.
Log on to Golfindia.com—it
might change your perspective

Golfindia also has a newslet-
ter you can subscribe to and
links to other golf sites.

(www.clickcricket.com

Clickcricket carries news, inter-
views, columns, records of previ-
ous matches and information on
forthcoming series. Shop here
for cricket gear or accessories
at the Shopping Mall or bid for
cricket memorabilia at the Auc-
tions counter. Other interesting
things you can do is check out
the height and weight charts at
the Fitness corner, read Sourav’s
thoughts in his Clickcricket Diary
and have fun with astrology,

scorecard of big games being
currently played in India. You
don’t have to visit the site if you
download a desktop score appli-

/4 ; ) on the game. cation, which gives you the
4 Wlth live This site helps you keep up score right away.
score ti Cke IS with the golf scene in India with The site features updates on
from Khel, its schedules and details of golf the game, along with inter-
yO u Won’t events, information on golf views, a fact file of teams cur-
H courses in India as well as pro- rently playing, player profiles as
m IZS g;';?u r files and statistics of Indian golf well as an image gallery, wall-
g players. papers, and other goodies.

Criclive even has a database of
past matches that you might
want to catch up on.

(www.magiccricket.com

Magiccricket has team and play-
er profiles, a database of test
records and a ‘Cricket Calendar’,
listing all the one day and test
matches played around the
world. Let the scores come to
you via the score ticker or sub-
scribe to ‘Score Flash’ and the
newsletter to get updates in your
mailbox.

Magiccricket has polls and
chat, along with fun sections
such as a ‘Test your CQ’ Caption

Khel 40 hotspots for fun sports such as quotes, Clicketoons and the contest, a ‘Gamezone’ with a
Clickcricket 27 bowling, go-karting and pool in hottest cricket gossip on crossword, and other interesting
e 18 major metros in India. And that’s ‘Masala’. cricket games.

e not all. Khel's photo galleries help
l(\BA(;?:':: dC,QCket 12 you get a glimpse of the great

indi

moments in sport.
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easy as it sounds. Ticket reservations, travel docu-
mentation and all those details associated with even
the simplest of trips can bog you down and rob you of
the excitement of enjoying your holidays. Here’s where
online travel sites step in. They can help you plan your
trip down to every last detail—from destination

I-eaving on ajet plane for your dream holiday isn’t as

information, maps and weather to tools such as itin-
erary and route planners. These sites also take care of
all your booking and reservations online, travel docu-
mentation such as visas (and applying for them), pass-
ports, travel insurance, foreign exchange and even
loans and finance for your holiday. You can do all this
online, avoiding travel agents and sleepless nights.

THE ABSOLUTE WINNER *.VW.makemytnp.com
JUDGES CHOICE & POPULAR CHOICE Makemytrip is a one-stop travel

{ www.traveljini.com

Plan your
itinerary in a
Jiffy with
smart finders
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Traveljini comes out the best in Indian travel sites, offering a wide range
of services from domestic and international flight tickets to hotel reser-
vations, domestic and international tour packages, documentation and
so on. It is well structured with sections on flights, hotels, cars, tours
and easily navigable links to services and planners. The search link for
the entire site can help you look for accommodation, shopping, and
hotels either by state or by city. If you're not in a hurry and want to hold
out for a better deal, you can bid for Traveljini packages and walk away
with a holiday at a throwaway price.Traveljini has an online flight search
for international flights. The Flight Route Finder locates flights within
India and the Smart Fare Finder checks international fares for tickets
from India to destinations worldwide. In this section you can also check
for the days on which flights from different airlines operate.

The Rail Route Finder helps you with information about train routes
within the country, including the arrival and departure time for every sta-
tion it halts at, and the train fare. Traveljini also has an excellent data-
base of domestic and international hotels and packages. It offers
destination information as well as
information on visa and passport
requirements. And if you have a
specific query about a place, the
answers to which you can't find
on the site, just ask a ‘jini’ (expert
on a particular location) and
you'll get your answer.

THE OTHER NOMINEES

Top of the Web (% votes)
Traveljini 31
Outlooktraveler 22
Makemytrip 16
Travnova 16
Airticketsindia 15

shop, which takes care of all
your travel arrangements—
flights and train tickets, hotel
reservations, car rentals and lux-
ury cruises. Read up on destina-
tion information as well as check
out video clips on destinations in
India and Australia.

Makemytrip also offers trav-
el documentation services such
as obtaining passports, visas
and insurance. It has a facility
that helps you apply for a loan if
you want to travel now and pay
later.

‘www.outlooktraveler.com

Outlooktraveler is best for afford-
able hotel packages for destina-
tions within India and abroad, as
well as packages to theme desti-
nations—eco-tourism, pilgrim-
age and so on. Read up their
destination information, honey-
moon hideaways, and weekend
getaways.

The Outlooktraveler Airshop
offers flight bookings, excursion
fares, and car rentals among
other services. The site also fea-
tures a list of restaurants that
you can search for according to
location and cuisine.

 www.travnova.com

A well-designed site, Travnova
offers easy navigation though
sections on Indian and interna-
tional destinations, tour pack-
ages, weekend deals, adventure
tours, etc. Travnova’s destination
information is among the best
around with its exhaustive infor-
mation on Indian destinations.
You can search for a flight and
book tickets in real-time through
an airline central reservation
system. Interactive tools on the
site include currency converter,
distance finder, STD/ISD finder
and passport office finder.

‘wwwairticketsindia.com

Airticketsindia has online air
reservations and Indian and
world travel guides. You can
search for flight availability and
make online reservations in real-
time. The site also has informa-
tion on baggage allowance and
frequent flier programs offered
by airlines. It has an India as well
as a world destination guide and
its travel planner section has
links to international rail sched-
ules, exchange rates, a currency
converter, time zones, and
weather reports to help you plan
your holiday effectively.
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AVINA LOBO

ou’ve been constant companions through

the years—been together during the good

times and seen each other through the bad.

We're not talking about your childhood
buddy or your pet dog. For most of us Microsoft
Office is the ‘one and only’ solution to all our
desktop processing needs, whether it’s that
assignment that’s going to get you a top grade
or a presentation that’s going to help you close
a deal.

But hey, wait! StarOffice is back with its ‘new
improved’ version and it’s ready to take on
Office! So can StarOffice do all that Office can?

StarOffice is back with
its ‘new improved’
version. Let’s find out
if it's worth ditching
MS Office yet

Probably not. But the important thing is, can it
do the tasks you most depend on Office for? Let’s
find out.

Kick(Star)ting Office 6.0
StarOffice is a free office suite from Sun
Microsystems which runs on Windows 9x, Me,
NT, 2000 and XP. It also runs on Linux and
Solaris platforms. If you’ve used StarOffice 5.2
and often found yourself cursing its ‘inte-
grated desktop’—uwell, its long gone.

StarOffice 6 behaves better and
g has as good a design as
" Office.

The StarOf-
fice suite
comes packed

with a word processor,
aspreadsheet,an HTML edi-
tor, presentation and a drawing
tool. Each application runs separately and
you can launch them either from the Start menu

Illustration: Mahesh Benkar or Quickstarter in the system tray.
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Customising StarOffice: Like Office, StarOf-
fice applications have a common customisation
interface that can be accessed from Tools > Options.
Here, apart from the obvious customisation
options such as user information, printer, securi-
ty, language or font settings, you can customise
the look and feel of StarOffice. For instance, you
can give StarOffice a Macintosh or an OS/2 look
and feel, set mouse scrolling and positioning, get
the middle button of your mouse to act as a
scrollbar, etc. Global settings for all StarOffice
applications can be done from this one dialog
box.

Tools > Configure lets you configure the functions

ce 6.0

you want on your menus or change keyboard
shortcut keys and configure your status bar. Tool-
bars can be knocked off in this dialog or through
View > Toolbars and you can also customise the tool-
bar by clicking on Customise in the same menu
or simply right-click the toolbar and select visible
buttons to uncheck the buttons you don’t want.
You can also view your document as a print lay-
out (that’s the default layout in Writer), online
layout and a full screen layout.

You can even customise toolbar buttons and
set functions to them. Get rid of those old but-
tons and create your own (make sure they are in
BMP format, sized 30x30 pixels and don’t have
more than 256 colours) and add them to ‘starof-
fice6.0/share/ config/Icon’ directory—every time
the Buttons bar is clicked, StarOffice will auto-
matically search for new icons in that folder.
Template management: Like MS Office, StarOf-
fice also has a template management interface.
This can be started through the Quickstarter in
the system tray. StarOffice doesn’t have as many
readymade template choices as Office but its
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interface is quite easy to navigate and helps you
pick the right template for an invoice, fax or
presentation. You can open a new document or
template, browse through folders to pick a tem-
plate, preview template details and layout and
open existing documents from your ‘My Docu-
ments’ folder right from this one navigation
window.

Autopilot in StarOffice is the equivalent of the
‘Template Wizard’ in Office. It can be found in
the File menu of all StarOffice applications.
Autopilot isn’'t as advanced as the wizards in
Office but runs you through the basic steps of
customising templates the way you want them.
Database integration: StarOffice has support for
internal (StarOffice 5.2) as well as external data
sources such as Netscape, Mozilla or Windows
System Address book. They can be integrated into
StarOffice at the time of installation or manually
through Autopilot > Address Data Source. This makes
mailing out documents to multiple recipients (or

Footer borders is especially neat as you can set
the distance to determine the shadowing effect.

You can either format footnotes while for-
matting a page or insert it through Insert > Foot-
note. You can set the footnote area, the separator
line that separates the footnote from the docu-
ment and number the footnotes.

Format > Character is where you set fonts, font
size and font effects such as embossing and font
position (subscript, superscript) while Format >
Paragraph takes care of formatting blocks of text—
alignment, paragraph indents and spacing,
hyphenation, border and background for para-
graphs, drop caps, etc.

‘Bullets and numbering’ has some pretty
good styles. The standard bullets are the same
but there are more options for graphical bullets
in Writer. The options to align and control the
spacing of the bullets are especially good.

The StarOffice Stylist, a window containing a
library of styles, is present across all applications

[ et i el i ts alal=]

and provides another
easy way to format

a mail merge) a
breeze. G
Writing off Word o R -

The interface of Star
Writer, the word N
processor, does feel a
little different from et
Word but the most
commonly used —
functions in Word
are available here as

T orresoeaeer| text. All you need to
H do is select the text
and double-click on
the style in the win-
dow to apply it.

If you don’'t want
to manually format
text, there’s always
Autoformat and
Autocorrect, both in

———

well.
Writer easily

7 the same dialog and
— with similar func-
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imports and handles
different file formats
from different versions of Word as well as text
documents for Macintosh and Unix without los-
ing out on much of the text formatting. It’s only
while importing StarOffice documents into
Word that you might lose some of the format-
ting. To save documents in HTML, go to File >
Send > Create HTML document.

Formatting text: If you're looking for the famil-
iar Format menu options as in Word, you'll find
them all organised quite neatly in StarOffice.

Format > Page takes care of your page size, mar-
gins and page background. For the background
you can either choose solid colours, images from
the StarOffice clip gallery or your own back-
ground.

You can add and set the size (in centimetres)
and the style of different page elements such as
headers and footers, borders, columns and foot-
notes. This dialog has a small page preview
option that gives you a glimpse of how these ele-
ments are going to look against the page.

Backgrounds, borders and shadowing effects
can be set for Headers and Footers. The shad-
owing option for the page and the Header/

StarOffice has a neat template management feature

tionality as Word.

Tools consists of a
spell checker, thesaurus, line humbering and
macros. The Insert menu has the same elements
as Word—Find and Replace, Comments, Book-
marks, Footnotes, Captions, Cross-reference and
Hyperlinks. In addition you can also insert
charts, diagrams and images. You can insert spe-
cial characters and symbols into the text through
Insert > Special Characters.

The comment feature isn’'t as good as in
Word. It lets you insert a note at the cursor posi-
tion, but the note isn’t visible on a mouse over.
You have to double-click on the note indication
for the note to pop up.

Star Writer has a clip gallery with fairly good
images. You can insert images into the document
from a file or the StarOffice clip gallery.

Auto abstract is a neat feature packed into
Writer that extracts the title, summary and sub-
headings of a long document and saves it to a
new document.

You can create a small table in Writer by
selecting Insert > Table, selecting the number of
rows and columns and entering the data. Alter-
natively, you can define table attributes at Tools >

Say it with XML

There’s been a lot of talk
from Sun about a new XML-
based file format for docu-
ments in StarOffice 6.0 and
the increased functionality
that it would bring to its
users. So what's this all
about?

This means that parts of
an Office document such as
the content, layout and
meta information are stored
as separate XML streams
along with embedded
graphics and objects con-
tained in the document. This
is done so that they can be
read, interpreted and modi-
fied independently of each
other. This XML format is
commonly used across all
StarOffice documents,
whether it's a spreadsheet
or word processor.

How does this help the
user? Well, for starters, it
will ensure greater compat-
ibility and interoperability
of StarOffice file formats
with other operating sys-
tems as well as with newer
versions. With XML, the
recipient of a StarOffice
document will not be
required to have StarOffice
installed to view it.

XML also helps in docu-
ment archiving and pre-
serves the longevity of the
document. Being a text-
based and human readable
format, it allows files to be
read even if the original
application or the OS that
it ran on is not available
anymore.

With the XML file for-
mat, the user can inspect
the content of files being
sent or received through
the meta information,
which is stored as plain text
in the Windows Explorer
context menu. So the next
time you receive a suspi-
cious attachment, you
know what to do!

didityat
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Handy pointers

H To view a Starlmpress
presentation, you don’t
need to start the entire
application; Starplayer
should do the job just fine.
H The StarOffice free version
does not come bundled
with e-mail. While installing
it detects and integrates
easily into your current
default mail client—whether
it's Outlook, Outlook
Express or Netscape mail.

u If you're new to StarOffice
and find it unfamiliar, just
use context menus to figure
out basic commands.

m Click on the Insert icon at
the top of the main toolbar
(the one that runs down
your work area) to work
faster.

® The Navigator is a neat
tool that displays all the
objects in a document. Use
the Navigator (the [F5] key)
to jump directly between
pages, different headings,
notes or hyperlinks within a
document.

m To quickly open a file
without using the file menu,
type in the path of the file in
the URL bar.

® You can directly copy
drawings in StarOffice from
text, spreadsheet or presen-
tation files. All you need is
[Ctrl] + [C] and [Ctr]] + [V].
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Options. Under the Text document heading, select
Tables. Formatting a table is simple—just select
the entire table and click on Format > Autoformat.

Frames don’t mean the same thing as in
Word. Here a frame is like a box that may con-
tain text. Insert > Frames gives you the option to
determine size, position and format the frame
and text within it.

Making ‘Impress’ive presentations

Need to create snazzy presentations that will
floor the clients and clinch the deal? Star Impress
can do the job just as well as its Office counter-
part, PowerPoint.

For simple presentations, use a slide template
or customise it using Autopilot. Autopilot will
run you through the process of selecting your
background, slide transition, slide duration and
output medium such as overhead screen or
paper, in just a couple of steps.

If you want to start out with a blank slide,
Impress still shows you options for slide lay-
outs, rather like PowerPoint. Choose the appro-
priate layout according to what you want to
display—text, images, animation, charts or dia-
grams. Slide background options are few but
they look good. You can also add your own
background through Format > Area through the
colour palette or insert your own slide back-
ground (Impress supports the most popularly
used image file formats).

You can also add text boxes, resize them and
fill in text. The same text and paragraph format
options used in Writer apply here. Use the Insert
menu to insert spreadsheets, charts, diagrams
and images.

While creating a slide, you might constantly
need to modify the slide layout, insert a new slide
or perhaps duplicate slides. Instead of having to
go to the menu several times, use the floating
window that has all these functions. Slide view
options are located towards the top right corner
of the screen within easy reach so you can change
slide views constantly.

Format > Font Work lets you play around with font
effects—apply shadows rather like ‘Word Art’ in
Word. You can rotate the font, change the angle
or set it to curve in different directions. With For-
mat > 3D Effects you can add 3D effects to the font
selected, such as shading illumination, geometry,
textures and material.

Files created in Impress can be saved as Pow-
erPoint or StarDraw from File > Save As. If you
want to save the slide as an HTML file, you'll
need to select File > Export. This opens up an
Autopilot dialogue, which takes you through
converting and formatting the slide as a Web
page. Use Insert > File to import an HTML page.

The slide show menu has all the animation,
slide transition options and settings to help make
your presentation more interactive. A simple way

to apply this is to select the textbox and click on
Effects or Interaction. Impress also has custom
slide show options.

In addition to this, you can hide slides with-
out deleting them through Show >Hide Slide.

You'll miss the Slide Sorter feature in Power-
Point to view thumbnails of all the slides, with
drag-and-drop to change slide order. StarOffice
has an alternative—each slide is laid out like
worksheets in spreadsheet applications like Star
Calc and Excel. You can rename each slide or
drag to change the slide order.

Impress handles organisation charts and flow
charts pretty well. You can create them with text
boxes and connectors from the Draw toolbar.
The connectors move along with the boxes and
hence managing them and moving the boxes
around isn't difficult.

[¥o[=Ta]e0 s S

The ‘Stylist’ makes formatting text a breeze

Spreadsheets

Star Calc is the spreadsheet application from
the StarOffice family. The worksheet and
workbook options work the same as Word
as do basic file functions. Calc can import
external data (Import > External Data) and save files
created in Calc as Excel, dBase, CSV and Lotus
123 files.

Formatting functions include formatting
worksheets, rows and columns and cells. The
context menu is the easiest to use for inserting,
renaming and deleting sheets or setting width or
height attributes to rows and cells. Format > Cells
takes care of the fonts, font effects, worksheet
protection, cell border and background options
and merging cells.

The delete option in Calc doesn’t just delete
the cell content. It pulls up a dialog box which
lets you select what aspect of the cell you want to
delete—format, formulae, or just the text.

You can customise the Autofill option in Calc
as well as use and create your own sort lists to
sort data alphabetically or as per your preference
through Tools > Options under the Spreadsheet
category. Calc also has options to group and out-
line cells in the Data menu.

Calc has Filters and advanced filtering

November 2001



Tral e K

EE IR I L i
] o T R Aary=

Use connectors to make flowcharts easily

options to let you filter data and view data for
certain fields, which is handy with large spread-
sheets containing lots of data. The Autofilter
option works just fine with the entire spread-
sheet or with selected rows or columns. The stan-
dard filter lets you set up to three conditions for
filtering while the advanced filter lets you set up
to eight filters.

As in Excel, you can represent the cell data in
the form of charts. Selecting Insert > Chart brings up
the Autoformat Chart dialog, which helps you
choose between bar charts, pie charts or radar
charts. There aren’t as many chart options as

in Excel, which has several formats with
3D effects.

Insert > Function List gives you a list of the func-
tions in Calc. To insert functions, use the
Function Autopilot on the toolbar menu. You
can also use the Autopilot to create your own
formulae.

Insert > Object > Formula activates Star Math.
Once activated, you can use the toolbars in
Star Math to add mathematical formulae to
your spreadsheets.

So what’s it going to be?

The free beta version of StarOffice 6.0 that

we’ve looked at here is feature rich and packs

in a lot of functionality, in spite of the fact that
it doesn’t include applications such as Star Mail
and Scheduler, which you will find in the paid
CD version of even StarOffice 5.2. Additionally,
stability isn’t one of the strong points of the
StarOffice 6.0 beta version, hence you have to
keep saving your work periodically. Documen-
tation for StarOffice, in general, isn’t too good
and the Help files aren’t easy to follow.

We suggest you wait for the release of the full
version of StarOffice 6.0 before you decide to
completely switch over. But till then, have fun
fiddling with this version of StarOffice—try it,
tweak it and use it. [

hitp://wWhww,

www.sun.com/starof-
fice/6.0beta/

Download StarOffice 6.0
supportforum.sun.com/star
office

Feedback and discussion
for StarOffice 6.0
www.staroffice.com

A StarOffice user group
portal
www.openoffice.org
Home of the StarOffice
Code
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Organising your
thoughts (and notes)
on Palm was never so
easy

76 FHE

Illustration: Mahesh Benkar

ANIL PATRICK R.
t's that time of the day when you have to look
up your appointments and tasks. You get your

Palm out, check your To Do list and discover

that you need to call a client. Then you go to
the Address Book to look up the contact details.
There, you discover a note in the Memo about
the details of the deal. You click once again to
look up the note. All this takes time. Shouldn’t
your personal organiser be more organised to
keep you better organised?

With all the time and effort spent shuffling
between different tools on the Palm, don’t you end
up wishing there was some way to get all the infor-
mation in one place. But hang on; it’s not time to
take refuge in a notepad, not yet at least. Outlin-
ers are third-party programs for the Palm. (See
box, ‘History of Outliners’ to get an idea of how
organiser programs for the Palm evolved.)

We know that Palm has good organising tools
like Address, Data Book, Memo Pad, Expense, To
Do List, etc but when you need the information

1

at one place, organising turns into an exercise, a
cumbersome one at that. Outliner programs
help you organise things in such a manner that
you get an overview of all that you want to do.
These programs can link with applications such
as Memo Pad and To Do List to give you an
interface which helps you organise the contents
of all of them at a single point. If you're won-
dering how that’ll help you, here’s how. Let’s
assume you're starting a new project, for
instance, a research report. You would need an
overview of the major areas of your research and
also of the subcategories under each area. A To
Do List will not be able to give you an efficient
overview. Here’s where outliners can help you by
organising all the information you have and
placing it at your fingertips.

Hit a Hi-Note

Keep it straight and simple with Hi-Note. This
easy-to-operate organiser allows you to keep Notes
in text form as well as drawings. It is possible to put
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text in the drawings as well. You don’t need to carry
notepads around to make presentations, you can
do it all on Hi-Note.

Install Hi-Note in your Palm using the Palm
Desktop and you are ready. Simple. Start Hi-Note
by clicking on the icon. Tap on the New button to
start a new note. Select the type of note—text or
picture. Start entering whatever you want in the
new note that comes up. It stays simple. You can
draw your diagrams by choosing the Picture note
option. If you want to add a diagram to a note, it’s
assimple as adding a sub-note to it. Just tap on the
note to which you want to add a sub-note. Now tap
on the New Sub-Note item from the Record menu.
Enter the type of note. Tap on Done and you are
through with the sub-note. From the Options
menu, set Title (of the note) and Picture Size. If
you want to look up telephone numbers, do that
using Phone Lookup in Options.

Hi-Note’s simplicity makes it a must for people
who like things efficient and easy. You can drag-
and-drop all the notes to structure them the way
you want. If you need to import data from the
Memo Pad, use the Import option in Record.
Alternately, you can export data from the note you
just made into Memo Pad using the Export option.

Palmy BlackForest

How do Trees, Branches and Leaves make up an
outline? No, we’re not joking. A hierarchical
structure, which has elements called Trees, is
used for Outlines in BlackForest. Branches and
Leaves are the sub elements in the outline.
You can have as many leaves as you want in
a branch.

To create a Tree, tap on the Create button in
BlackForest after installing it using the Palm
Desktop.

Name the tree and tap on it to open. Go to the
Tree option in menu and select the New Branch
option to create
new branches. New
leaves for branches
can be made in
the same manner.
Notes can be
attached to the
branches and leaves
using the Attach
Note option in the
Tree menu.

You can set the
priority of abranch
and leaves using
Details. The items
which you have fin-
ished working on can be marked using the check
box next to the leaf or tree. Dragging and drop-
ping branches and leaves is a standard feature of
BlackForest.

A major drawback of BlackForest is that it

Creating a new tree

doesn’t provide linking to other Palm applica-
tions such as Memo Pad. This is inconvenient if
you are dealing with projects that rely on data
from these applications.

Arrange(r)

Arranger makes use of a tree-hierarchy for making
outlines. Creating a tree structure in Arranger is
child’s play. First,
install Arranger on
your Palm using
the Palm desktop.
Now click on the
Arranger icon to
open it. Tap on the
New button to start
an outline. Enter
the information
and tap the OK
button. Specify the
category of the
outline, if you so
wish, through
Details in Options.

Now that the
master outline has been made, it is time to add
new items to it. For adding new items tap on the
Open button.

In the drop-down Edit menu, tap on New
item. This brings up the new item, which will be
added to the outline. Click on OK. You can also
use other options such as New link to Address,
Date Book, Memo, Expense, and To Do to add
items to the outline from these utilities. Add all
the items you want to outline using the same
method. A plus sign in the box on the left side of
the outline shows that items have been added to
the outline. You can open the outline by tapping
on the plussign. You can also drag and drop items
to act as child items of the ones in the outline.

The interface of Arranger is not as user-friend-
ly as that of Hi-Note. It requires some time to get
used to. Importing and exporting of items from
and to Memo Pad can be done via Options menu.

Adding new items to the
Outline

Keep it simple

There are some things you need to keep in mind
when using an outliner program. Firstly, break
up the task you have in hand into simple steps.
This will help you prepare a better outline.
Always remember to keep the information in the
outline as simple as possible. After all, it doesn’t
make sense to write a whole page of information
for a single task, does it?

Keep these tips in mind and you can make the
best use of your outliner. Your outliner is like a
reliable secretary who can help you breeze
through your busy day without your having to
juggle between all those to-do lists, memaos, proj-
ect reports and others. So choose the outliner for
you and put it to task right away.fil

Outliner History

A piece of information for all
those of you who grew up
thinking God created man,
woman, and PIMs and in
that order, the reality is a bit
different. It's more like man,
woman, and outliners. Out-
liners were used in personal
computers for collecting
pieces of information and
organising them. Believe it
or not, there was a time
when Personal Information
Managers (PIM) weren’t
around. But when they
came along, outliners
became a much lesser force
to reckon with in the desk-
top arena.

Outliners got a new
avatar with the introduction
of the Palm operating sys-
tem. In such systems where
space is always a constraint,
outliners found their own
little nook. They are pre-
ferred over other kinds of
organiser programs for the
Palm system because organ-
isers designed for a desktop
computer can be easily
ported to suit the Palm.
They do not consume too
many resources and offer
simplicity of usage. Outliner
interfaces usually take up
the least display space—an
important feature in
portable devices. Its no-clut-
ter nature has made it a hit
in the Palm domain.

Despite their simple
nature, most organisers
have a lot of power under
the hood. Most of them
allow you to link items from
the main Palm applications
such as Address, Date Book,
To Do, Memo Pad and oth-
ers. These links can be
turned into hierarchical out-
lines that make sense to
you. You can manage To Do
items, set alarms and so on,
straight from the outliner.
Grateful, aren’t you now, for
outliners?
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Troubleshooting
Understanding Memory, check out
Mindware

Windows

+ Of lost passwords

| use MS Office 97 and | had assigned pass-
words to my Excel and Word files through File >
Save As > Options > Save Options. The problem
is that the text file in which | wrote the pass-
words got deleted. Is it possible to get back the
passwords?

Rishi

Via e-mail

R There’s a password recovery solution
available for cracking Word and Excel pass-
words. You can get a trial version at www.lost-
password.com/excel.htm.

Applications

+ Internet Explorer woes

| recently installed Internet Explorer 6 from the
October edition of the Digit Mindware CD, but it
doesn’t seem to be working. It says that some
components are missing and tries to download
an 11 MB file from the Internet. Please help.
Shankar

Via e-mail

R It appears that instead of installing the
program from the CD, you copied the
main installer to the hard drive and then
tried to run it. As the full installer has all
the components bundled along, try rein-
stalling from the CD.

Windows

4 Shut down queries

| own a Celeron 433 MHz system (Windows 98
preloaded). Its system cabinet is of MicroATX
type. | recently installed Windows Me. Its Shut
Down menu does not show the Hibernate option,
while the MSCONFIG/Advanced menu says that
the Standby and Hibernate features are enabled.
Previously, while using Windows 98, pressing the
power button on the cabinet resulted in a regu-
lar Windows shutdown. But now it directly shuts
off. Is this due to some utilities that were pre-
loaded in the OEM machine? | have updated the
BIOS, but nothing has happened. Please help me.
Girish

Via e-mail

78 R

Troubleshooting

Trying to retrieve your password, wondering how to uninstall
autodialers, tracing a missing scanner? Go ahead, shoot. You'll

find all the bullets here
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The Hibernate option in Windows

R You have probably not enabled your
Hibernate option correctly. In order to
enable the Hibernate option, go to Power
options under Control Panel. Select the
Hibernate tab and select OK. You will now
be able to see the Hibernate option when-
ever you try to shut down Windows. As
for your second question, there is noth-
ing to worry about as your system is
working perfectly fine. When you had
installed Windows 98, the ACPI was not
enabled. However, on installation of Win-
dows Me, it gets enabled by default. As a
result, the machine will automatically
shut down without you having to manu-
ally shut it down.

Applications

+ Erroneously yours

| have recently installed Adobe PageMaker 6.5.
I am running Windows 98 SE on a CPU 300A
(Intel) Celeron, with 64 MB RAM and an 8.5 GB
hard disk. However, when | access PageMaker
6.5 it gives an error message: “Cannot start
PageMaker. Unable to load icon DLL for this
screen 8027.6623.” In the error message, the
reference ‘icon DLL is not a file name as | could-
n’'tfind it in the CD or the hard disk. This may be
a reference to a *.DLL file dealing with the
PageMaker icon. Please help.

V. Ravchandran

Via e-mail

B( This problem has arisen probably
because you are not using the original copy
of Adobe PageMaker. The pirated copy,
which you may be using does not seem to
have copied the software properly and
hence, the appearance of these errors. We
would strongly advise you to purchase the
original copy of the software.

Applications

+ Uninstalling autodialers

| have a P-IIl 866 MHz machine with 128 MB
RAM, running Windows 98 SE. | had installed
VSNL Auto Dialer and Satyam Intellidialer on my
computer, but | found them cumbersome to use.
Therefore | deleted the autodialers. However,
the icons of VSNL and Satyam autodialers still
remain on my desktop and | cannot delete them.
How can | get rid of these unwanted icons?
Nagarajan

Via e-mail

R To install or uninstall programs, you
must go to the Control Panel and then to
Add/Remove programs and uninstall
them. You can then delete the folders of the
programs uninstalled manually. We sug-
gest that you reinstall the programs and
then uninstall them in the right way.

Hardware

+ So you upgraded your CPU
and RAM?

| recently exchanged my old PC for a new one.
The old one was a P-IIl 500 MHz with 128 MB
RAM and a 10 GB hard disk, while the configu-
ration of my new PC is P-111 800 MHz, 256 MB
RAM, 40 GB hard disk. Yet, | don’t find much dif-
ference between the performance of the two
systems. Even while playing Quake Ill, it does-
n't perform any better. On the other hand, it has
a much lesser frame rate. What's wrong with
my new PC? There was no extra card on my old
PC, nor on this one.

Ankit

Via e-mail

RYou seem to be under the false
impression that by upgrading just your
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CPU and RAM you will obtain better per-
formance from your machine. You may see
improvement in various other applications
like office suites, but to get optimum per-
formance, all the components such as hard
disk, motherboard and graphics card
should be of good quality.

In your case, the graphics card is the
bottleneck, not the CPU or the RAM. As
far as gaming is concerned, the improve-
ment in performance is more or less direct-
ly proportional to your graphics card. Even
a Celeron 400 with a TNT2 card would be
able to give 60+ frames per second in low
to medium resolutions, but a Celeron 400
with a SiS 6326 will not even touch 10 fps,
making the game practically unplayable.

You should upgrade to a better graph-
ics card. We recommend going in for a
GeForce2 MX, an economy-level graphics
card available for approximately Rs 4,000
or slightly above.

Internet & Communications

+ No go mail

| am unable to send mail using Outlook Express.
The following error is displayed: “An unknown
error has occurred. Account: ‘satyam’, Server:
‘mail.satyam.net.in’, Protocol: SMTP, Server
Response: ‘502 unimplemented (#5.5.1)", Port: 25,
Secure (SSL): Yes, Server Error: 502, Error Num-
ber: 0x800CCC64.” However, | am able to
receive mail. My ISP is Satyam Online.
Frederic St. Andre

Via e-mail

B( The error shows that in the account
settings, you have SSL enabled for the
SMTP server (outgoing server). This needs
to be disabled as the ISP does not support
this kind of mail transfer. Open Outlook
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Configure your mail settings the right way
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Applications

#+ While the CDs burnt

| have connected my CD-R/RW drive
(16x/10x/40x) as the secondary slave. | have
Windows 98 SE installed. | use
Adaptec Easy CD Creator 4 to
burn CDs, which was bun-
dled with the CD-R/RW. |
have burnt 650 MB CD-
Rs and CD-RWs and
they are working fine, ot
though in My Com- Sl
puter it showed the
total size of the blank
CDs as 648 MB. How-
ever, My Computer
shows the size of blank
700 MB CD-Rs also as 648
MB, though the user manual of

Express and click Tools > Accounts. Select
Satyam and click on Properties. Switch to
the Servers tab and under the Outgoing
Mail Server area, uncheck the box marked
‘My server requires authentication’.

Hardware

+ A reluctant printer

| have a P-IIl 600 MHz system with 192 MB
SDRAM and Windows 98 SE as the operating
system. My problem is that my computer hangs
(and I'm forced to make a hard reboot) when-
ever | try to take a printout. It usually hangs after
printing two-and-a-half or two-and-three-fourth
pages. It occasionally has no problem in print-
ing about four pages in economy mode. The
timeout settings are set to a maximum of 60 sec-
onds each. The printer LPT port properties show
basic configuration 0000 with input/output
range 0378 - 037F, 0778 - 077B, interrupt request
07 and Direct Memory Access 03 with no con-
flicts. | have tried reformatting and reinstalling
the printer from the CD provided with the print-
er and even updating the printer driver from the
Windows 98 CD and from the Internet. Please
help me.

Jacob George

Via e-mail

R( Go to your BIOS settings and check
whether your parallel port is configured as
ECP mode+EPP mode. Next, check
whether your printer is assigned IRQ7 and
whether any other hardware is utilising the
same IRQ.

In case your printer is not assigned
this IRQ, make sure you assign it and
change the IRQ of any other hardware that
uses it.

my CD-R/RW says that it is compatible with
700 MB CDs. How can | use the full 700 MB
capacity of the CD-R?
Sachin Dalvi

Via e-mail

B( The problem lies with
your software and not your
CD Writer. Easy CD Cre-
ator will burn 700 MB CDs
but it will not show the data
to be 700 MB while burn-
ing, as it cannot natively
detect CDs of this kind. To
solve this, it would be advis-
able to upgrade your soft-
ware to the latest version or
shift to another CD burning
software such as Nero.

e

Windows and Internet & Communications
+ Of partitions and computers
hanging
| have a P-Ill 667 MHz processor, 128 MB
SDRAM, Intel 810i chipset and Windows 98 SE
0S with FAT32 file system. | have three parti-
tions: the primary DOS partition C: (5.16 GB), sec-
ondary DOS partition D: and extended DOS par-
titions E: (2.14 GB each). | would like to combine
the two partitions of 2.14 GB into one. Can | do
this without using third party utilities and without
losing my data on the primary DOS partition?

| also have a problem with my 56 KBps V.90
compliant modem. Whenever | connect to the
Net with my Rolta Dialer, the modem connects at
a speed between 30-40 KBps. Also, when con-
nected, my computer hangs. This happens every
time | connect to the Net. My hardware vendor
told me that there might be a conflict between
my internal PCI modem and my PS/2 mouse, but
there was none. He then replaced the mother-
board as it might be faulty, but that did not help
either. Please help.
Pranav Desai
Via e-mail

B( To combine the data of the two parti-
tions of your hard disk, you have to use a
third party utility such as Partition Magic,
which enables you to do this safely with-
out losing your data.

About your second query, the problem
is not with your motherboard but is most
likely because of conflict with other hard-
ware. Check for any sort of conflicts
between your internal modem and any
other hardware device such as the sound-
card. If there is no conflict, you can try
changing the PCI slot for your modem. If

FIER 79



H resolve~s.o.s.

that does not help, try updating the driv-
ers for your modem from the manufac-
turer’s Web site.

Internet & Communications

<+ No private key

| recently signed up for a free digital certificate
from www.digicerf.com for encrypting e-mail
messages. It was working fine until | had to for-
mat my hard disk. | had taken a backup of the
certificate, but when | tried to reinstall it, the
message “You don’t have the private key” was
displayed. Is there any way | can backup a cer-
tificate along with its private key?

Amit Samarth

Via e-mail

R( When you export a digital certificate,
the wizard asks you whether you wish to
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Back up the private key of your digital
certificate

include your private key. By default, this
option is selected. This will ensure that
your private key is included in the backup.
Be careful, though. Use this only for back-
up purposes. When exporting the certifi-
cate for distribution, make sure you don’t
include the private key.

Windows

#+ Shut down blues

| have machine with a P-11l 733 MHz processor,
i810e chipset based motherboard, 128 MB RAM,
and 20 GB hard disk (ATX). Recently, | removed
my RAM for cleaning. | placed it again in the
same location on the motherboard. Now, every
time | shut down my computer, it restarts. But
when | shut it down again, it shuts down prop-
erly. | formatted my hard disk and reinstalled all
the components but the problem continues. | am
told that this may be because of a problem with
my motherboard. Please give me a solution.
Sachin

Via e-mail

R( The problem of the damaged RAM

slot is unrelated to Windows behaving the
way it is. Had the RAM slot been damaged

80 R

completely, your PC wouldn’t boot at all.
However, you can try removing the RAM
and installing it in another slot. If this does
not solve your problem then the trouble
could be with your power management.

Try disabling power management and
the ACPI from the BIOS. The ACPI can be
disabled from the BIOS only if the option
is available. Or you can even try disabling
fast shutdown. Go to Start > Programs > Acces-
sories > System Tools and click on System
Information. In the Tools menu, go to Sys-
tem Configuration Utility and select
Advanced in the General tab. Here select
Disable Fast Shutdown, click OK, and then
click OK. Restart the computer.

Windows

+ In a flash

| have a PC with a Celeron 800 MHz processor,
an 815e Mercury motherboard, 128 MB RAM,
and a 20 GB hard disk. | had kept a password for
the system, but unfortunately forgot it. To log in
to the system, | removed the CMOS battery and
tried to short it. | then put the battery back in the
machine, but now | get an error message:
“CMOS check sum error. Press F1 to load default
or Del to enter setup.” What's wrong?

Raju

Via e-mail

R( You get this error message because
your battery has been discharged. You
should have your battery replaced to clear
this problem. If the problem persists even
after changing your battery, go to your
BIOS settings where you will find an
option to load the default settings. If in
spite of doing this, you continue to get the
error, there could be a high probability

Applications

#+ Using multilingual fonts

I would like to use multilingual fonts on my
Web pages, for which | want to use dynamic
fonts. But I've heard that only Netscape Nav-
igator supports dynamic fonts. What must |
do to be able to use multilingual fonts that are
also supported by Internet Explorer?

V. Srinivasa Reddy

Via e-mail

R( In order to use dynamic fonts that
are visible on Internet Explorer you will
have to save them in .eot format. To do so
you will require a utility called WEFT
(Windows Embedded Font Technology)
which is available on the Microsoft Web
site (http://www.microsoft.com/typography/web/

that your BIOS is corrupt. You will have
to flash your BIOS. To do this, find the
exact model number of your mother-
board.

Then go to the manufacturer’s Web
site, download the utility and the latest
BIOS and save it on a floppy. Follow the
instructions given on the Web site with
regards to flashing your BIOS. Take great
care while doing this as you could severe-
ly damage your motherboard if you do
not flash it the right way.

Windows

+ No driver for this one

| have four HP brio 410 P-111 933 MHz machines
preloaded with Windows 98. When | uninstalled
Windows 98 and installed Windows 2000 Pro-
fessional on these PCs, | could not change my
display settings from 256 colours to 16-bit, 24-bit
or higher. | have a Matrox - PM133 PS Prosav-
age Display card. | could not locate the driver
for this for Windows 2000.

Nilesh

Via e-mail

R( Unfortunately the particular display
card on your machine does not have any
support for Windows 2000. You will have to
stick to your previous OS or communicate
with H-P directly regarding this matter.

Hardware

#+ Misbehaving monitor

| have a Celeron 433 MHz system with a 2 GB
hard disk, 64 MB RAM, and an LG Studioworks
44m monitor. | am using Windows 98 SE as the
0S. My picture tube began to have problems
and so | got it changed. Now it can have
800x600 or 1024x728 resolution but not 640x480.

embedding/weft3/default.htm?fname=%20&fsize=).
If you are interested in knowing more
about this, you can go to
http://msdn.microsoft.com/workshop/author/fonte
mbed/font_embed.asp and read the details.
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However, if | start Windows in Safe Mode it
starts on 640x480. Please help.

Debabrata Das

Via e-mail

R( First, go to your system properties and
check whether your monitor is being
detected correctly. If it shows default mon-
itor or shows a monitor other than what
you currently have, it means it’s not getting
detected correctly. If so, you will have to
install the drivers that came along with the
monitor. After this your monitor should be
able to show you the option of displaying
at a resolution of 640x480.

Internet & Communications

#+ Browser hang-ups

I have a P-111 800 MHz machine with 64 MB RAM
and | am using Windows 98. My machine
restarts when | am browsing. | have only 256 K
cache. Please help me. | use Internet Explorer
5.0 and Netscape 4.04.

S. Sudhakar

Via e-mail

R( To eliminate the possibility of your
RAM being the cause of your problem, try
running some games, or some other appli-
cations already loaded in your machine
such as office application or Photoshop for
at least half an hour and see whether your
machine hangs or not. If it does not, then
there is no problem whatsoever with your
RAM. The 256 K cache that you have men-
tioned refers to the L2 Cache of your
processor and has nothing to do with your
machine restarting. The problem obvious-
ly lies with the installation of your brows-
er. Reinstall the latest version of the
browser and your problem will be solved.

Linux

+ Missing devices

I have a P-IIl 800 MHz system with 128 MB
SDRAM with a 40 GB hard disk. | am using Red-
Hat Linux 7.1. | have a scanner (Umax Astra
2000P), which is not recognised by running
SANE. It says ‘Device not found’. My scanner is
connected to the printer port. Help!

Tapas

Via e-mail

R( Go to your BIOS settings and check
whether the printer port is enabled and
configured as EPP for optimal perform-
ance. The scanner you have mentioned

DO YOU NEED HELP?

(the Umax Astra 2000P) is supported by
SANE. If, as you have mentioned, it does
not get detected, you can get a custom
SANE built for your scanner from
http://umax1220p.sourceforge.net/.

Internet & Communications

+ Error terror

When | start Internet Explorer, | get the follow-
ing error: Please check your Content Advisor
settings for missing information. I am also
unable to view offline Web pages. | had imple-
mented a supervisor password for the Content
Advisor and enabled it. How can | remove it?
Sawan Gupta

Via e-mail

R( This happens if the Ratings.pol file is
damaged or corrupted, or if there is more
than one Ratings.pol file on the system.
Make sure that Explorer is set to display
hidden files, close all browser windows and
check \Windows\System for the file. If there
is one, rename the file with any other name.
Open Internet Explorer and click Cancel
when the error is displayed. Open Tools > Inter-
net Options > Content and click on the Settings

B

Content Advisor in Internet Explorer

button under Content Advisor. Enter the
supervisor password, set the ratings accord-
ing to your preferences and click OK. Close
the browser window and open it again to
check whether the problem has been solved.

Windows

#+ Where have the thumbnails
gone?

When | select the View as Web Page mode in
Windows Explorer, | cannot view thumbnails of

Send an SOS to sos@jasubhai.com

JPGfiles. Itis the same with PSD files, but there
is no such problem with GIF and BMP files. Are
there any settings for being able to view JPG,
PSD, TIF, PNG, TGA, etc files as thumbnails?
Ramesh Pradhan

Via e-mail

R( The problem you have mentioned is
not related to your graphics files. Inability
to view JPG file thumbnails happens quite
often due to problems related to Internet
Explorer. Go to Add/Remove programs,
click on Internet Explorer and select
Remove. It will prompt you to Remove or
Repair the installation of Internet Explor-
er. Select to repair it.

If the problem persists even after doing
this, then you should update your browser
to Internet Explorer 6, the latest version of
IE which is available in the October Digit
Issue CD. This will definitely solve the
problem. The other file extensions, howev-
er, cannot be displayed as thumbnails.

Internet & Communications

+ Browsing blues

| recently went to Microsoft's Web site
(www.microsoft.com) for a general Windows
update and | got an error while viewing the
site’s content. | then added Microsoft's Web
address in the Internet settings for trusted sites,
guided by the error message on the site’s Web
page. | was able to view the page after that and
started downloading the updates. Midway
through this process, however, my connection
came to a standstill and | had to disconnect
manually. When | connected to the Net again
and tried to resume the Windows update, | got
the message: “The page could not be dis-
played.” | get this error only when | click on
Windows update or support; | can view the
home page and other pages of microsoft.com.
Please provide me with a solution.

Via e-mail

R( Whenever one browses the Internet,
certain files are stored in the Temp folder
and others stored in the cookies folder. The
problem you have mentioned could be due
to the fact that since your previous visit,
there is no newer version of the file stored
in the temporary folder and hence it shows
the previously visited page. Clear your
Internet cache by going to Tools > Options >
General where you can delete the cookies
and the temporary files. This should solve
your problem. [l

Or write in to DIGIT, D-222/2, Om Sagar Bldg, MIDC, Nerul-400 706
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SEARCH TOOLS

Demand what you want from the Net! Finding the information you need is

Copernic 2001

Empower yourself with simultaneous search
over the Web, newsgroups and e-mails. It
has features to remove duplicate matches,
eliminate invalid links, translate pages, etc.

= Downloading required pages

You can directly save Web pages for brows-
ing when you are offline. To save the ones
you require, simply click on the required
document while holding the [Ctrl] key.
Now press the Download button. Alter-
nately you can go to Results > Download Or
simply use [Ctrl] + [W] to get the Down-
load Documents window. Select the
Remove Unreachable option if you
want to skip all unreachable pages in the
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Select options for the type of download
you want

Larad

Copernic 2001 shortcuts

[Ctrl] + [B] — Browse results

[Ctrl] + [I] — Validate results

[Ctrl] + [N] — New search

[Ctrl] + [R] — Refining a search

[Ctrl] + [T] — Track search

[Ctrl] + [U] — Update search

[Ctrl] + [W] — Download documents
[Ctrl] + [Shift] + [E] — Excerpts

[Ctrl] + [Shift] + [H] — Highlight key-
words

[Ctrl] + [Shift] + [Z] — Show or hide
search history

[F2] — Modify search

[F3] — Next search

[F9] — Duplicate search

actually as simple as using these tools

download. For quicker downloads, leave
the Download Images option unchecked.
If you want only the selected documents,
make sure to check the Download Select-
ed Documents Only option.

w» Exporting your search results

It is possible to save search results as
HTML, text, XML, CSV (Comma sepa-
rated variables) and dBase files. First,
select the search you want to save by
clicking on it. Give the result a name,
select the type of file you want to save it
as and mention the path where it has to
be saved. That’s it.

Net Snippets

With a drag-and-drop interface, this brows-
ing tool allows you to select and save por-
tions of the Web page you need, besides
snippets from other Windows applications.

= Adding snippets and images
Adding a new snippet from a page is easy.
Make sure that Net Snippets is running
by going to View > Explorer Bar > Net Snippet
option in Internet Explorer. Highlight
the snippet or image you want in the
Web page. Drag and drop the snippet
into the Net Snippets explorer window
on the left hand side of the page.

w Directly saving Snippets

You can save Snippets even without
opening the Net Snippets Explorer. Just
highlight the element you want to save
and right-click. In the menu, select the

Save the Snippets you want directly

Add to Net Snippets option and save it.

w Getting Snippets from other
applications

Net Snippets has a feature called Drop
Spot which allows you to drag-and-drop
snippets from applications other than
Internet Explorer. For enabling the Drop
Spot toolbar, right-click on the Task Bar

T R e e T wE

Helpingior

Enable Drop Spot toolbar for other
applications

and select Net Snippets Drop Spot from
the Toolbars option. This will add a new
toolbar called Drop. Now you can drag-
and-drop snippets from any application
you want into the Drop toolbar. This will
help you save that particular snippet in
the same manner as with Internet
Explorer

Atomica 2.0

Atomica automatically analyses the context
of a selected piece of text. It delivers refer-
ence information from a dictionary, the-
sauras, or encyclopaedia.

= Using Atomica 2.0 with Acrobat
Reader

Atomica can be used to look up words
in Adobe Acrobat Reader. In Acrobat
Reader choose the Text Select tool by
clicking on the Text Select icon or by
pressing the [V] key. Now highlight the
word or words to be looked up. Press
the [Alt] key and right-click to look up
the terms.

O
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Use text select tool in Acrobat Reader to
look up words

o Changing key combination in
Atomica

Don’'t want to use the default [Alt] key +
Mouse Click combination each time you
want to look up something with Atomi-
ca? Right-click on the Atomica icon in
the system tray and change the key com-
bination to the one you want in the Pref-
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Change the default Alt key combination

erences box that opens. You have the
option of changing key settings for
Atomica.

= Clearing history in Atomica

To clear the history lists in Atomica,
right-click the Atomica icon in the sys-
tem tray and select Preferences. If you
want to clear history of only the present
session, use the Clear History button to
clear it. Check the Clear History After
Every Session box if you want the
history to be cleaned each time Atomica
is used.

Surf Pilot

A browser companion with search capabil-
ities, bookmarking features and a built-in
browser.

w Shortcuts

[Shift] + [Ctrl]] + [N] — New file search
[Ctrl] + [R] — Refine search
[Ctrl]] + [O] — Open session
[Ctrl] + [S] — Save session
[Shift] + [Ctrl] + [S] — Save as
[F2] — Export HTML report

[Alt] + [M] — Send

[Ins] — Create new records

[Alt] + [Ins] — Create new folder
[Ctrl] + [J] — Park

[Ctrl]] + [D] — Unpark

[Ctrl] + [M] — Mark as read

[Ctrl] + [U] — Mark as unread

[Ctrl] + [Alt] + [D] — Record descriptions
[Ctrl] + [1] — Show all records

[Ctrl] + [2] — Hide read records

[Ctrl] + [3] — Only parked records

[Ctrl] + [4] — Show records with reached
links

[Alt] + [0] — View threads by none

[Alt] + [1] — View threads by domain
[Alt] + [2] - View threads by title

[Alt] + [3] - View threads by source
[Shift] + [0] — Group folders by none
[Shift] + [1] — Group folders by keywords
[Shift] + [2] — Group folders by category
[Shift] + [3] — Group folders by package
[Shift] + [4] — Group folders by date
[Shift] + [5] — Group folders by search
scheme

[Ctrl] + [W] — View categories bar

[Ctrl] + [Al] + [W] — View log

[Alt] + [V] — Validate links in selected folder
[Ctrl] + [Alt] + [V] — Validate all links in
session

[Alt] + [D] — Delete duplicates in selected
folder

[Alt] + [U] — Delete records with unreach-
able links

[Shift] + [F4] - Search engine analyser
[Shift] + [Ctrl] + [F4] — Category editor
[Shift] + [Ctrl]] + [M] — Mark records with
folder’s keywords

[F9] — Show Preferences

[F12] — Search mode switch

[Alt] + [Enter] — Show folder / record
properties

BROWSER COMPANIONS
Programs to help you speed up browsing, disable pop-ups, and search
the Web in a more efficient manner

NetSonic Rawam Ostu | the system tray.  justclick on the favourites or links in his-

Accelerate browsing by loading previously boiiaret el Launch the tory of the browser to view the pages

accessed Web pages from its cache. It fea-  Tigin | I The browser and when offline.

tures offline browsing, site exclusion, and ok Hlzae welod | make sure that

customised chache locations. sl the  browser's w Excluding sites from acceleration
iak ) ! Work  Offline Itisbetter to exclude sites like news from

- Browsing pages offline Uerdd- Buchr ol option is not acceleration in Netscape. These sites are

Close all the browser windows you've selected. Then updated very rapidly and the cache may

kept opened. Now select the Work v T show old information. To exclude a site

Offline option from the NetSonic menu o] R from acceleration, go to NetSonic

by right-clicking on the NetSonic icon in

Browsing pages while offline

options. Now select the Site Exclusion
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Enter the URLs you want to exclude

option under the Settings tab. In the Site
Location box feed in the URL of the site
you want to exclude. Click on the Add
button and you are through.

w Use advanced cache settings

The default setting of NetSonic cache
(memory for storage of Web pages in the
hard disk) is 200 MB. If you think it is
taking up too much or too less hard disk
space, then you have an option to change
it. For this, click on the Advanced cache
button in the Acceleration option. This
can be found under Settings in NetSon-
ic Options. You can select the cache size
from any capacity between 2 MB and
4294 MB using the slider. It is also pos-
sible to change the location using the
browse button. Clearing up the cache
can be done using the Browse button.

CrystalPort AppCapture

Browse the web faster with this browser
companion which can manage multiple
profiles, searches, etc.

w Disabling pop-up windows

Itis possible to disable pop-up windows
in CrystalPort. For this, go to Tools and
select the Disable pop-up windows. It is
also possible to see one of the disabled
pop-ups. For this, go to Tools > Disabled Pop-
up Windows and select the window you
want to view from the list of disabled
windows.

w Disabling media
Don’t want to see all those animations,
images, music, sounds, etc that slow surf-

ing? CrystalPort AppCapture helps you
disable all of them. In the Tools option,

Disable media types for faster downloads

untick the required media types you
want to disable. For example, if you want
to disable sounds, unselect the Play
Background Sounds option.

w Translate Web pages

Thinking of getting a translator to
translate Web pages? CrystalPort’s Trans-
late function does the job for you. For
enabling this function, click on
the arrow next to the Go button. Now
select the translation you want
performed.

TR a
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Use translator to translate Web pages

= Adding search engines
It is possible to add search engines of
your choice to the custom search engine
list in CrystalPort. For doing this, go to
the search engine you want to add using
the browser, and click on the Add Cur-
rent Page option. At the Add Custom
Search Engine box that opens, click OK
to add the search engine.

It is possible to search the site from
the Advanced Search Bar after it has been
added.

Shortcuts for
CrystalPort

[Ctrl] + [L] — Open link

[Ctrl]] + [W] — Close

[Alt] + [Left arrow] — Back

[Alt] + [Right arrow] — Forward
[Esc] — Stop

[Ctrl] + [Tab] — Go forward

[Ctrl] + [Shift] + [Tab] — Go back
[Ctrl] + [H] — History bar

[Ctrl] + [1] — Favourites bar

[Ctrl] + [M] — Multiple search bar
[Ctrl] + [E] — AppCapture sidebar
[Ctrl] + [F5] — Auto refresh

[Ctrl] + [F7] — Tile mode

[Alt] + [Enter] — Full screen

[Alt] + [Home] — Home page
[Ctrl] + [Alt] + [P] — Preferences
[Ctrl] + [D] — Add to favourites
[Ctrl] + [B] — Organise favourites
[F2] — Channel bar

[F4] — Disable popup windows
[F9] — Close present tab

[F10] — Close all tabs

[F11] — Close all tabs except present

= Set up Paranoia
You can clear your Web history using the
Paranoia tool in CrystalPort. It is possi-
ble to clear address bar history, search
bar history, main history, Recent Docu-
ments, and your Temporary Internet files
using Paranoia.

For setting up the Paranoia tool, go
10 Tools > Paranoia. In the dialog box, check
all the boxes for the items you wish to
clear. Next step is to click on the Clear
Selected Items Now button and click OK.
Paranoia can also be customised to clear
items of your choice. For doing this,
check the boxes you want to be cleared.

Now check the box next to Clear
Selected Items every time the browser is
closed. This option will clear the brows-
er history every time you exit it. Click on
Apply and then OK again. The items
you've selected will be cleared every time
you close the browser.
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w Importing Netscape favourites

To add IE and Netscape favourites to
CrystalPort, go to Tools > Select Import and
Export Favorites. Select the Import Netscape

Import Netscape favourites into
CrystalPort AppCapture

Favourites option from this, choose the
folder you want to save, and click Finish.
The bookmarks have been imported.

- Allow multiple instances for
new sites

If you are tired of every new window
opening as a tab, then you have the option
of multiple instances (open each new link
as separate windows instead of tabs). For
this, go to Tools > Preferences. Now select the
multiple instances check box to have mul-
tiple instances of the browser.

SpeedNet

Accelerates downloads, resumes interrupt-
ed downloads and resolves IP for faster site
access.

- P Resolving

You can save time while accessing Web
sites using SpeedNet’s IP resolving fea-
ture. It allows you to enter Web address-
es and IP addresses which saves loading
time while browsing. For setting up IP
resolving, click on the SpeedResolve but-
ton or go to View and select SpeedRe-
solve. Now click on the Start Wizard
button to start IP Resolving. There are
two options for IP resolving. Select
SpeedResolve with a new address option
to add IPs of the sites you regularly visit.

The check for IP update option checks
Internet settings and compares them
with your SpeedResolve settings. If there
is a change in the IP address, SpeedNet
will accordingly update your settings.
Click on SpeedResolve, add new address,
and click Continue. In the location box,
enter the URL of the site whose IP has to
be resolved. For example, if you visit
www.rediff.com a lot, enter the URL in this
box. Click on Finish and you are done.
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Just enter the URL to resolve its IP

The SpeedResolve wizard will now ask
you if you want to add another IP. Click
Yes if you want to add more addresses,
else No.

w Keeping SpeedCache updated

It’s necessary to make sure that Speed-
Cache doesn’t show you content which
was stored earlier. For this, click on the
Settings icon. Now select the Accelera-
tion tab and check the ‘Delete files when
I visit a new site’ option. This will make

Shortcuts for
SpeedNet

[Shift] + [F1] — SpeedUp
[Shift] + [F2] — SpeedResolve
[Shift] + [F3] — SpeedCache
[Shift] + [F4] — SpeedRetrieve
[Ctrl] + [S] — Settings

[Ctrl] + [X] — Exit

sure that SpeedCache does not show old
files stored in it.

EasyMTU

Modify your PC's Windows registry for a
faster Internet conncetion with this brows-
ing companion.

= Self-tuning for Windows NT
users

If you are using Windows NT 3.5x/4.0,
the TCP/IP stack is tuned automatically
according to the connection conditions.
If you want to change these and put in
your own settings for DefaultRcvWin-
dow and Default TTL, click on the Win-
dows NT tab. Now check the Disable
automatic settings option and fill in
DefaultRcvWindow and Default TTL
values.

Refresher

Refresh your site automatically at intervals
specified by you without using the Refresh
button . This is very useful when viewing
news sites, cricket and other sport sites.

= Using Power Search and Power
News

GO to Power-Tools > Search Or Power-Tools >
News to get Search and News as different
tabs in the same window. Now select the

Select News or Search from Power-Tools

search engines and news sites you want
to see. Press the Go! button to view the
different sites as different tabs in the
same window.

= Drag and Drop Links

You can drag and drop links in Refresh-
er by just dragging the link you want to
open on to a tab. The tab will be activat-
ed and the link will be dropped in to the
Explorer window.

Ad will come
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DOWNLOAD MANAGERS

They manage your downloads for you, resume broken downloads and offer
features like management of mulitple downloads

Download Accelerator Plus
Improve download speed, resume broken
downloads, and find mirror sites.

= Drag-and-drop files into Down-
load Accelerator Plus

You can simply drag-and-drop the links
from which you want to download into
the download basket. For this, enable the
Download Basket option from the
Downloads menu. This opens up a small
window titled Download.

Now click on the link to drag-and-
drop it into this box. In the Download
File Info box which pops up, click on the
Start Download button if you want the
download to start immediately. Clicking
on the Download Later button puts the
download into the queue for download-
ing later on.

Using the Advanced button you can
choose between the various download
speeds available.

= Downloading directly without
the browser

It is possible to download directly with-
out opening the browser if you know the
URL of the download site. All you have
to do is click on the Add URL button in
the Download Accelerator main window.
Click OK for the download to start
automatically.

= Downloading files with exten-
sions unavailable in DAP

Just press [Ctrl] + [Alt] when clicking in
an HTML link whose extension is not
available in Download Accelerator.

File extensions available in the Down-
load Accelerator Plus configuration are
.EXE, .ZIP, .ARJ, .RAR, .LZH, .Z, .GZ,
.GZIP, .TAR, .BIN, .MP3, .AVI, .MPG,
.MPEG, .QT, .PLJ, .ASF, .MOV, .WMA,
WMV, .RO*, .R1*, .A0*, .Al1*, .TIF, and
TIFF.

w Schedule DAP to download at
specified times

Download Accelerator has a scheduler
function which lets you specify when you
want to download.

Specify when you want the downloads
scheduled

The scheduler can be accessed from
the scheduler button or Downloads > Options
/ Configurations > Scheduler. The scheduler
can be set to run daily or once a week.
Make sure that the Enable Schedule Start
checkbox is ticked. If you want the
scheduler to run only on specific days of
the week, click on the Choose Days but-
ton to select the days you want the sched-
uler to run. Specify the time at which you
want the downloads to end by clicking
on the ‘Always stop downloads at certain
time’ checkbox and giving the time. Use
the HangUp modem, Quit the Down-
load Accelerator, or Shut Down comput-
er options to select the action to be done
after the downloads stop or are over.

w» Simultaneous download

Download Accelerator can simultane-
ously download any number of files.
However, you have to define the number
of maximum simultaneous downloads
to Download Accelerator. To set the
maximum batch size, go to Downloads >
Options / Configurations. Select the Connec-
tion option from the left hand side of the

box. Now set the maximum number of
simultaneous downloads in the Down-
load queue box near the right hand bot-
tom of the box. Click on Close to
complete.

w Searching for hot downloads
Click on Select > Hot Downloads. Clicking on
Start Search gives you Web sites with
downloads—both shareware as well as
freeware.

GetRight

This utility gives you the ability to resume,
schedule and manage your downloads.

= Setting up download times
GetRight can be scheduled to start
downloading at fixed times of the day.
For setting up the scheduler click on the
Schedule Download Start button on the
main panel or use Downloads > Schedule
Download Start. You can also get it by right
clicking on the GetRight system tray icon
and selecting from Tools. Choose the
time at which you want to start the
downloads and click OK. Downloads
will be performed at the time(s) you have
scheduled.

Similarly, the Download ending times
can be set using the Schedule Download
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Set up your Scheduler for fixed times of
the day
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Shortcuts for GetRight

[Ctrl] + [U] - View unfinished down-
loads

[Ctrl] + [H] — View history of finished
downloads

[Ctrl] + [1] — File comment on down-
loads

[Ctrl] + [G] — Start automatic down-
loading

[Ctrl]] + [L] — Obey speed limit

[Ctrl]] + [B] — GetRight browser tool
[Ctrl] + [D] — GetRight Dialler tool
[F7] — Verify URLs

[Ctrl] + [F7] — Verify new URLs

[Shift] + [F7] — Verify selected down-
loads

[F8] — GetRight configuration

Stop (Hang up) option in Downloads or
the Schedule Download Stop (Hang up)
button in the main interface.

w Setting up daily downloads

You can set up GetRight to download
from a list of download locations at dif-
ferent times on different times of the week.
This is possible using the Daily Down-
loads feature in GetRight.

Set up Daily Downloads using Tools >
Daily Downloads. This brings up the
GetRight Daily Downloads box. Click on
the Add... button to add the download
details. Enter the download locations of
the files you want in the URL box of the
Daily Download box. Now set the tim-
ings for downloads, days, and locations
to be saved. Click OK and you are done
with the set up.

FlashGet

Resume, schedule and increase download
speeds by splitting files into smaller
segments.

- Downloading files as segments

It is easier to divide a download into dif-
ferent segments for faster downloading.
This is especially beneficial in slow con-
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Set the number of segments to be
downloaded
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nections. FlashGet allows files to be
divided up to a maximum of 10 seg-
ments. However, in most of the ordinary
dial-up connections, it is always best to
keep the number of segments between
three and five.

w Downloading files not handled by
FlashGet

FlashGet does not automatically down-
load files like images. For downloading

Shortcuts for FlashGet

[F4] — New download

[F5] — Start job

[F6] — Pause job

[F8] — Start all jobs

[F9] — Pause all jobs

[Alt] + [S] — Schedule jobs

[Alt] + [M] — Move to

[Alt] + [Del] — Delete job

[Alt] + [Enter] — Properties

[Alf] + [Up arrow] — Move up

[Alt] + [Down arrow] — Move down
[Ctrl] + [Enter] — Open destination
directory

[Alt] + [H] — Hang up when done
[Alt] + [L] — Obey speed limit

[Ctrl] + [Alt] + [O] — Default download
properties

[Alt] + [O] — Options

these files, hold down the [Ctrl] and
[Alt] keys together and click on the file
or the link you want to download.
FlashGet will now get hold of the link
which is clicked and will start down-
loading it.

w Automatically scanning down-
loaded files

FlashGet can automatically scan all the
files you download with it. For setting up
the automatic scanning feature in
FlashGet, go to the tools menu and select
options from it. Select the File Manager
option by clicking on its tab. In the File
Manager check the ‘Use virus scanner to
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Give the location for anti-virus using the
Browse button

scan the downloaded file option’ for set-
ting up the automatic scanning feature.
Now give the path to the anti-virus you
use in the text box below it.

If you do not know the path of your
antivirus, then use the Browse button to
find the location of the .exe file as
shown. For example, if you use McAfee
AntiVirus, it will be having a path of the
form C:\Program Files\McAfee\VirusS-
can95\scan95. Norton AntiVirus will be
having a path like C:\Program
Files\Norton Antivirus\navw32.exe in
most cases.

If you do not want your antivirus to
scan all the files, then you can scan each
file individually by right clicking on the
downloaded file and selecting the Virus
scan option.

Ad will come
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ONLINE PRIVACY TOOLS

Preserve your online privacy with the help of these cookie managers and pop-ad blockers

Burnt Cookies
Tips on how to keep track of and manage
cookies on your machine while surfing.

w Making cookies fireproof

There are some cookies which are neces-
sary for proper functioning of your com-
puter. You can protect these cookies from
getting burnt by putting them in the
Fireproof list. For example, when a cook-
ie comes in, the program will ask you
if you want to put that cookie on the
‘Burn List’.

If you select No, the next query will
be whether you want to add it to the
‘Fireproof List. The cookies on this list
are not deleted from the PC. It is possi-
ble to view and modify the contents of
this list by clicking on the Fireproof
button.

w Command line switches
Command line switches help you con-
trol the way Burnt Cookies starts up. The
command line switches available for
Burnt Cookies are given below.

/h—Burnt Cookies start up in hidden
mode. This switch is the same as starting
the program normally and then clicking
the Hide button.

/newlog — Creates a file called ‘Burnt
Cookies.txt’ in the same folder as the
program executable. This folder contains
a list of all URLSs visited during the ses-
sion of Burnt Cookies which has just
ended.

/log — This is similar to ‘/newlog’
above but appends a list of all URLS vis-
ited during the session of Burnt Cookies
which has just ended to the file.

AdSubtract SE

Block ads and cookies by setting up filters.

- Configuring filters
Filters help you configure AdSubtract SE
as to what kind of blocking you need to

enforce. The default option of blocking is
to block all advertisements.

In addition to advertisements you
can also block all cookies. For setting
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Use filters to block and selectively filter
sites

up filters click on the Filters tab. Now
check the Cookies option as well if you
want AdSubtract to block incoming
cookies.

One problem with this kind of
blocking is that it tends to block all
sites. There are sites (like banking, for
example) which have to place cookies
on your PC for security purposes. if
these cookies are removed, you will not
be able to use these sites. For this you
can put all these needed sites in the
Custom Sites Filter list. For adding a
site to the Custom Sites Filter list, click
on the Add button in the Custom Sites
Filter and add.

You can also remove the default sites
or those you don’t want to be blocked
from this list. Just click on the site in the
list and click on the Select button.

Pop-up Stopper

Ban pop-ups and ads to minimise on irri-
tating distractions and to retain your surfing
pleasure.

= Allowing pop-up windows when
block is enabled

Many sites have pop-up windows for dis-
playing content instead of ads. In these
cases, you can temporarily disable the
blocking by holding down the [Ctrl] or

[Shift] key when clicking on the link. Set-
ting the sound option each time for pop-
up windows is helpful. If you don’'t want
sound alerts, just look at the Pop-Up stop-
per icon in the system tray which flashes
every time a pop-up is blocked.

Double-clicking the icon can be used
to disable and enable Pop-Up Stopper
blocking. The X on the icon will be red
in colour when Pop-Up Stopper is
enabled.

Window Washer

Tips to clean up your browser’s cache, cook-
ies, and history. Automatically.

= Washing and bleaching files

You can set Window Washer to com-
pletely delete files from your PC. Adding
the Bleach To Wash Items will complete-
ly delete the washed files.

Set the number of times data has to be
bleached

To add bleach to washing, click the
Wash Options button. Now click on the
Info button after checking. This brings
up an Information box. In the box, click
Yes. Now enter the number of times you
want data to be overwritten. Bleaching a
file about three times ought to take care
of most of the sensitive data.fl
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IN TEST: 15 IDE HARD DISK DRIVES

rmore

DIGITAL MEDIA RESEARCH AND TEST CENTRE
he storehouse of your computer, hard
disks are marvels of modern engineer-
ing that glean the best from fields such
as mechanical, electronic, aeronautic as
well as chemical engineering. The con-
struction of a hard disk involves very
precise and micron-level tolerances,
which is now possible with the help of
highly sophisticated machinery. Right
from the time the first 20 MB hard disk
made its appearance to the 100 GB hard
drives available today, the increase in
capacity of these is a very accurate indica-
tion of the progress of computing in par-
ticular and technology in general. To
illustrate this, the areal density (the amount of data
that can be packed into a single unit of area on the hard
disk platter’s surface) of the hard disk drive has
increased by around 5 million times. Therefore, mam-
moth devices such as the 100 GB drives are fast becom-

ing commonplace nowadays.

When buying a hard disk, the first and primary con-
cern most users have is whether it will serve their appli-
cations well. Then there’s also cost that plays a role when
determining how large a hard disk you can afford. When
it comes to performance, there are a range of parameters
that dictate the speed at which your applications and pro-
grams will run from your drive. These parameters are specifi-
cations such as sequential and random data transfer rates
during read and write, access time of the hard disk and the CPU
utilisation during operation. The spindle speed of your drive
Eopastit AR (rotations per minute or rpm) will also play an important role
here, since the faster it spins, the faster will it be able to transfer
data between the platter and the read/write heads. To evaluate
the performance of these parameters, we used a selection of

With hard disks like
these, you can give
your PC all the space
it needs!
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TEST PROCESS

The following benchmarks were used to evalu-
ate the performance of the IDE hard disk drives
in this shootout:

B High-End Disk Winmark 99, which puts the
disk sub-system of the PC under stress

B SiSoft Sandra 2001te (Disk benchmark), a
synthetic benchmark that tests the

low level parameters of a hard disk

such as sequential and random

read/write speeds, access times, and

SO on.

W HDTach 2.6, which evaluates the

sequential read/write, read burst

speed, average access time and CPU
utilisation of the hard disk.

After running these tests, the over-

all score of a hard disk drive was cal-

culated by applying a set of

weightages to the various parameters

WEIGHTAGE TABLE
Benchmark Percent weightage
High-End Winmark 99 10
SiSoft 2001te score 5
SiSoft sequential read 7
SiSoft sequential write 7
SiSoft random read 12
SiSoft random write 7
SiSoft access time 10
HDTach random access time 10
HDTach read burst speed 10
HDTach read speed average 8
HDTach write speed average 8
HDTach CPU utilisation 6

and tests run. The weightages fixed
for the tests are as in the table.

benchmarking programs that test the perform-
ance of each of these sub-systems and also of the
hard disk as a whole by using applications such
as office productivity suites, etc. The results of
these tests are described below.

PERFORMANCE DRIVES (7200-RPM)
When you're looking for the best in
IDE disk drives, look no further
than the current breed of 7200-
rpm speedsters. The platters
of these drives spin at a
maximum speed of 7200
rpm and by virtue of
this, data can be picked

up by the read-write heads
much faster than in the case of
a 5400-rpm drive. Also, since data
is read that much faster, high-
speed interfaces such as ATA/100
can be properly utilised, which
makes the overall performance
and response of the hard disk
much faster. Let’s take a look at
this crop of hard disks and see which one is best
suited for your applications.

Application performance and the Winmark 99
For evaluating the performance of these drives,
we used Ziff-Davis High-End Disk Winmark 99.
This is a benchmarking tool that uses real-world
applications such as office productivity and mul-
timedia authoring tools, comprising audio and
video applications that particularly stress the
hard disk sub-system of a computer.

These applications are run in a script-driven
manner and the index that is returned at the end
of this test reflects the drive’s performance in
working with similar applications. It runs for

IBM Deskstar 75GXP: this
hard drive is silent and has
a very low CPU utilsation

about 10 minutes on each hard disk and the
strain that the hard disk undergoes is evident
from the sound and heat generated during the
course of the test.

In the 7200-rpm category, the IBM Deskstar
40 GB delivered exemplary performance in the

Winmark 99 test, logging a score of 26700.
Compare this, for example, to an aver-
age of 7500 logged by a 5400-rpm

drive of the same capacity.
The other drive that gave a
good score in this test was
the Seagate Barracuda
ST320414A 20 GB hard
drive, which scored
23000. This drive was also
very economical considering
the fact that it’s a 7200-rpm drive.
On the other end of the scale, the
Samsung SP4004H, with it’s Spin-
Point technology, did not score
very well in this test and notched a
score of just 5770.

Over to the actual tests that
measured the data transfer speeds: SiSoft San-
dra 2001te was the program used to evaluate the
performance of the drives in these low-level
tests. Here, we measured the data transfer speed
and the access times for the hard disk. We specif-
ically noted the sequential and random
data transfer
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rates in sequential operations are faster
than that of random operations as the
drive does not have to reposition the read-
write head each time it accesses a new file.
Also, the speeds while reading are faster
than that obtained when writing to the
drive. In this test, the best performer was
once again the 40 GB IBM Deskstar 60
GXP hard disk, which scored a blazing 39

Jifnft Sanden Sequentizl readivrite speed 00 rpm dries)

Max: 15
grEnd
IaM! Desistar 0LTA-307075 NI 73

I5M DeseSter EOEXP (16E) N o
Bempenn EPA004H . TR 7
EFEEEEREE i

fepgate Barracuds STI204144

MBps in sequential read and 7 MBps in the
random read test. When writing, this score
dropped to 11 MBps and 9 MBps during
the sequential and random write test,
respectively. These are very good scores
and indicate a usage of about 40 per cent
of the entire bandwidth available in the
ATA/100 interface. Though this
seems rather low, this is the
practical maximum that
a single 7200-rpm
hard disk can
achieve. When
evaluating  the
5400-rpm drives,
the under-utilisa-
tion of this bandwidth is
far more pronounced due to
the lower spindle speeds.
The access times
logged by these 7200-
rom  drives  were
between 5 ms and 9 ms
and though this isn't
much of a variation numerically, it does
translate into the drive taking longer to
access a file located on the hard disk.
Therefore, in case of the 20 GB Seagate
Barracuda, the access time of 5 ms means
that it is ideally suited for applications
where many files are accessed on the
drives—applications such as multimedia
authoring, databases, etc. In real world
terms, a faster access time means quicker
response of the hard disk, which is evident
when applications start up faster and are
more responsive when tasks are run.

What other factors affect performance?

There are other factors that are not direct-
ly related to the data transfer speed and

108 FIEH
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Western Digital WA Caviar WD200:
this 5400-rpm drive carries an amply
large 2 MB buffer onboard

access times of the hard disk but which
affect the overall performance of applica-
tions running on your hard disk. One such
parameter is the CPU utilisation of the
hard disk.
All hard disks manufactured today use
a technology called DMA (Direct Memo-
ry Access) which is a mode of data trans-
fer where the hard disk orchestrates
all data flow

between itself

and the rest of the

Maw 10 system—the
Saguentizl wrie main CPU of
|| your system plays
M i ittle or nopartin
T o this.  Therefore
I 30 the level to which

the hard disk
depends on the
main processor during data transfers
would affect the performance of the rest
of the system when the hard disk is being
accessed. This is known as CPU utilisation
and is expressed as a percentage.
The CPU utilisation of the drives was
measured by a benchmarking program
called HDTach, a program which is
known to accurately measure
this parameter. Here, we
found that these
7,200-rpm drives
posted a CPU
utilisation rang-
ing between 3.6
to 4.9 per cent.
This indicates that the
drives used a very small
portion of the system proces-
sor, which, in turn,
implies that the rest of
your system  runs
smoothly even while
the hard disk is being
accessed, as the hard disk uses a very small
portion of the main processor’s power.
Another interesting point seen in the
results was that the CPU utilisation post-
ed by SiSoft Sandra was significantly dif-
ferent from those logged by HDTach. This
is because different applications write dif-
ferent type of data to the hard disk, which
accounts for the variation in the scores
logged by the two programs.

VALUE DRIVES (5400-RPM)

Over to the 5400-rpm category, these
are the hard disks with wide variation,
both, in terms of price as well as capac-
ity. These are generally targeted at the
value market where not much stress is

How a Hard Disk
Works

Hard disks are used as a repository in
which vast amounts of information can
be stored. Unlike RAM, this information
is permanent in that it is retained even
after the computer is powered down.
This is done using the principles of
magnetic storage, which is similar to
that used in retrieving and storing infor-
mation on conventional tapes. Hard
disks allow data to be stored at far
denser levels and can be accessed very
quickly. The working of a hard disk can
be understood easily by drawing a par-
allel to the conventional audio or video-
tape. In an audiotape, a special
magnetic material is coated onto a thin
plastic strip whereas in a hard disk, the
magnetic material is layered onto an
aluminium or glass platter, which is pol-
ished to mirror smoothness. In an
audiotape, the reading and recording
head actually touches the surface
directly during the read-write process
but in hard disks, the head actually
‘flies” microns above the surface of the
platter and is never really allowed to
touch the surface of the hard disk. Just
fathom the speeds at which hard disks
operate: the tape in a cassette recorder
moves at a speed of about 2 inches per
second while the platters of the hard
disk can spin under the head at rates of
up to 3,000 inches per second, translat-
ing into a speed of 225 kmph!

placed on data transfer speeds, but on the
amount of storage space available for a
given price. Let’s take a look at the drives
that proved to be worthy performers here.

Application performance

Here, too, we ran high-end disk Winmark
99 as the primary benchmarking tool for
evaluating the performance of the drive in
applications such as multimedia author-
ing and software that especially stress the

Overal Scares (7200 rom drives)
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hard disk sub-system. The hard disk that
did especially well in this test was the West-
ern Digital WA Caviar WD200, clocking a
very impressive score of 19900. This
turned out to be higher than even two of
the 7200-rpm drives. This implies that the
hard disk, in spite of the 5400-rpm speed,
is still capable of good performance in
applications that require intensive access
to the drive, such as multimedia author-
ing applications using audio and video.
The Fujitsu MPG3409AT came a close sec-
ond in this test, trailing slightly behind the
Digital WA Caviar with a score of 18100.
The drive that delivered a very low per-
formance in this test was the 40 GB Seagate
ST30810A, logging a score of just 7790.
This implies that it isn’t suited to situations
where multiple applications would have to
be executed at the same time. However,
when it comes to storage space, this drive
offers 40 GB and therefore imparts a lot of
value in situations where you just need
storage space, with little stress on per-

550h Sendre ndex
[The top Faee 5400 rpm dreees|

Hrand - Mg Ll
Marior D540 4k0a0H B 7raqd
Mextor 2E02041 G410 I 21882
Samzung SUEN4 I ro2a7

Wastern Digital WA Cavier WO200 I 20324
Fugesn FAPGIA05AT I o0z

formance.

In terms of the data transfer speeds, the
drive that posted exemplary performance
in the sequential read transfer rates was the
20 GB Maxtor 541DX, which posted a
score of 37 MBps. The drive that came in
a close second here was its 80 GB sibling,

the Maxtor D540X-
4K080H4, clocking a

SiSoft Sandra Rendom read'writs spsad (The top five T400 rpm drives)

respectable 33 MBps. Mu: 15 e

The drive that trailed Brang Azndom rzzd Hendnm wirrs
here was the 80 GB Samsung AVa0nay NN 0 R ©
Seagate ST380020A, Seggate ST3E00200 NN 10 [
which clocked a Maxtor 2W10ma s5any GGG - B ERS  |
very disappointing Sesgate ST3405100 NN 7 .

14 MBps in the Sragate ST702105 N 7 .

sequential read test.

However, this drive

posted a very respectable score of 10 MBps
in the random read tests, along with the
40 GB Samsung SV4084H drive.
This could be attributed to the
fact that these hard disks
also  posted very
good scores in
the access time
benchmarks. As
access time has a
direct bearing on
the random data transfer

rates, since the read-write heads
are constantly actuating
when accessing the differ-
ent parts of the platters, a
lower access time will help
the heads access the data
faster and subsequently allow for greater
data transfer rates. These drives are ideal-
ly suited for applications where data will
be primarily read in a random manner, for
example, a storage drive where installa-
tions of applications are stored or data-
bases are continually read from.

In the sequential writing tests, the
drive that performed well was the 80 GB
Maxtor D540X-4K080H4 and the 20 GB
Western Digital Caviar WD200. In spite
of them being 5400-rpm drives, they
posted very respectable scores of 32 MBps
and 29 MBps, respectively. An interesting

Maxtor 541DX: this 20 GB drive
has a low CPU utilisation and has
a fast sequential read rate

trend noted here was that a majority of
the drives that did well in the sequential
write tests were those that featured
more than one platter. This is
because when there
is more than
one platter
available,
there are
multiple
heads writing
onto the platters
concurrently, resulting
in twice as fast sequen-
tial write speeds. These
drives would be ideally
suited for applications
such as amateur audio
and video authoring, where you would be
writing large quantities of data to the
drive over sustained periods.

As seen from the graphs, the random
write scores were expectedly logged as the
lowest by these drives, since this test
involved writing data on random sections
of the hard disk.

The drive that did the best in this test
was the mammoth 100 GB Maxtor
4W100H6 536DX, which logged a good
transfer rate of 11 MBps. Coming in sec-
ond were the 40 GB drives, Fujitsu
MPG3409AT and Samsung SV4084H.

How Much Space is Enough?

Application Recommended capacity Individual file size (Avg. range) | Explanation
Word processing, | At least 20 GB 20 KB to 200 KB These files are very small and consume least amount of space on your
spreadsheets drive. Go in for an entry-level 20 GB drive.
MP3 audio 20 GB and above, depending on | 3 MB to 7 MB The size of hard disk you settle for depends entirely on the total
the number of files number of MP3 files you plan to store
Movies (DivX) 20 GB and above, depending on | 400 MB to 700 MB Here again, the size of hard disk you settle for depends entirely on how
the number of movies many movies you need to store
Audio/video Entry level: 20 GB Depending on usage If you're a professional who works on audio/video files, you should opt
editing Professional: 100 GB for the largest and fastest drive you can afford.
Gaming 20 GB and ahove, depending on | Upwards of 20 MB Today's games are huge and often take up to 1 GB on a full install.
the number of games Depending upon whether you're a casual or serious gamer, you should
go in for the largest drive you can afford

110 B November 2001
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What other factors affect performance?
We saw that the drives that posted com-
paratively lower scores in the access time
test were also the ones that returned low
data transfer scores. Access time affects the
random access of data, which was
evident in the random data trans-

fer tests. The 20 GB Seagate

ST20410A posted a score of
16.6 ms in the access
time test. The drive
that posted very
good access time
scores was the 60 GB
Samsung SV6004H, which
posted a good score of 9.5
ms. Expectedly, this drive
exhibited good overall per-
formance in the rest of the
data transfer tests.

The CPU utilisation of the hard disk,
though neglected by most of us at times,
determines the demands that the hard disk
places on T processor during its opera-
tions. This is especially significant to 5400-
rpm drives, as they do not have the
headroom in terms of data bandwidth as
compared to their 7200-rpm counterparts.
These scores were logged by the HDTach
benchmark and the drive that posted a
good score in this test was the 20 GB Max-
tor 2B020H1 541DX, which logged just
2.6 per cent of CPU utilisation. On the
other end of the scale, the drive that
utilised more CPU power was the 20 GB
Seagate ST20410A, at a very significant
12.7 per cent. This means that the Maxtor
drive would be ideally suited for situations
when you want to use the hard disk in sys-
tems that are powered by an older proces-
sor, where any additional strain on it
would be very noticeable in terms of over-
all system performance. The same would
be the case in applications where you
would be using software that are implicit-
ly demanding on the main processor, such
as image, sound and video editing, 3D
authoring, etc.

There are two primary parameters that
you need to consider when deciding on

il
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Maxtor 536DX: this 100 GB
drive gives you all the storage
space you need

how much you
want to spend for a
hard disk: capacity

Was: 35

Saguestiol writa and performance.
|___BF When considering
I i performance, we
BN 7:  found that the
M : 40 GB  Fujitsu
A e MPG3409AT and
the 40 GB Samsung

SV4084H were both

available for up to Rs 6,000, coupled with
very good performance numbers. This
makes these drives very well suited to tasks
that need a good level of performance
while still offering 40 GB capacities.
If you're looking for a greater amount
of storage, then the 60 GB Sam-
sung SV6004H hits the
sweet spot with a
price tag of just Rs
8,000. This was, in
fact, the cost of a 40
GB hard disk about four
months ago. If you're will-
ing to shell out a few thou-
sand rupees extra, you
can even get an 80 GB or
a 100 GB hard disk—
these cost between Rs
12,000 and Rs 15,500. Of
special mention here is the Maxtor 100 GB
hard disk (the largest in the country right
now), which is available at Rs 12,800. This
is definitely a better choice, both in terms
of price and performance, over the 80 GB
Seagate ST380020A, for example.

How big is big?

When it comes to tasks that require large
files to be written to and read from the
hard disk, you should opt for one that
sports high sequential data transfer speeds
such as the 40 GB IBM Deskstar or the 20
GB Seagate Barracuda drives. If, on the
other hand, your job involves working with
smaller files such as database applications
that access information frequently from
the drive, or multimedia and Web author-
ing tools, then the random data transfer
speed of the drive would play a pivotal role
in the performance and response of your
applications. Here, the drive that excelled
was the 76.8 GB IBM Deskstar.

Finally, when it comes to applications,
you would need to decide the size of the
hard disk you're willing to settle for
depending on the applications you plan to
use. For example, if you're a home user
who’s looking for a performance hard disk
and you plan to use applications such as

intensive gaming, 3D software and sound
and video editing, then you would at least
need a 20 GB hard disk. Depending upon
the volume of files you plan to create, you
could even wind up using all of the space
on your 40 GB hard disk! (Refer to the
table, ‘How Much Space is Enough?’ high-
lighting the suggested hard disk sizes in rela-
tion to the files and applications you most
often work with.) Asarule, text documents
and spreadsheet files require the least
amount of hard disk space. In the middle
range, there would be files such as Power-
Point presentations, MP3 audio files, etc.

Owzred Scares |The tog dive S400 rpm dives

drend Crazral {%|
Samswen Sva0nas NN 555
Mextor 4W100HE 5360 I 52 :7
Rzetor NELDE-Axna0H TN 5.0
Semzung SVEODH I 5121
Fsjitzn MPEIA0EAT I 009

Finally, if you're a movie buff and store fea-
ture-length movies on your hard disk
itself, at the rate of about 700 MB per
movie, your hard disk could get filled in
direct proportion to your interest in
watching movies!

Files such as MP3, audio and movies do
not really need a high-speed hard disk to
work well.

Performance hard disks come into play
if you work with audio and video files and
are involved in multimedia authoring
applications that use large files that are
accessed constantly. This would also
include Photoshop where average file sizes
would range anywhere between 5 and 50
MB. In these cases, a fast hard disk drive
will ensure that you don’t have to wait long
when working with many such files.

CONCLUSION

From this roundup, it is apparent that the
array of hard disks available are
so wide in terms of capacity,

IBM Deskstar 60GXP: the performance hero

November 2001



Performance

Price

Performance

Price

price as well as performance, that choosing
the best from them is very closely tied in to
the utilisation.

In the 7200-rpm category, the drive that
bagged the Best Performance award was the
40 GB IBM DeskStar 60GXP. This drive
posted best-of-class performance in virtu-
ally all of the tests it was subjected to and is
ideally suited for applications that need

high speed data transfer such as
professional audio and video
editing or even for the

Seagate Barracuda: the value option

demanding home user. The drive bagging
the Best Value award in this category was
the 20 GB Seagate Barracuda ST320414A.
The drive was priced nearly the same as
most 5400-rpm drives (though offering
only 20 GB of storage space) and if it is per-
formance you're looking for but don’t need
an overly high amount of storage space,
there’s no other drive that comes close to
the 20 GB Barracuda.

In the 5400-rpm category, the drive that
bagged top honours was the 40 GB Sam-
sung SV4084H. This drive offered a good
amount of storage space for working with
most applications and posted very good
performance characteristics. If you're look-
ing for good value where you do not need
much storage space or especially high per-

IBM Deskstar 60GXP (40 GB)

Seagate Barracuda (20 GB)

Samsung SV4084H (40 GB)

Fujitsu MPG3204AT (20 GB)

formance, the 20 GB Fujitsu MPG3204AT
should suffice, with its reasonable per-
formance and highly affordable price. This
drive is ideal if all you're looking for is an
economically priced hard disk for running
applications such as word processors,
spreadsheets and surfing the Internet.
With hard disk drives pushing the lim-
its of performance and capacities and with
applications getting larger every day, it
wouldn’t be surprising if in a few months,
you were to settle for a 60 GB or 100 GB
hard disk in your new home computer.

Fujitsu MPG3204AT: an affordable performer

Until then, the present drives will serve
you well in whatever application you
might want to throw at them—be it office
productivity or serious gaming! il
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On your way to
buying a CD-ROM
drive? Our Test
Centre plays the disc
jockey and tells
what's what to help
you make a wise
decision

114 BEER
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DisKography

DIGITAL MEDIA RESEARCH AND TEST CENTRE
e've seen the trusty CD-ROM drive grow
in terms of importance in a system to
such an extent that it now forms an indis-
pensable part of any PC. This has prima-
rily been fuelled by the fact that software—both
applications as well as operating systems—have
also grown exponentially in terms of install sizes.
What was once available on sets of floppy disks
as a de facto standard, now comes on CD-ROMs.
Added to this, the increasing use of multimedia
in conventional applications has been a pivotal
factor in transforming the CD drive into a com-
ponent that you can’t do without.

Thanks to the Video CD and DivX rage, the
popularity of movies on CD-ROM, though ille-
gal, is a big selling point and forms one of the
main uses that most home users have for their
CD-ROM drive. The importance of the CD
drive is also, in fact, corroborated by the fact that

nowadays boot floppies are so rare—you can
boot and install operating systems off the CD-
ROM drive itself. While other optical standards
such as DVD-ROM s have also risen and taken
some of the limelight away from the CD-ROM
over the past couple of years, the economical
price and very high availability of software and
working titles have ensured that the CD drive is
still widely used, both in new computers as well
as standalone purchases.

In terms of technology, however, the under-
lying operating principles and mechanisms of
CD drives have remained largely unchanged.
The major advancements that we have seen are
the increase in the speeds itself and not the actu-
al read technology.

Looking back, the first conventional CD-
ROM drive sported a 4x read speed (that’s four
times the speed of an audio CD, or 150 KBps x
4 =600 KBps). Today’s fastest CD-ROM drives
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The tests comprised of a mix of real- -
world and synthetic benchmarks that | TeStS- Weightages
included Ziff-Davis CD Winbench 99, | C2 Winbench 99 10
SiSoft Sandra 2001, AudioCatalyst | SiSoft Sandra 2001te 34
(digital audio encoding). SiSoft index 4
The real world tests included copy- Sequential read (KB/s) 10
ing a single 100 MB file, copying Random read (KB/s) 10
100 MB of assorted smaller files, and Average access time (ms) 10
opening 10 TIFF images through Pho- | audio catalyst 24
toshop 6'0'_ File copy / access 32
The weightages accorded to these Single 100 MB (sec) 8
tests in determining the overall per- Assorted files (sec) 12
formance of the drives are given in the o
adjoining table. Opening files in Photoshop (sec) 12

L Wisbencd B semes ol the lop fe C0-Homs
May: FIHEI
Brand L0 Wialerd 22

ARLS cO-sReoRy R oon
ASUS CO-550006  EREEEEEEE 1950
APEX CHI-GE IR 1030
ACER COG52F EESEEEN 1750
ACER CU Gben TSNS 1750

sport a blazingly fast 72x maximum read speed!
While these speeds are not sustained through-
out the entire operation of the drive, the effec-
tive read speeds of the CD-ROM drives available
today will let you, for example, install Windows
98SE in about 35 minutes flat on a Pentium I11
based system, as compared to the leisurely
50 minutes to one hour that it used to take on
the 32x and slower drives available just a few
years ago.

To help you better understand the potential
of these bad boys, we've put to test some of the
best CD-ROM drives available today to help you
get a good idea of the kind of myriad applica-
tions each is capable of running.

Application tests
CD Winbench 99 is one of the
best benchmarking software
for testing a CD drive’s
overall performance.
This  includes
measuring the

CPU  power

utilised  while Vil
operating the CD- R
ROM (that is CPU
utilisation expressed as

a percentage) and the speed
of the CD-ROM (which is
expressed in terms of
data transfer rates and

LG CRD8522B: fast at ripping audio

access times).

As this test involves running a variety of
applications such as word processors and
spreadsheets that are run directly from the
Winbench 99 CD, you get a clear indication of
performance while working with these ‘real
world’ applications as well as the actual data
transfer speeds. Since this test continuously
accesses the drive, the operating noise levels of
the drive also becomes evident.

In this test the drive that overtook all others
was the ASUS CD-S520/G. Though the rated
speed of this drive was just 52x, it outper-
formed other higher rated drives by scoring an
index of 2000—the highest in this test. Coming
in a close second to this drive was its sibling,
the ASUS CD-S500, which logged a score
of 1950.

Of notable mention is the Apex CHI-56,
which trailed 70 points behind the fastest drive
in this test. However, the price of this drive is
a very significant Rs 400 lesser than the
52x ASUS, with performance that closely
matches it.

On the lower side, the drive that didn’t meet
up with our expectations was the 40x Plextor
PX-40TSi. Sporting a SCSI interface, this drive

logged a score of just 1380, which was the

lowest in this roundup. In spite of

being rated as a 40x drive,

this one came with a Rs

5,450 price tag because

of its SCSI interface.

With  performance

that was just not up to

the mark in this test,

this drive is not a good

choice: its price is a constraint

and it's performance is, in fact,

slower than even some of the IDE
drives tested.

While most scores posted by the
52x drives ranged from 1500 to
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!!!!! Specifications

The CD-ROM Drives at a Glance

Brand Model Speed Contact Phone E-mail Web site Warranty  Price Rating
Acer CD652P 52x Acer Peripherals 022-570 5230/31/32  pankajpamani@acercm.com.tw www.acercm.com 1year Rs 1,650 B+
Acer CD 656A 56X Acer Peripherals 022-570 5230/31/32  pankajpamani@acercm.com.tw www.acercm.com 1year Rs 1,850 B+
Apex CHI-56 56X Apex Computers 8354157 bomapex@bom2.vsnl.net.in - 1year Rs 1950 B+
ASUS CD-S500/G 50x Aditya Infotech Ltd 6338555t0 61 applmmb@bom4.vsnl.net.in www.adityagroup.com 1year Rs 2250 A-
ASUS CD-S520G/A  52x Aditya Infotech Ltd 6338555t0 61 applmmb@bom4.vsnl.net.in www.adityagroup.com 1year Rs 2350 B+
Creative Digital iR 52x Compuage Infocom Itd  022-8305501/02/03  info@compuageindia.com www.compuageindia.com 1 year Rs2250 B
Krypton 52x Priya International 022-2663611 prom@priyagroup.com WWW.priyagroup.com 1year Rs 1,740 B+
LG LG CRD-8522B  52x LG Electronics 022-691 0123 sanjaym@Igindia.com www.lgindia.com 1year Rs 2,200 B+
Plextor PX-40TSi 40x Zeta Technology 022-4102288 tejas@zetaindia.com www.zetaindia.com 1year Rs 5450 B
Samsung  SC-152 52x Savex Computers Ltd ~ 022- 2881616/17 devang@savexcomputers.com  www.savexcomputers.com 1 year Rs 2,000 B

2000 points, another drive that delivered
below-par performance in this test was the
Krypton 52x, which just managed a score
of 1380 in spite of being rated as a 52x
drive.

If you more often than not run appli-
cations from the CD drive directly (as in
games that need the CD to be in the drive
to be played) and also perform extensive
installations, then the ASUS CD-S520,
which did well in this test, would be your
best choice. If price is a constraint, then
you could consider the Apex CHI-56,
which delivered performance close to
the best performer in this test, but was
priced lower.

Give me raw numbers!

SiSoft Sandra (System Analyser, Diagnos-
tic and Reporting Assistant) 2001te is a
utility that we used to benchmark param-
eters such as sequential read, which is
important while copying or playing back a
single large data file, such as an MPG or
AVI file, from your CD.

The random read, buffer read and the
access time of the CD drive that this test
measures are also important because
they reflect the performance while
browsing the contents of a CD. This test
also logs information such as the maxi-
mum speed the drive reached while run-

Li%oft Sandra scores for the

ning the test.

Here too ASUS delivered exemplary
performance in both, the 52x and 50x
drive categories. Results logged by the
ASUS CD-S520/G were very impressive
across the board where it logged a
sequential read speed of 3553 KBps, a
random speed of 682 KBps and an access
time of 56 ms. These were among the
highest that we’ve seen in a CD-ROM
drive. This performance was also repli-
cated by its 50x sibling, which
clocked a sequential read
score of 3496 KBps, a
random read
speed of 688 KBps
and an access time
of 55ms. : y

Another  drive Ay
that also did especially
well in this test was the Apex wi
CHI-56, which scored 3395 KBps
in the sequential read test.
The random read speed
and the access time of this
56x rated drive, which was
clocked at 764 KBps and 45 ms, respec-
tively, turned out to be even faster than
that of ASUS.

On the other side of the spectrum, the
drive that disappointed was the Samsung
SC-152. It managed a sequential read
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Apex CHI-56: it's fast in read-
ing and transferring data

speed of just 1462 KBps, which is under
par considering that it is a 52x drive. To
add to this, the price of this drive was a
shade higher than the average pricing in
the 52x category.

The Creative Digital iR CD drive was
another that gave a low result of 2061
KBps in the sequential read test. Howev-
er, this drive did sport some cool features
such as an infrared remote control that
can be used to control the functioning of

the drive if you choose to install the
application software that is bun-
dled with it.

Of special men-
tion is the per-
formance of the
drive in the ran-
dom read tests.

This is a very pivotal
specification ina CD-ROM
drive as it talks about the
performance of the drive’s
data read assembly while
accessing information from
different parts of the CD-
ROM media.

While the scores in these tests may not
seem very high as compared to those in the
sequential read tests, they are a more real-
istic indication of how the drive will per-
form with day-to-day applications, as
most access to the CD-ROM drive is ran-
dom in nature (such as browsing the con-
tents of a CD-ROM, running multimedia
applications, installing applications etc).

Here, the drive that posted the best
results was the Apex CHI-56, which logged
a transfer rate of 764 KBps with an access
time of just 45 ms.

If your work process predominantly
involves sequential access of large data files
(asin reading big image files and databas- =)
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m select~test drive

es from CDs), then the ASUS CD-S520 is
the best choice. For random data read
applications, the Apex CHI-56 gets top
honours, but if features such as a remote
that allows you to control drive operations
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is more important to you, then the Cre-
ative Digital iR would be a good choice,
provided you're willing to sacrifice on per-
formance.

Audio ripping

This helps evaluate the ability of the drive
to perform error corrections with the help
of better cache synching on the fly, which
results in WAV files devoid of any ‘clicks’
and jitters. This will result in better quali-
ty as well as faster conversion of CDA to
WAV format.

All you MP3 buffs out there would
need a drive that works well with applica-
tions that need audio tracks to be ripped
from audio CDs so that they can be
worked on and edited or converted to
another format such as MP3. This process
is called Digital Audio Extraction (DAE).
This is a feature that older drives used to be
incapable of supporting but is incorporat-
ed into all CD-ROM drives available today.
Interestingly, this is also a feature that
proves to be very well implemented
in some drives and poorly implemented in
others; although the data transfer might
be fast in one, it could have very poor
DAE speeds.

The drive that gave good results in this
test was undoubtedly the 52x Acer
CD652P, which logged a blazing 16.94
seconds to rip the middle track—com-
pared to the 43 seconds taken by the
ASUS S520 drive.

Another drive that also performed

Owarzll szorss {top five CO-Roms)
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very well in this test was the Plextor PX-
40Tsi, taking just 27.03 seconds to rip the
innermost track (72.84 MB in size) of the
audio CD, making it almost twice as fast
as the slowest performing drive in this
test. Surprisingly, we
found that the drive
which excelled in data

Mao: 40
Azsarian Sles |5ecd transfer—the ASUS
I 3057 S520G 52x—per-
D or.ne formed slowest in this
N 7.0 test, taking a leisurely
R 2.2 73.68 seconds to rip
I the innermost track.

This was almost three
times more than the
fastest drive.

The Samsung SC-152 also performed
very well in this test, with very good
results in spite of not having performed
too well in the earlier data transfer tests.

So, if you are into converting music
on CDs into MP3s or extracting from
audio CDs, the best drive for you is the
Acer CD652P 52x, which logged exem-
plary results in this test. Do keep in
mind, however, that good performance
in DAE and high data transfer perform-
ance cannot be directly co-related; there
are drives that deliver very good data
transfer performance, but lag in DAE
performance.

Working with files

Simply put, this is a set of tests that
involves copying different file types from
the CD-ROM to the hard disk. This is a
very practical indication of the speed of
the CD-ROM drive.

The drive that emerged the
winner while copying a sin-
gle 100 MB file was
Krypton 52x, which
surprisingly out-
performed all
other drives in
spite of deliver-
ing very average
performance in the
synthetic tests. This drive
took only 26.19 seconds
to copy the 100 MB test
file to the hard drive. The
scores in the synthetic
tests for this drive were
not among the highest, but as seen, it did
very well in the real-world test. The run-
ner-up in this test was the 52x LG CED
8120B, which took 27.58 seconds to copy
the file to the hard drive.

In the assorted file copy test, where an

in most tests

Acer CD 652P: this drive
gave above average results

CLV vs CAV

CLV (Constant Linear Velocity) is the
method used to access data in almost
all CD-ROM drives available in the mar-
ket today. In this method the variable
speed motor is used to spin the disc.
The reason for this is that while reading
the data available on the innermost
track, whose circumference is smaller,
the speed at which the disk spins has
to be higher. On the other hand, when
the head is reading the data from the
outermost track, the rotational speed
(rotation per minute or rpm) of the
drive is much slower. This change in the
rotational speed ensures the constant
flow of data.

CAV (Constant Angular Velocity) on
the other hand follows a different
method of reading the data. Here the
rpm of the motor spinning the media
remains constant, regardless of where
the data is stored on the media. This
makes the drive using this method
slower than the drive using the CLV
method. The advantage of this method
is that it's simple to design and produce
the drive because the speed of the
motor is constant and latency time
(time wasted while the drive changes
its rpm) is eliminated.

assortment of 10 files totalling 100 MB was
transferred to the hard disk from the CD
drive, the Krypton 52x clocked 22.21 sec-
onds to complete the task. The slowest
drive here turned out to

be the Samsung SC-

152, which took

40.13 seconds to

copy the 100 MB file
and 34.57 seconds to
copy the assorted files.
The most attractive part
& about this drive is its economi-

8 cal price tag. The runner up in
this test was the 50x ASUS
CD-S500, which delivered
results that were just a shade
below the Krypton drive.

The next real-world test
that we ran involved opening
an assortment of 10 TIFF images in Pho-
toshop 6.0 from the CD-ROM drive.
Since many Web designers, photogra-
phers and art professionals extensively
use CDs to store backups of images, this
test was intended to be indicative of the

"
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drive’s performance with such applications.

Here the 52x ASUS CD-S520G drive fared well, logging 30.12
seconds to open the images, making it 23 seconds faster than the
slowest drive in this test. The second in this test was the 52x
Krypton, which trailed very slightly, taking 34.28 seconds to open
the images from the CD.

The drive that took the most time to complete this test was
the 52x Samsung SC-152, taking a slow 53.56 seconds to open all
the TIFF images.

In summary, we see that the real world performance of
these drives is often different from the synthetic or ‘ideal-con-
ditions’ performance. If you work extensively with applica-
tions where you need to copy and read files from the CD-ROM
drive, then the best choice in this category would be the Kryp-
ton 52x drive as it showed exemplary performance in the file
transfer as well as the Photoshop tests and is also priced quite
competitively. The runner up in this category was the 52x
ASUS CD-S520.

CONCLUSION
The performance of a CD drive is not just a function of the
maximum speed it can reach in synthetic tests but also in real
world performance tests and in its ability to support new fea-
tures and formats.

The 50x ASUS S500/G drive proved to the best performer in
these tests, having logged a very impressive set of results and
was a good blend of performance in the real-world and low-
level data transfer tests. In fact, despite being a 50x drive it post-
ed results that were a shade ahead of even some of the 52x
drives. It was, however, among the more expensive drives in the
comparison.

The 56x Acer CD 656P bagged the Best Value award.

This drive posted good data transfer speeds and
proved to be an exceptional performer, especially for
audio ripping related
applications. Its per-
formance was just a
shade below that of
the winning CD drive
and it was quite eco-
nomically priced. No
other 52x drive came
close to this one in
terms of price for the
given level of per-
formance.

Even though CD-
ROM drives are at
threat due to the
aggressive  pricing
and speeds of DVD
drives, they still prove
to be worthy per-
formers and it seems
that the continually
falling prices of these

i drives will ensure
. e that the CD-ROM
o standard sticks
around for some
ASUS S500/G: it blazes ahead time to come. !
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IN TEST: 5 PAGE LAYOUT SOFTWARE

The visual element is
the single most
important thing
when it comes to
presenting
information. Ergo
design

122 EEERY

DIGITAL MEDIA RESEARCH AND TEST CENTRE

n the print medium, design comes in two

flavours: imaging and page layout. Page lay-

out software is essentially the tool that allows

a designer to format the images and written
information and place them to fit in whatever
format they are meant for—from a newspaper to
a magazine. Sounds quite like what your MS
Word does for you, doesn’t it?

Word processors are good for routine work
but when it comes to professional publishing
they simply don’t offer enough flexibility
to handle multiple objects besides other

functions involved in designing a magazine or
a newspaper. It becomes essential for one to
use page layout tools that allow one to handle
text as well as multiple graphics elements. This
is done by giving the user the flexibility to
design everything from simple letterheads,
posters and cards to publishing magazines and
even newspapers.

Unlike other software, the market does not
boast a wide variety of professional page layout
software. Adobe has a range of three different
types of software which in itself kill each other
on basis of their functions. QuarkXPress had
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received a tremendous response when it was
launched in the late 1990s and continues to be
popular with many publishing houses.

In this comparison test, we included only
those DTP software that had the functionality
of layers, text wrapping, frames, masking, etc.
Corel Ventura has been a favourite with many,
but we weren’t able to include it in our com-
parison test because it was unavailable.

SOFTWARE SPEAK

Interface

A reasonably appealing look and feel of the inter-
face adds to the tool’s intuitive feel. Software
developers conveniently ignore this factor and as

a result what one gets is an extremely function-
al product with an extremely dull interface.
Shortcuts allow for easy access to commonly
used features from the keyboard. A good soft-
ware will not only have the facility of providing
this feature, but also the capability of customis-
ing shortcuts. If a user wants a particular short-
cut through a particular set of keys, he should be
able to do so.

Toolbars are perhaps the most commonly
accessed element in a page layout software. The
toolbar should have the common set of tools so
that the user does not have to access the menu
each time to use the feature. Software developers
have started placing the extra functions of a par-
ticular tool in the toolbar, but in a hidden mode,
which can only be accessed when it is double-
clicked. Users will be more appreciative of the
floating toolbar as it gives them the flexibility of
dragging and dropping.

A common problem with professional soft-
ware available today is too many choices. Users
are often stuck with features they can't use.
Therefore, it is important for a software to
explain the basic operations through adequate
help and documentation and give in-depth
examples, information which would really be
helpful to new users.

In spite of the release of the new PageMak-
er, the Adobe developers seem to not have
taken many pains to improve the interface. It
looks no different from its previous version
with the exception of a quick access toolbar
under the menu bar, which can be called a nice
addition. QuarkXPress has a simple but not
appealing interface like Adobe InDesign. It too
features a floating toolbar with a common set
of tools like frames, Bezier, selection, type and
drawing tools.

Microsoft Publisher’s interface might not
appeal to a professional user. It too has a floating
tool palette that, by default, is stuck on the left-
hand side of the software. You will not have to
manually pick and drag the bar and place it
wherever you need it. A wizard panel also
appears on the left-hand side but it gives the
impression of the screen being too cramped. You
can hide it though.

Adobe Frame Maker’s interface is shocking; it
is difficult to believe that Adobe has developed
this software. This has a highly unintuitive inter-
face and the toolbar looks very dull indeed. One
wonders why this is so after the proven brilliance
of other Adobe products such as Photoshop,
Ilustrator, etc.

InDesign, with an interface similar to that of
Adobe Illustrator, possesses a common set of tools
like the gradient, free transform, text, drawing,
eyedropper, etc, which make it a pleasure to work
with this software. Both Adobe InDesign and
Frame Maker boast a good set of help files which
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TEST PROCESS

We used a 433 Celeron machine with 192 MB RAM running Windows 2000 as a test
bench. We believe Windows 2000/NT is a far more stable OS because of better memory
and disk handling, which is a necessity for page layout tools, as they work with large

images and other such data.

We tested the page layout software for the following features:

® Memory and hard disk usage

m Features (auto flow, text editing capabilities, creation of tables, various colour modes

supported, image editing capabilities)

m Design elements (paragraph style sheets, character style sheets, images, text flow, col-
umn guides, frames, layers, masking, text on path, gradient)

m Miscellaneous features (Dictionary, spell check, wizards, templates)

m Ease of use (look and feel, shortcuts, toolbars, help and documentation, tutorials)

Extremely intutive interface of InDesign

explain all the fundamental operations of
the software but what they (and also Quark)
lack is the look and presentation style which
is Adobe PageMaker’s forte.

Features

A page layout professional expects certain
features—on-the-fly text editing and
image editing capabilities, automatic flow
of text from one page to another, and the
ability to export to different colour modes
for pre-press use—to be present in the
software. We've emphasised these features
and closely examined how the software has
bundled them.

Professionals dealing with huge
amounts of text find it extremely tedious
to manually add and place text on every
page. If the software facilitates automatic
adding of text, it would make their work
much easier. Yet, sometimes when the text
has to be flown from one column to anoth-
er, the user should have the option of flow-
ing text manually.

Adobe PageMaker and InDesign do
have the auto flow feature but one will
have to first manually add pages, whereas
if one is using QuarkXPress, the pages get
added automatically. With Publisher it
prompts the user to use the auto flow fea-
ture and then automatically places the text
by adding the pages. Like Quark, Frame
Maker automatically puts the text to
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another page and does not require the user
to add one manually.

At some point of time everybody
includes tables in their work. However, it
is rare to find a page layout software with
a separate program for creating tables.
One normally has to create a table in
Office suite programs like Excel and place
it in the page layout program. The prob-
lem here is that the data gets imported
without the horizontal and vertical lines.
These lines would then need to be drawn
manually. Hence it would be better if
the software provides the facility of mak-
ing tables.

Adobe PageMaker does provide the
user with a separate program to generate
tables but unfortunately one cannot
directly import them into PageMaker so
one will have to place it as an OLE object.
Publisher and Frame Maker have the capa-
bility of allowing users to create tables in
the software itself but InDesign and Quark
do not have this capability. Hence one will
have to create tables in a different program
and then import them here.

Who does not make mistakes, especial-
ly when it comes to typing? Wouldn't it be
better if the software provides some easy
and quick way of editing the content?
Some software enable you to edit text by
providing a separate text editor programs
whereas others provide on-screen text
editing.

Except for Adobe PageMaker, which
allows the user the option of editing the
text on-screen or editing it in a separate
window by selecting Edit Story, the others
only allow one to edit the text on-screen.

Though one wouldn’t normally use a
page layout software for editing images, it
would be of great help if the software pro-
vided the basic facilities of cropping, rotat-
ing and transforming the size of the image
as one often finds the need to make some

Adobe PageMaker Provides a Story Editor
to edit text

adjustments to the images while placing
elements within the layout of the page. If
the software has this capability then it
eliminates the need of going back to the
image editing software to perform basic
editing.

Microsoft Publisher, InDesign, Quark
and Frame Maker provide one with basic
elements such as rotating, cropping and
scaling images, but Adobe PageMaker is
particularly impressive because in addition
to basic editing capabilities, it also lets the
user add Photoshop filter effects. Howev-
er, these can be added to only TIFF
(Tagged Information File Format) images.

Design elements

There are certain design elements which
layout professionals m2ake use of such as
frames, manipulation of layers, masking,
column guides, text on path, paragraph
and character styles, etc.

Layers: If digital imaging artists can work
with layers, then why not page layout pro-
fessionals? Most software developers have
taken this point in consideration and
infused functionality into professional
page layout software. With the help of
multiple layers one can create and edit spe-
cific areas in work without disturbing the
rest of the areas. For example, if you've
placed your text on a specific layer and
your images on another, you can tem-
porarily hide the image layer to make
proofreading easier.

Only Adobe PageMaker and InDesign
provide this functionality wherein one can
place different objects on different layers.
The layers can be hidden and even locked.
Frames: This element helps in laying out
content as it can hold content together
(text as well as graphics) and serve the pur-
pose of a placeholder too. Newspapers and
magazines use this element as it gives the
basic layout structure of the content and
one can place empty frames to make it eas-
ier to fit in data at a later stage.

Frame Maker, Publisher and InDesign
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Ever wondered if you really need to use
these expensive page layout software
packages?

The newest versions of Microsoft Word
and Photoshop are quite proficient when
it comes to handling text and images and
most of us can churn out pretty decent
looking documents with them.

Even page layout professionals tend to
use these to lay out simpler brochures and
booklets. In the new release of Photoshop
one can easily design and create brochures,
pamphlets, visiting cards, memo’s and also
type in large amounts of text.

not only provide frames where one can
add graphics but also text frames for typ-
ing text. Unlike InDesign and Publisher
where one has to add text frames to start
typing, Frame Maker gives the user the
flexibility to type on-screen as well as in
text frames. PageMaker and Quark allow
the user to type directly without having to
place text frames.

Masking: This feature is already presentin

One of the things that Photoshop
does lack, however, is the ability to flow
text around the object, etc. Hence if you
want to really do something special with
your design you will require the addition-
al flexibility of a specialist page layout
tool. This is why professional designers
would eventually choose to import the
image objects into the page layout soft-
ware and flow the text and manipulate
elements there.

For most of us, Word is probably a
more logical choice since it allows one to
create basic layouts.

most animation and image editing soft-
ware and is seeing its place in page layout
software as well. Going back to the image
editing software just to mask objects is
boring and disrupts concentration. Now
one can easily mask, that is, hide, objects
by either placing them one over another
or by covering a part of the object with the
help of various shape tools so that only a
particular portion of that object is visible.

Word XP, a part of the recently
released Microsoft Office XP suite, allows
you to do everything from adding tables,
frames and columns to placing images,
creating table of contents, spell checking,
wrapping text around an object and
adding gradients and all of these can be
done on the fly.

The things that are required for profes-
sional publishing and are missing from
Word are support for CMYK, the ability
to type text along a randomly drawn
path, placement of graphics in frames,
masking, etc.

Frame Maker and Publisher have not
yet incorporated this feature so one will
have to take the trouble of going back to
the image editing software for masking
images. The remaining software do pro-
vide this feature.

Text on path: Advertisements in news-
papers where the text flows throughout the
page are common. If you thinkit’s difficult
to place the text in such as a way, you'd be
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surprised. It can be done quite easily by
drawing a path with the help of the pen or
pencil tool (depends on what the software

Layers and Gradient effects in InDesign

provides) and typing the text on to it as
one would normally do. It is the software
which does the trick by allowing text to

flow on a particularly drawn path. A page
layout software should possess this impor-
tant feature.

The new release of Adobe PageMaker
tested here does not incorporate this feature.
The developers at Adobe don’t seem to be
interested in developing this software, and
are giving more importance to InDesign
which does possess this feature. Unlike Pub-
lisher and Frame Maker, Quark and InDe-
sign include this feature thereby giving the
user the flexibility to type text on paths.
Gradient: It is a blend between two or
more colours or tints of the same colour.
Why would anybody want this element on
a page layout software? This is primarily
used by designers in generating two-tone
effects in text and also in filling up drawn
objects. One disadvantage here is that the
colours are converted to CMYK mode

QuarkXPress provides on-screen display of
linking of various pages

while printing, which raises the possibili-
ty of them appearing dull or shifted.
Hence, most designers use this feature in
CMYK mode.

InDesign, Quark and Publisher allow
one to add gradients to objects but Pub-
lisher does not allow one to add it to text.

!!!!! The Page Layout Software at a Glance

Adobe Frame Maker Adobe InDesign 1.5.2 Adobe PageMaker 7.0 | Microsoft Publisher QuarkXPpress 4.1
+SGML 6.0 2000
Company Tricom International Adobe Systems India Adobe Systems India Trifin Technologies Quark India Pvt Ltd
Pvt Ltd Pvt Ltd
Phone Numbers 022-8942461 0118-4532026 0118-4532026 011-6236061 0172-254412
Fax Numbers 022-8930504 0118-4532010 0118-4532010 011-6436447 0172-254414
E-mail Address tricom@vsnl.com sandeepm@adobe.com sandeepm@adobe.com ' trifin@vsnl.com gprakash@quarkindia.c
Web site www.tricommutimedia. ~ www.adobe.com www.adobe.com om
com www.quarkindia.com
Price (Rs) 90,000 42,946 26,500 4,500 34,000
Hard Disk Space 95 MB 50.6 MB 172 MB 60 MB 22 MB
Memory Usage 16.4 MB 22 MB 31.2 MB 7.6 MB 8.4 MB
Features
Autoflow Yes Yes Yes Yes Yes
Text Editing Capabilities Yes Yes Yes Yes Yes
Creation of Tables Yes No Yes Yes No
Various Colour Modes CMYK, RGB, HLS CMYK, RGB, LAB CMYK, RGB, HLS CMYK, RGB CMYK, RGB
Supported
Image Editing Yes Yes Yes Yes Yes
Capabilities
Design Elements
Paragraph Style Sheets  Yes Yes Yes No Yes
Character Style Sheets  Yes Yes No Yes Yes
Importing Images Yes Yes Yes Yes Yes
Column Guides Yes Yes Yes Yes Yes
Frames Yes Yes Yes Yes Yes
Layers No Yes Yes No No
Masking No Yes Yes No Yes
Text on Path No Yes No No Yes
Gradient No Yes No Yes Yes
Miscellaneous Features
Dictionary Yes Yes Yes Yes Yes
Spell Check Yes Yes Yes Yes Yes
Wizards No No No Yes No
Templates Yes No Yes Yes No
Ratings B- A- B B B+
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Frame Maker and PageMaker are yet to
incorporate this feature.
Styles: Who would want to take the trou-
ble of formatting all the paragraphs in one
particular style? With paragraph style
sheets, one can load the predefined set of
styles already provided by the software or
save their own styles in case they are going
to be used again. Professionals actually use
this function to a great extent—all it needs
is a click to format paragraphs by select-
ing the appropriate style. Similar to para-
graph style sheets, character style sheets
allow one to have a particular style of for-
matting attributes that can be applied to a
selection of text. Thus, for example, for
logos or for headlines, you can save such
character styles once and then apply them
wherever required by a single click.
PageMaker and Publisher are disap-
pointing when it comes to styles—Page-
Maker provides for only character style
sheets and Publisher provides only para-
graph style sheets.
Importing text: One usually uses some
office program or the other to make text
documents and spreadsheets. Hence, if
one wishes to import data into a page lay-
out program, it should appear exactly the

PostScript Files

While working with page layout software,
one often faces problems when sending
the final documents to get printed at the
press. One usually gets ‘font missing’ errors
because the font used while designing the
document may not be installed at the
printer’s end. To work around this, copy
the fonts along with the documents so
that they can be installed before the docu-
ment is finally printed.

In 1985, Adobe developed PostScript
which became an industry standard for
printing and imaging. PostScript is basi-
cally a programming language which
describes the appearance of the page
containing text and graphics to the output
device (colour or a black and white print-
er or any other output device).

To eliminate font-related problems,
you can save your documents as Post-

way it was formatted—if one were to
reformat the text after it’s been imported
into the page layout software, it would just
be an unnecessary duplication of work.

Script files. This will save you from worry-
ing about which platform or version of
system software the service provider has.

PostScript files contain all the fonts
used in the document so the fonts will
appear correctly even if the output device
does not have them. Files saved in the
PostScript format can even be sent over
the Internet to the service provider. How-
ever, the large file sizes associated with
PostScript files deter many from sending
documents over the Net, especially in India
where bandwidth is a major problem.

To reduce the file size one can,
depending on the settings provided by
the software, omit images (which are
usually saved in TIFF format) from the
document. These TIFF images can be sent
separately and incorporated into the Post-
Script file before printing.

Adobe PageMaker shines here as it can
retain the formatting while importing
text, though it does lose the font size. InDe-
sign also does a good job of importing text
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but strangely enough, it retains the font of
the header but not of the remaining text.
QuarkXPress was quite bad in this regard—
it doesn’t import text if it is saved in the
default MS Word format. You can import
text only in RTF format, but all the format-
ting gets lost. Like PageMaker, Adobe Frame
Maker, InDesign and Microsoft Publisher
maintain the text formatting.

PageMaker and InDesign do an excel-
lent job of importing data as it is from MS
Excel. Quark again disappoints here.
Frame Maker does import the Excel sheet
but only if it is saved in version 5.0. How-
ever, what you get is a hotch potch of data
which you then have to adjust manually as
the flow of the data is lost upon importing.

Miscellaneous features

If a page layout software has features such
as spell checker, wizards and templates, it
is a bonus as they add to the software’s
functionality.

u e |

MS Publisher 2000 provides wizards and
templates for ease of use

Spell checker: Spelling mistakes are com-
mon. After laying out the text, we normal-
ly run the spell checker to see if any
typographical errors are present. The spell
checker should be able to detect not only
the spelling mistakes but also the duplicate

words. It can get pretty irritating if it keeps
on ignoring proper nouns. The software
should allow users to manually add names
and not show it as an error the next time
you run the spell check.

All the software that we tested had this
feature and all were equally good.
Wizards: There are many software which
provide wizards (step by step guidance) to
create predefined documents. This makes
the job easier and much faster than the
manual process.

Except for Microsoft Publisher 2000,
none of the software have wizards for gen-
erating documents. Publisher offers an
extensive list of publications such as
brochures, catalogues, greeting cards, etc
that can be created very easily even by a
novice with the help of wizards.
Templates: A template is a predefined
design page which can be used as standard
document as it contains a set of graphics
and text in predefined layout. This feature
is commonly use by newspapers and
monthly publications where the template
can consist of text, graphics, layout, place-
holders, rulers, grid, etc. Software like
Adobe’s PageMaker now come bundled
with sufficient templates to make things
easier for the user.

PageMaker, Microsoft Publisher and
Frame Maker provide an extensive list of
templates which one can use for his work
or rework on them to suit his need. InDe-
sign and Quark haven’'t implemented this
feature yet.

CONCLUSION

Even though PageMaker and QuarkXPress
have been the all-time favourites, this time
the equation changes a bit. Quark hasn’t
come out with a new version for quite a
long time. Even though QuarkXPress 5 is

reportedly nearing completion, the retail
version available in the market as of now is
still 4.1.

Even with PageMaker, the new version
fails to impress as the interface and fea-
tures haven’t changed much. Quark is fea-
ture rich, but lacks proper importing
capabilities. Microsoft’s Pub-
lisher 2000 offers a simple
and easy-to-use solution
for those  not-so- -
design-inclined who
want nothing but basic
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Adobe InDesign 1.5: the most functional
and versatile page layout software

design templates to make simple docu-
ments such as letterheads, business cards
and memos.

What really toppled the top ranks was
Adobe’s InDesign, which, with its easy-to-
use interface and a boatload of features
overtook all the oldies. It has an extreme-
ly functional interface that rivals that of
Photoshop. Adobe came out with this ver-
sion a couple of months back, and a new
2.0 version has already been announced on
Adobe’s Web site. As of now, InDesign
stands way ahead of all other page layout
software in terms of user friendliness,
features and usability.fil
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Notes for an Audiophile

A look into the world
of audio formats and
what’s happening

130 FER

PRASHANT MASRANI
udio formats have evolved since the early
days of blips, beeps and first-generation
PCM audio. It was the WAV format, which
finally allowed users to experience CD-qual-
ity audio on their PCs. Though audio reproduc-
tion was remarkable, file sizes of WAV audio clips
were huge. A single minute of CD-quality audio
occupied approximately 10 MB of space. As an
uncompressed audio format, WAV files are diffi-
cult to share and transport across computers.
The need to bring down the size of audio files
was felt and development began on a format,
which not only accomplished smaller audio file
sizes, but also maintained as much audio integri-
ty as possible. Fraunhofer started it all with their
revolutionary MP3 format. With MP3, audio
clips were cut down in size, in most cases, by a
factor of 10 to 14, while maintaining audio qual-
ity to a great extent. Though audiophiles may not
swear by the MP3 standard, most casual listeners

won't be able to tell the difference in audio qual-
ity between MP3 audio and CD audio.

How MP3 works

An MP3 file consists of a number of individual
frames. Each frame contains a certain amount of
song data and when grouped together, they make
up the entire track. In order for these small seg-
ments of data to exist, a particular song must be
encoded first. The bit rate chosen will directly
reflect upon the output file’s size and audio qual-
ity. Essentially, bit rate is a measurement (in bits
per second) of how much compressed audio data
flows per second. Higher bit rates yield higher
quality sounding music as opposed to lower bit
rates. The lower the bit rate, the less space the
file occupies.

A CD contains data, which is digitally stored
in an uncompressed, high-resolution manner.
Music is sampled 44,100 times per second and
each sample is 16 bits long. Separate samples are
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MP3PRO is made up of a combination of standard MP3 files supplemented with reconstructed high frequencies using SBR.

taken for the left and right audio channels. If we
do the math, we get:

44,100 samples per second x 16 bits per sam-
ple x 2 channels = 1,411,200 bits per second or
176,000 bytes per second

So a typical one-minute segment of CD audio
occupies around 1MB of data. What MP3 does is
reduce the number of bytes of a song while
maintaining a high standard of audio quality. In
order to accomplish this, the MP3 format uses a
compression technique known as perceptual
noise shaping or ‘psychoacoustics.

The principle behind perceptual noise shap-
ing is based upon the characteristics of the
human ear. For instance, the human ear is sensi-
tive only to frequencies in the range of 20 Hz to
20,000 Hz. Anything below or above this range
cannot be heard. Also, there are certain sounds
that the human ear can hear much better than
others. Furthermore, if two sounds of different
amplitudes (volume levels) are being played
simultaneously, the human ear has a natural ten-
dency to pick up on the louder sound and focus

less upon the softer one. Using these principles,
MP3 encoding will only include those frequen-
cies, which the human ear ‘prefers’ and excludes
certain parts of the song without significantly
deteriorating sound quality.

With this algorithm of song compression, the
resulting MP3 file is only one-tenth to one-
fourth the size of the original song, giving it
tremendous portability. What you have left after
encoding is a ‘near CD quality’ song as the MP3
version of the song does not sound exactly like
the original since some parts have been removed.
For all practical purposes, the output is very
close. Due to the fact that the MP3 encoding
process eliminates some data from the original
song, this type of compression is known as ‘lossy
compression’.

The MP3 format also supports Variable Bit
Rate, or VBR for short. As mentioned earlier,
MP3 files consist of hundreds of smaller chunks
called frames. When encoding a VBR file, the
encoder decides the bit rate for a particular
frame. A frame’s bit rate can drop down by 32

A Question of St@NdaRDS

Lossy Compression

When audio is compressed,
it usually doesn’t mean the
compression of the audio
itself. What really happens is
known as lossy compres-
sion. Lossy compression is
usually used in audio, video
and image files where cer-
tain details can’t be seen or
heard by the human senses
and thus those areas are not
included in the compressed
file itself. Every human has a
hearing range, which means
that he or she can hear only
a particular range of sounds.
In MP3 compression or
most audio format compres-
sions, the frequencies that
cannot be heard are elimi-
nated from the particular
song. However, a good
audio compression method
will give the most accurate
results by getting most fre-
quencies encoded within
the song, giving quality of
sound and also giving small
file sizes.

Sony, Liquid, Dolby. Three companies with
three standards—AC3, ATRAC3, and LQT.
Which is the best?

AC3: Audio Code number 3 is a sound
compression standard that has been creat-
ed by Dolby. In most audio formats, stereo
sound is the standard. However, in AC3, the
aim is to deliver five speaker streams and
also a bass channel, which is overall denot-
ed as 5.1 surround sound. This standard is
usually found in cinemas and theatres. AC3
encoding allows sound from the frequency
of 3 Hz to 20 kHz to play on the system,
which is quite over the sounds that a
human can hear. The bass that is produced
is between the frequency ranges of 3 Hz to
120 Hz only. The bit rate at which the audio
is played at is 640 kbps, which is much
over most audio formats today like MP3,
WMA, etc, but here quality and not the

media size is the main priority. Recently,
with the introduction of DVD, compression
and storage of surround sound is now pos-
sible. This enables users to listen to Dolby
Digit surround sound at home.

Sony ATRAC3: Sony was the first company
to introduce portable music with the unfor-
gettable Walkman. Then came the Memory
Stick Walkman, which was like a pen and
stored songs on the memory. Sony has
been using its own formats; there were two
main technologies used—ATRAC and Magic
Gate Memory. Later, a software called
OpenMG was introduced which would con-
vert the normal MP3 to the Sony format,
ATRAC3, before copying it to the memaory.
However, the public wasn't quite happy
with the conversion of formats.

Liquid Audio’s LQT: Liquid Audio SP3 is
the latest of all the formats available, and it

has been created with security of the media
as the chief priority. Liquid Audio SP3 is also
known as Liquid Audio Secure Player Plat-
form. The Web site and company offer
firmware updates for any later version.
Claims have been made that Liquid Audio
with its technology will be able to protect
the copyrights of the artists. There are huge
archives and online stores available for the
format where people can use carts and
select songs from the Internet through the
authorised sites. Currently, Liquid Audio has
device partners such as Palm, Sony, and
Toshiba, to name just a few. There is also a
software player which is available for down-
load from the Liquid Audio site itself. The
free version and the Pro version of the play-
er allow you to write CDs and import music
at high quality. Liquid Audio is also said to
use AC3 Dolby digital Codec for its audio.
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Advanced Audio
Coding

WMA and RealAudio 8 may
have the advantage over
MP3: Their files are half the
size at CD-quality rates.
However, a newer standard
called Advanced Audio Cod-
ing (AAC) may give them a
run for their money. AAC
was co-developed by the
Fraunhofer IIS-A, Dolby, and
AT&T, and it is part of the
MPEG-2 specification. AAC’s
algorithm is different from
MP3'’s, and AAC incorpo-
rates additional features that
boost the efficiency of
encoding. Basically, AAC
delivers better-quality audio
with 30 per cent less data
than MP3. AAC is widely
known to be the best when
it comes to audio compres-
sion, and a number of desk-
top players, like the new
MusicMatch Jukebox 6.0,
are beginning to incorporate
it into the suite of codecs
they support. As of today,
there are no portable play-
ers that support AAC, but
with its upgradable
firmware, it may just be

a matter of time before
AAC becomes as common
as MP3.
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kbps to a lower value whenever possible (if there
is not much audio going on) and can accelerate
the bit rate by 32 kbps as and when required.
Essentially, VBR is used to provide for an effi-
cient compromise between file size and audio
quality. Whenever a silent period is encountered
during a track, the bit rate can be decreased, thus
conserving on the size of that particular seg-
ment. Whenever higher quality is in need, the bit
rate can increase giving a fuller, more accurate
reproduction of the original track, but at the sac-
rifice of space.

The problem encountered with VBR is that
as the bit rate is constantly changing from one
segment to another, several players have a prob-
lem in determining correct track length. Though
a standard exists where track length is recorded
into the first segment of an MP3 file, not all
encoders can do this.

A negative point from the perspective of the
recording industry with the MP3 format is that
there are no security features that have been
included in the format—it is free for everyone
to pirate and share. As for the licensing part of
MP3, a company needs to pay $3.75 for each
device capable of playing back the MP3 format.

Emerging standards
Though the MP3 format does a satisfactory job
in compressing song data and maintaining a high
standard of audio quality, recent advents in tech-
nology permit even further compression of song
data. Thompson Technologies, the co-creators of
the MP3 format along with the Fraunhofer Insti-
tute, have teamed up with Coding Technologies to
produce the next-generation MP3 format called
MP3Pro. MP3Pro operates in a similar fashion to
the MP3 Codec with a few enhancements. A codec
is analogous to a device driver in that it allows
playback of a particular audio format using spec-
ified parameters. MP3Pro is completely backward
compatible with the original MP3 standard but
you will not reap the full benefits of this codec
unless the suitable codec or plugin is installed on
the computer.

In MP3Pro, the encoder splits up the encod-
ing into two main parts: the low frequency range

Wershle

Lessless

and the high frequency range. The low frequen-
cy range consists of signals below 10 KHz while
the high frequency range lies above 10 KHz. This
technique proves to be a more efficient way of
encoding sound into MP3Pro format and also
contributes to increasing overall sound quality.

One problem encountered with the MP3 for-
mat is that at low bit rates, MP3 files run out of
bits to compress the music in full audio band-
width. That is why at bit rates of around 48 kbps
to 64 kbps, MP3 music begins to sound dull as it
lacks a good deal of high frequency signals. At
64 kbps, MP3 can either produce an audio band-
width of approximately 10 KHz or introduce
coding artifacts. Coding artifacts are used to
compensate for the shortage of bits while sam-
pling at low bit rates in order to attempt to rep-
resent the complete audio bandwidth.

MP3Pro is a result of combining two com-
ponents: MP3 and Spectral Band Replication, or
SBR. SBR is a new coding technology which
offers FM-quality audio (15 KHz) by increasing
audio bandwidth of a standard MP3 sample.

SBRis a new method used in conjunction with
the MP3 format to reproduce high frequencies in
low bit rate encoded audio files. When used with
SBR, the underlying MP3 encoder is responsible
for transmitting frequencies below 10 KHz while
SBR reconstructs all frequencies above the 10 KHz
range. This is a process which occurs during play-
back of the MP3Pro file. First, the MP3 decoder
processes the file (and frequencies below 10 KHz),
then it transmits the decoded portion to SBR for
analysis and high frequency enhancement of the
decoded portion. In effect, the SBR accurately
represents the original music before the encod-
ing process began. This reconstruction is not
only accurate in the frequency domain, but in
the time domain as well. The end result is full
bandwidth audio decoding at low data rates and
increased compression efficiency.

The free version of MP3Pro supports a 64
kbps bit rate and a maximum sampling rate of
44.1 KHz. The official full version of the codec
will allow a 96 kbps bit rate, which easily rivals
standard MP3 files encoded at 128 kbps in terms
of audio reproduction. Like MP3, MP3Pro does

MP3 compression is done over a finite number of steps. In the first stage, audio
is simultaneously passed through the psychoacoustic stage and a filter bank
which splits up the sound into subbands of frequency. In order to minimise noise
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track as output.

in the data stream, the signal then passes through a bit allocation stage. The final
phase of compression simply organises the data and creates an MP3 encoded
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not have any security features to prevent wide-
spread piracy of licensed music.

A completely free alternative

Let’s see what else you can really depend on
for storing and playing your collection of
songs. Ogg Vorbis could be just the thing for
you in case you want quality and, more impor-
tantly, you want it free for distribution. Ogg
Vorbis is open source code, patent free and
you don’t have to pay a penny for giving your
own songs to anyone. As of now, it is the only
audio format that does this.

Ogg Vorbis uses different mathematical
principles from MP3 in how it encodes its
music and plays it. The Ogg Vorbis Codec
works on the basis of VBR like MP3 but does it
more efficiently. In the standard MP3 format,
VBR allows for arise and decline of 32 kbps steps.
In Ogg Vorbis, the jump is of 1 kbps, which means
you get very accurate quality and file sizes are
strictly kept to a minimum. Though Ogg Vorbis
files themselves can be encoded between 8 kbps to
512 kbps, the current beta encoder supports 128,
160, 192, 256 and 350 kbps in mono or stereo.

Since streaming audio is a very important
application for these file formats in the future, any
successful format would need to include support
for them. This is natively supported within the
Ogg Vorbis Codec. Currently, the designers of Ogg
Vorbis are working with the makers of Icecast, an
open source streaming server which will allow
users to enjoy streaming audio.

Similar to what MP3’s ID3 tag offers, Ogg
Vorbis supports a proprietary comment header
system, which allows you to include various
information about the track such as title, artist,
song name, and so on.

Ogg Vorbis is patent free, open source and
thus can be distributed and used for personal
and commercial purposes. Similarly, codecs are
being developed for other operating systems like
Linux, BeOS, etc. Ogg Vorbis files can be played
back using Winamp and other supportive audio
players simply by using an Ogg Vorbis plug-in.

How can we forget Microsoft?

Microsoft likes doing things its own way. After
having taken over the operating system and
office suite market, they’ve set sights upon push-
ing their audio formats in a similar fashion with
their Windows Media Audio.

What you are about to get is Windows Media
Audio 8—Microsoft’s latest iteration of the
WMA standard and their idea of the perfect
competition to MP3Pro and Ogg Vorbis.

The format is similar to MP3Pro in terms of
size of the file. The bandwidth used is 48 kbps
for near CD-quality and 64 kbps for CD-quality
audio, similar to what MP3Pro offers. The for-
mat has been created for streaming of media

Lre

over 56 kbps dial-up connections to high-speed
DSL and cable modem connections.

One particular feature incorporated into
WNMA 8 that should appeal to the record industry
isatechnology called Digital Rights Management,
or DRM for short. DRM is an end-to-end solution
for encrypting and distributing digital content in
a secure manner on the Internet.

The Windows Media format is a compilation
of various components, which is called as a Win-
dows Media File Container. It contains WMA
and WMV using the codecs along with DRM
technology. Metadata is similar to MP3’s ID3 tag
as it contains information about the artist, song
name, etc. The format also has well integrated
voice recognition and text to speech capabilities
using Microsoft speech engine.

What’s your format?

So finally, which is the best format? If you're
looking at availability, MP3 is no doubt the most
happening audio format available. MP3Pro has
just started and the demo encoder/player does
not have support for encoding audio at full qual-
ity yet. For the time being, one will have to stick
to encoding at 64 kbps using MP3Pro.

Ogg Vorbis offers high quality audio, thanks
to the optimal VBR encoding and playing fea-
tures, but availability and widespread industry
support still remains a major problem. And
without security and encryption, it is difficult for
the record industry to adopt Ogg Vorbis as their
audio standard du jour. The latest version of the
Ogg Vorbis Codec, V1.0, will soon be available
and proper encoders and players should also be
available for the general public to adopt.

Microsoft is doing a splendid job with their
WMA 8 standard. With high compression, inte-
grated security features and streaming capability,
WMA 8 appears to have the most potential to be
the prominent audio standard in the future. At
the moment, while WMA is catching ground fast
with portable audio player makers’ support in
their devices, MP3 still remains the format of
choice for most device manufacturers and users. !
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Decoding ‘an MP3 starts with feeding the signal through bitstream unpacking where certain bits of informa-
tion regarding the decoding process are read and stored. The audio sample is broken down into chunks,
which pass through the Huffman decoder where many tables are used to look up actual values since these
bits of information are decoded. The decoder’s task is to then requantise the results and transform the sig-
nals into the time domain so that the resulting audio stream accurately represents the original sound.

What to look for in
a Protected Player

With audio standards chang-
ing the way they are today,
it would be best to scout for
a player that will support a
particular format in the
future. To ensure that your
digital audio player is
indeed future-proof, pur-
chase a unit equipped with
upgradable firmware. Be
sure you buy from a reputed
company, as the inclusion of
upgradable firmware does
not guarantee that the com-
pany will provide you with
an upgrade in the future.

Several memory-based
and MP3/CD players are
available that permit
firmware updates. Son-
icblue’s Rio players (500
and above) support MP3,
WMA and Audible formats. If
an MP3 CD player suits your
fancy, take a look at the AVC
Soul Player which has a very
good track record of provid-
ing constant firmware
updates through their Web
site.
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As the battle for CPU
supremacy wages on,
Intel and AMD fight
to promote their
proposals to rework
the innards of
computers
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here is no doubt about it. The escalation seen

in today’s CPU speeds is stunning. Hard

disks are buzzing along faster than ever and

the 3D technology that’s available today was
dismissed as fantasy a decade ago. However,
without due consideration, pushing barriers in
clock speeds, storage densities and fill-rates will
be in vain. Tomorrow’s devices are going to need
infrastructure suited for their requirements.
Without high-bandwidth protocols in place, the
new technology is virtually useless.

Long-time rivals, Intel and AMD have each
introduced blueprints of a new 1/0 bus—a suc-
cessor to the aging PC architecture, the PCI
bus—aimed at handling future bandwidth
requirements and which are scalable at the same
time. AMD’s HyperTransport and Intel-backed

3GIO (known as Arapahoe) each proposes to
change one of the most overlooked parts ina PC,
the 1/0 bus.

But before we discuss the technologies
involved in HyperTransport and 3GIO, let’s
rewind a little and see the limitations in the exist-
ing technology.

Beyond the confines of the PC
The components of a PC communicate by send-
ing and receiving data through an interconnect-
ed network of wires called buses. A bus is
essentially a high-speed conduit for digital infor-
mation to travel. Several types of buses exist and
each operate at a different speed and protocol,
depending upon the standard at which the bus
functions.

The PCI bus is responsible for transporting

November 2001



y i

|5 B

data from PCl-based peripherals to and from
the memory bus for further processing. This
general-purpose bus has been serving well as a
standard for over 10 years, hosting such devices
as soundcards, video cards and storage con-
trollers. Now PCI is facing a major strain with
bandwidth-hungry 1/O devices on the horizon.
Products used in applications such as video cap-
ture/editing and other bandwidth-intensive
applications need plenty of room to function. In
order to host a number of components such as
these, either the entire PCI bus would have to be
reworked or a new standard would have to be
built from the ground up.

A chipset, or core logic, is responsible for
directing the control and flow of data across bus
lines. Generally, it is divided into two distinct
chips, a north bridge and a south bridge. The
term ‘bridge’ comes from a reference to a device
that connects multiple buses together. The north
bridge connects to the CPU, the memory bus,
the AGP graphics bus and the south bridge.
The south bridge connects to the PCI, USB, ATA,
ISA, etc.

With current technology, the reservoir of
available bandwidth for these multiple buses is
quickly running out, leaving the industry no
other choice but to innovate new ways to replen-
ish the bandwidth pool.

The answers

One answer to bus bandwidth constraints is
HyperTransport, an AMD-led architecture
developed with the help of industry partners
such as Cisco, nVidia, Sun Microsystems and 168
other industry influences. HyperTransport is a
bi-directional (send and receive), high perform-
ance packets-based protocol for interconnecting
various components in a PC. Using packets sim-
ply means sending data in chunks (or packets)
and rearranging them to its original form later.
It was designed for applications such as net-
working, telecommunications and other uses
where scalability, high speeds and low latencies
are required while at the same time, remaining
compatible with legacy PC buses such as PClI,
ISA, USB, etc.

There are several immediate advantages of
HyperTransport. While developing specifica-
tions for the protocol, design engineers kept a
framework of goals in mind in order to improve
system performance. Higher bandwidth bus
links and reducing low latency responses across
bus points are two direct ways of achieving this.

Being 32-bits wide and running at a speed of
33 MHz, the PCI is restricted to a maximum
bandwidth of 133 MBps. HyperTransport offers
substantially larger bandwidth up to a maximum
of 12.8 GBps, a near 100-fold increase over exist-
ing technology.

Current PCI technology transfers data across

the bus at 133 MBps. PCI-X, an evolutionary
modification of the original PCI bus, runs along
at 1 GBps. HyperTransport ups the ante to a sig-
nificantly higher 12.8 GBps.

Off the bat, HyperTransport uses a flexible
bus architecture providing data links in various
widths. Depending on the application, bit
widths can either be 2, 4, 8, 16 or 32 bits. Each
bus line is capable of transferring data at a rate
of 400 MHz in each direction. Since Hyper-
Transport provides a dedicated line for both
sending and receiving data, effective through-
put is in the area of 800 MHz with a maximum
throughput that is over 96 times the bandwidth
of today’s PCI bus. In situations requiring dif-
ferent upstream and downstream speeds,
HyperTransport is fully capable of asymmetric
operation.

Optimising bus topology and reducing the
number of buses in a system not only stream-
lines data transfer processes, but also contributes
to lower voltage requirements and, therefore,
lower power consumption.

HyperTransport is not designed to eliminate
technologies such as USB and FireWire.
Instead, it was designed to complement them
by acting as an infrastructural backbone
between the devices themselves and the rest of
the system. The fact remains that HyperTrans-
port was designed to interconnect internal sys-
tem components and not directly connect to
external technologies. The point of using
HyperTransport is to provide the bandwidth
that FireWire and USB devices will need now
and in the future.

Unlike PCI, which is a shared bus and allows
multiple devices to be placed on the one bus,
HyperTransport only allows one device to be
placed on a bus. However, these busses can be
chained together to create a multi-device bus.

Latencies
Of course, the further devices are chained, the
higher latency there will be between a device at
the end of the chain and the processor. It
is important to design the system so that there
are at most around three to five elements in
the chain. The more a component is affected
by latency, the higher up the chain of buses it
has to go, otherwise, a bottle-
neck would be introduced.
HyperTransport’s theoretical

maximum of 12.8 GBps is 96 | Bus type

Computing at Light
Speed

US-based startup, Primarion,
is currently in the process of
developing optical fibers
which will serve as the next
medium for bus data trans-
fers. Once processors start
touching speeds in excess of
10 GHz, industry analysts
say that copper would have
reached the limit of its
bandwidth carrying capacity.
Optical links pose a number
of advantages over today's
current carrying materials
and promise that the dream
of video-on-demand and
peer-to-peer computing will
become a reality.

Advances in processor
technology have surpassed
the seemingly outdated lim-
its of Moore’s Law. As tran-
sistor counts continue to
skyrocket so does the
amount of voltage required
to power them. And high
amounts of power can do
funny things like causing
interference in bus signals
and lead to physical damage
of components.

Optical connections use
pulses of laser beams to
transmit data as opposed to
the electromagnetic princi-
ple used in today’s technol-
ogy. Using optics would not
only eliminate EMI (Electro-
magnetic Interference), but
would also dramatically
bring down power require-
ments.

Likeness in Disparity

HyperTransport 3GIO
Point-to-point  Point-to-point

times as fast as a 32-bit, 33 MHz  Protocol

Packet based Packet based

PCI bus, and 24 times faster | Maximum band- 1.6Gbits/sec  2.5Gbits/sec
than an expensive 64-bit, 66 |width per link

MHz PCI bus. However, the 12.8  "Multi-processor ~ Yes Yes

GBps link is likely to be used ' support

only in processor-north bridge | Outside-the-box No Yes

and north bridge-north bridge
configurations, and each pin-

configuration
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Licensing Scheme

Unlike direct licensing
schemes which require
annual payment and at
times royalties as well, the
HyperTransport licensing
strategy is comparatively
simplified. Those who want
to use the technology may
join the consortium for
$5,000 a year, and those
who also want to contribute
to the technology develop-
ment may join for $25,000 a
year. There are no royalties
or licensing fees beyond this
annual membership cost.

At the moment, licensing
information on 3GIO is not
available.

pair can carry 1.6 Gbps (200 MBps) of data.
Other HyperTransport implementations will be
using a slower but cheaper HyperTransport 10
system, at a speed of 800 Mbps (100 MBps) per
pin pair, which is just under the speed of a 32-bit
PCI.

HyperTransport is a differential bus. This
means that for each bit of the connection, two
wires (and therefore interface pins on a chip) are
required to carry the signal. Wire one carries the
signal and wire two carries the inverse of the sig-
nal. For each device residing on a bus, there
needs to be a corresponding number of pins.
This increases the pin count by quite a margin,
so many implementations of this technology will
use reduced bus widths to cut costs.

HyperTransport products

Products from AMD based upon the Hyper-
Transport protocol are expected to appear in
2002. HyperTransport has the potential to
replace most point-to-point busses in use in
computer systems today. This includes north
bridge-south bridge interconnects, the memory
bus, AGP, and the front-side-bus. AGP is cur-
rently limited to 4x speed, and 8x speed is not an
easy task. With nVidia licensing HyperTransport
for their own use, both within their chipsets and
between their chipsets and other components,
the appearance of a HyperTransport graphics
processor (GPU) is guaranteed.

This raises the interesting spectre of a sys-
tem without any AGP slots, and a lot more inte-
gration onto the motherboard. Now that
nVidia are into chipset design, they could very
well decide to drop AGP support and make the
GPU part of that chipset, connected using HT
to the north bridge at 1.6 GBps. The standard
specification would mean that any HT10 GPUs
that ATI or Matrox produced would also work
with this chipset, meaning more choice for the
consumer.

3GIO
Intel’s latest initiative to develop a standardised
bus transport comes in the form of third-gener-
ation 1/0, or 3GIO for short. Like HyperTrans-
port, 3GIO (code named Arapahoe) addresses
similar concerns of bandwidth, scalability and
flexibility in design.
3GIO is a point-to-point interconnect and
uses a packetised protocol structure. It trans-
ports data at high bandwidths, uses scalable bus
widths, exhibits low power consumption and is
hot-pluggable. It was designed for chip-level
interconnects, expansion card connections and
can act as an 1/0 bridge for other interconnects
such as USB 2.0, Infiniband, Ethernet, 1394, etc.
3GIO is capable of providing interlinks within
the chipset core but initial proposals state that
initial implementations will focus on the 1/0
devices and subsequently the AGP bus itself.
The specific workings of
3GIO differ somewhat from
HyperTransport. A funda-
mental 3GIO bus link uses

| AN Atk | two low-voltage pairs of sig-
Memory { Frocessm nals, one pair to transmit and
" the other to receive. Initial
i EVS Bus speeds between pairs is over
L TR aar 300 MBps and this is expect-
- L Wy b i i ed to increase to 1.25 GBps
; | DRaM || i :
CRU " [l Northbridge | =~ n?.r:ﬂﬁ.r e vaH,_,r._r:,mpm u (the physical limits for cop-
per interconnects). Once
% Shired i these limits are reached,
PGl Bus /- HWE”E;':;"D" i 3GIO has made provisions
| PR ; % it UsB for asmooth transition from
. Southbridge [-s—-| I0E | l copper to faster intercon-
Ethemat *L..: e ¢ i : ; _ nects using optical links.
Mossm | L0 5 Infinibesd o | 3GIO also brings forth a
] | ; PCL-X [ 1] GbE }0 Huh | . i
STl ALA | technique to allow itself to
| scsior s | . |

| {thes PLI Cards |

The north bridge of a chipset maintains control of data between the
processor, system memory and the video subsection of a computer,
whereas the south bridge serves as a central hub for traffic between
1/0 devices (called endpoints) and with the rest of the system bus.

.

power of PCs.

Data paths between a bridge and an endpoint are known as local
buses. A PC consists of several local buses and each has their own

bandwidth requirements and protocols.
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HyperTransport links are inserted at various points
within the system bus topology. Inserting
HyperTransport links boosts the speed-carrying

T connect to external high-
i speed devices such as hard

disks, optical drives and
video cameras. Furthermore,
3GIO can be used to tie
together different PC subsys-
tems that are housed in phys-
ically separated enclosures.
This in itself could be used to
completely redesign the
‘beige box’ existence of PCs
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today. As 3GIO uses hot-plugging capabilities,
devices can simply be added and removed with-
out opening the PC chassis and without power-
ing down the system first.

Intel is compatible with PCI at the software
layers, so if the software supports PCl, it auto-
matically supports 3GIO too. The initial speed
of a single channel or ‘lane’, which is comprised
of two differentially driven pair of wires (trans-
mit and receive), is 2.5 Gbps in each direction.
The lanes will supposedly scale to 10 gigabits per
pin and beyond in the future.

The PCI bus is parallel in nature. The dif-
ference between serial and parallel buses from
a motherboard designer’s standpoint is the
number of traces and routes needed between
the device and core logic. Parallel architectures
require a significantly higher amount of trace
points than serial designs and, thus, the number
of pins needed to correspond to these routes
goes up as well. Changes such as these not only
increase cost, but also cause a rise in signalling
problems due to electromagnetic interference.

A new type of controller introduced in third
generation 1/O architecture is the switch. A
switch essentially manages interconnections
streams of data and between attached devices. In
the case of the PCI bus, multiple devices share
the same pathway for data flow. With Hyper-
Transport and 3G10, each device receives a ded-
icated link from the device to the core logic. This
setup overcomes some of the problems faced by
PClI such as system resource conflicts and ineffi-
cient use of bandwidth. Since devices reside on
independent bus links, each link can be scalable
to a higher width if the need arises.

A key advantage that 3GIO holds over
HyperTransport is the focus on external
devices. Not only does 3GIO act as a point-to-
point link between chips, the standard is also
explicitly designed to link to external devices.
HyperTransport, on the other hand, is more
focused on connecting the internal devices
of a PC.

Current implementations of HyperTrans-
port, such as nVidia’s nForce, focus upon bus
links between the north and south bridges.
HyperTransport has no problem in performing
as a system-wide bus.

3GIO, like HyperTransport, can handle bus
connections across the system. Interestingly, the
Arapahoe group has opted in favour of posi-
tioning 3GIO as more of an expansion bus in the
immediate future. A more comprehensive sys-
tem-wide approach may be taken in the future.
However, at the moment, nothing has been
etched in stone.

Announced at the spring session of the Intel
Developer Forum, the Arapahoe architecture
was recently handed over to the PCI SIG (Spe-
cial Interest Group), the industry organisation

chartered to develop and manage the PCI stan-
dard, which will assume further governing
and development of 3GIO as a standard in
the future.

The last word
AMD and Intel are both aiming to solve the same
problem with similar constraints. Therefore, it is
not surprising for them to come up with similar
solutions. Between these two solutions, Hyper-
Transport appears to be a faster way to connect
devices today. Since it uses parallel bus architec-
ture, it should not be very difficult
to quickly implement with existing
technology. The biggest advantage
that HyperTransport has over
3GIO is that it is available now. In
fact, nVidia has already incorporat-
ed HyperTransport technology in
their upcoming nForce chipset.
Transmeta too has jumped onto the

.
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But before the AMD camp starts mddins | ]
cheering, here’s a pause for % T 3Gio

thought: 3GIO has been adopted by
the PCI SIG (Special Interest
Group), the influential standards
body which governs the currently
prevailing PCI bus standards. Con-
sidering how widespread the PCI
bus is and how comfortable com-
panies are with the group and the
PCI standard itself, its magic could
easily rub off on 3GIO.

Surprisingly, nothing is holding
back the two competing solutions to work
together. With HyperTransport at the chip level
and 3GIO linking external devices, a perfect
blend of complementary technologies would
result. This, however, will most likely not
happen.

Two overlapping standards raise indecision
for component makers, who must decide
whether to support one standard, the other,
or both.

In the end, Intel just might be a little too late
in getting to the market with 3G10. Technology
solutions based upon HyperTransport have
already been designed and implemented into sil-
icon, some of which are very close to being
released in the market.

Multiple lanes can be connected between devices,
chips, etc, and this almost seems like you'd be
constructing parallel interfaces again, but these
are independent serial channels. In fact, the physi-
cal layer of 3GIO supports x1, x2, x4, x8, x12, x16,
and x32 lane widths. A data stream would be
striped across the lanes as in the figure. There
must be some logic to split and reassemble the
streams, of course.
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More Info on

the hardware products tested.
Check out

Mindware

Not too hot

porting the Socket 370 inter-

face, this processor comes with
a heatsink alone and no fan. It
uses the 0.13-micron technology,
which consumes little power
(between 7 to 14 Watts) and heats
up considerably lesser than other
processors in its range. It's target-
ed at the budget—conscious buyer
not looking for top-of-the-class
performance.

Lavish and sleek

his stylish 15-inch monitor fea-

tures an easy-to-use onscreen
display and offers flicker-free dis-
play even at the highest resolu-
tion. Installation is simple due to
the plug and play feature. It occu-
pies very little desktop space and
can even be swivelled through 360
degrees. The featured pivot makes
switching between horizontal or
vertical display simple.

An expensive proposition

his socket 370-based mother-

board features five PCl slots
and an AGP Pro slot, which guar-
antees you high-bandwidth game-
play when coupled with a
high-end 3D card. It provides you
with four USB slots, so connecting
USB devices to it is no problem.
The board is a good buy as it sup-
ports both SDR and DDR RAM up
to 3 GB.

140 FHEERY

HARDWARE

Radar

All that’s new on the block—Bravish LCD monitor, lomega Zip
drive, ASUS TUA 266 motherboard and more

VIA C3 800 MHz
i

SPECIFICATIONS:

128 KB of L1 cache, 64 KB
of L2 cache, 0.13-micron
technology

Benchmarks:

SiSoft Sandra: 953 Mflops in
CPU Whetstones, 1635
MIPS in CPU Dhrystones; 7
minutes 18 seconds for
video encoding; 2 minutes
49 seconds for audio
encoding; 64.6 fps (normal
mode), 63.9 fps (high quali-
ty) and 58.8 fps (max set-
tings) in Quake I11; 499.17
seconds in the Photoshop
test; 19.4 units in Content
Creation

verdict | B |

VIA C3 800 MHz

Performance A M d
Build Quality 'EEY
Value for Money & &
Features Ah s
OVERALL h b A

+ Does not require a heatsink; Good per-
formance in day-to-day applications

- Comparatively high-priced

Price: Rs 4,000+taxes

Contact: eSys Distribution Ltd

Phone: 011-6420450

Fax: 011-6420431-52

E-mail: c3sales@esysmail.com

Bravish LCD Monitor

(15-inch) .=
i

o

SPECIFICATIONS:
Supports a maximum
resolution of 1024x768
Features: Average dot pitch
of 0.30 mm, includes 1built-
in multimedia speakers

verdict

Bravish LCD monitor (15-inch)

Performance h b b i
Build Quality h b b
Value for Money & & & &
Ease of use h b b

OVERALL A b A

+ Stylish design

+ Uses little desktop space

- Tricky placement of OSD buttons
Price: Rs 35,000

Contact: Wales Technologies

Phone: 022-3828100 Fax: 022-3877418
E-mail: mediaman@boma3.vsnl.net.in
Web site: www.walestechnologies.com

SPECIFICATIONS:
Supports the P-I1l Copper-
mine and Tualatin (0.13
micron) processors; ALi
M1651 north bridge and the
ALi M1535+ south bridge
chipsets; DDR RAM compati-
ble; five PCI slots; four USB
ports

Interface: Socket 370
Benchmarks: 1619 in 3D
Mark 2001; 15687 in SiSoft
Sandra; 23 MBps sequential
read; 4 MBps random read;
20 MBps sequential write; 5
MBps random write; 26.3 in
Content Creation

verdict

ASUS TUA 266 Motherhoard

Performance h_h

i
Build Quality d.

Features

'Y
Value for Money &
A
'Y

> > >

s
#
L)
s
[

OVERALL

+ Five PCI slots; Support for up to 3 GB
DDR RAM/SD RAM

- High price

Price: Rs 9,500

Contact: Rashi Peripherals.

Phone: 022- 8260258 Fax: 022- 8221012
E-mail: ho@rptechindia.com

Web site: www.rptechindia.com

November 2001



Smooth operator

This stylish Zip drive uses the USB
cable for both power as well as
data. Installing the drive is easy—sim-
ply connect the drive to your sys-
tem’s USB port and it automatically
gets detected. You don't even need
to reboot the system. After connect-
ing the drive, load the drivers provid-
ed in the accompanying CD and you
are ready to transfer data.

lomega Zip drive (250 MB)

SPECIFICATIONS

Features: USB cable, two man-
uals, stand for the drive, driver
CDs, a software for data

back up

Benchmarks: 7 minutes 58 sec-
onds to copy nine 10-MB files
from hard drive to Zip drive; 1
minute and 17 seconds to copy
from Zip drive to hard drive

verdict
lomega Zip Drive (250 MB)
Performance LX)
Build Quality (XX
Value for Money & & d
Featues b h A
OVERALL h i

+ Good looks and good bundled soft-
ware

- No superfloppies included

Price: Rs 11,050

Contact: Neoteric Infomatique Ltd
Phone: 022-4172600 Fax: 022-4185294
E-mail: sales@neoteric-info.com

Web site: www.neoteric-info.com

Speedster

he fastest processor available
Tin the market today, it uses the
new Socket 478 architecture com-
prising an arrangement of pins
called the micro pin grid array.
Due to this, the size of the proces-
sor is drastically reduced. The
processor returned excellent
scores in almost all the tests and is
a great buy for those who simply
want the best.

SPECIFICATIONS

Pin count of 478; 8 KB L1
Cache; 256 KB L2 Cache;
400 MHz system bus (100
MHz Quad-pumped)
Benchmarks: 25675 in SiSoft
Sandra; 234.6 fps (at
320x240 with all effects
turned off), 198.3 fps (nor-
mal mode), 182.3 fps (high
quality), 116.6 fps (at maxi-
mum settings) in Quake III;
45 units in Content Cre-
ation; 3963 in 3D Mark 2001

verdict

Pentium 4 2-GHz Processor

Performance h A A

Build Quality LEEX

Value for Money # & 4

Features A A A

OVERALL A A A

+ Fastest processor available in the mar-
ket

- Expensive

Price: Rs 28,000

Contact: Ockam Infotech Pvt Ltd

Phone: 022-6330375 Fax: 022-6347805
E-mail: sales@ockamindia.com

Web site: www.ockamindia.com

Pricey performer

his mainboard supports the
Tnew Intel P4 2 GHz processor
with Socket 478 interface. It has
onboard audio support through
the AC'97 Codec and can support
a maximum of 3 GB of PC 133
MHz RAM through the three
DIMM slots. A great buy if you
need the power of a Pentium 4
processor but do not want to use
RDRAM.

Epox 845-chipset
motherboard

SPECIFICATIONS
Interface: Socket 478
Features: Features the 845
chipset from Intel, six PCI
slots, four USB ports (two
onboard and two through
the add-on card), manual,
driver CD, data cables, con-
nector for extra USB ports
Socket Type: Socket 478
Benchmarks:

3963 in 3D Mark 2001;
25675 in SiSoft Sandra; 38
MBps sequential read; 7
MBps random read; 33
MBps sequential write; 9
MBps random write; 45
units in Content Creation

verdict

Epox 845 chipset motherboard

Performance h A

Build Quality LX)

Value for Money & & i

Features A A

OVERALL h Aok

+ Good packaging; six PCI slots and sup-
port for up to 3 GB of RAM

- Rather expensive

Price: Rs 9,000

Contact: Rashi Peripherals.

Phone: 022-8260258 Fax: 022-8221012
E-mail: ho@rptechindia.com

Web site: www.rptechindia.com

No magic here

he Jadoonet Elite Netbox con-
Tnects through a cable connec-
tion. The setup lets you configure
connection settings, e-mail set-
tings, video and remote control
settings and other netbox settings.
Although capable of viewing
Flash-enabled sites, it was slow
and didn't play any audio on
these sites. While it displayed
good audio streaming capability,
it was unable to stream video.

SPECIFICATIONS

Features: Smart Card securi-
ty, infrared keyboard with a
range of approximately 15
feet, remote control, built-in
e-mail, option of sending
voice messages and even
videos

verdict

Jadoonet Elite Nethox (Ethemet)

Performance h A A

Build Quality hh b

Value for Money & & i

Features A A

OVERALL hhoh

+ Good audio streaming; smart card

- No video streaming and poor browsing
through heavy graphics; no mouse
Price: Rs 7,990

Contact: Jadoonet Computers Limited
Phone: 022-4968892 Fax: 022-4950415
E-Malil: info@jadoonet.net

Web site: www.jadoonet.com
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More Info on

the software products tested.
Check out

Mindware

Just what you need

his software supports most of

the popular image formats
available today. In the interface,
you can choose from different pre-
view options such as Details, Large
icons, Small icons, or Thumbnail.
The other options included are
slideshow, full screen view, set as
wallpaper, to name a few. The soft-
ware is available for download for
a 30-day trial period.

SOFTWARE

Radar

Zbrush, MAGIC Dance Maker...the latest software in the market tested
and reviewed

Ibrowser

sl
= e

BN

=

Lo e e D rehe e L )

SPECIFICATIONS
Features: Offers inter-
face presets, Visual
Scrolling which lets you
view large images
effortlessly, has multi-
language support

verdict E
Ibrowser
Ease of use [ EEY
Features LK.
Performance h b
Value for money & &
OVERALL LR

+ Good interface

+ Supports large variety of formats
Price: Shareware

Web site: www.fcodersoft.com

t contains a plethora of tools and
materials to bring your imagina-
tion to reality—a blob of clay or gel
from the materials drop-down list
can be carved or stretched to cre-
ate a shape. You can also apply

some amazing lighting effects.
While you are creating your
model, everything is rendered in
real time.

ZBrush

SPECIFICATIONS

Size: 9 MB

Features: 19 palettes, can
export only to .bmp and
.psd format, the fibre
brush tool lets you paint
adjustable fibres such as
hair

verdict E
ZBrush
Ease of use b d
Features L XX
Performance h A A
Value for money #& # &
OVERALL L)

+ Great interface and tools

+ Small file size

- Exports in just .omp or .psd formats
Price: $585 (approx Rs 28,080)

Web site: www.pixologic.com

M Viewlet Builder 2

his is a tool for creating

viewlets, which are compact
and visually rich movie files. The
viewlet opens in its own Java win-
dow. You can choose different
fonts, add balloons, notes and
sounds to your slide from the tools
palette. It is useful for firms spe-
cialising in software publishing and
training and home users keen on
making interesting presentations.
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Viewlet
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SPECIFICATIONS
Features: Can select the
resolution for capturing
screenshots; can choose
from among different
fonts or font effects, add
speech balloons, notes
and sounds to your
viewlets

verdict | B |
Viewlet Builder 2
Ease of use h A
Features A A A
Performance b d
Value for money & & &
OVERALL LI
+ Easy to use

+ Extremely customisable

+ Does not require any extra plugins
Price: Freeware

Contact: ViewFinder

Tel no: 0265-750623

E-mail: viewlets@viewfinderindia.net
Web site: www.garbon.com
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Dance, baby dance

Dance Maker allows you to cre-
ate original dance tracks
through an intuitive interface. You
can add music to any of your
video clips using it. Creating songs
is quite simple due to the drag
and drop feature. The accompany-
ing CD includes sound files, which
can be imported while you are
creating a song. This version car-
ries support for DirectX plugins.

Old and dependable

OC has several configurable

options to suit your terminal
emulation needs; from the plain
Solaris telnet, to Linux with Mid-
night commander to BBSes acces-
sible from telnet. It's suitable for
modem or shell account/BBS
users and supports secure shell
connections. ZOC supports almost
all protocols used by earlier BBSes
even over telnet connections.

Musical notes

his software for playing MPEGs,

MP2s and DVDs works on
almost every operating system
and has low system requirements.
Although Videolan may not match
up to a software such as PowerD-
VD, you really mustn’t complain
too much since it is free. Opt for
Videolan if you don’t mind the
plain interface and are satisfied
with the features it provides.

Iconically speaking

Articons allows you to create or
modify icons in colour depths
of up to 16 million colours. While
modifying images you can give
them gradient or fill shadow or
mirror effects. You can save your
image as an image file or an icon.
You can download the trial version
of the software and use it for a
period of 30 days.

MAGIC Dance Maker

SPECIFICATIONS
Features: Real time mixer
with a five-band equalis-
er; supports 16 tracks of
audio, MIDI video or
BMP data

verdict
MAGIC Dance Maker
Ease of use h A
Features L
Performance A b
Value for Money # & d
OVERALL oA
+ Small file size
- Low on extra audio effects
Price: Rs 850

Contact: Microsoft Computer Services
Phone: 022-8729525

Fax no: 8727446

E-mail: sales@mwcdrom.com

Web site: www.mwcprom.com

SPECIFICATIONS
Features: You can define
your own custom trans-
lations for a certain key
phrase, which allows you
to build any keystroke, or
break/pause combo
required in some UNIX
terminals

verdict
Z0C 4.02
Ease of use A h A A
Features h b ohohi
Performance h b b
Value for Money & & 4
OVERALL h b ki
+ REXX Scripting

- Needs extensive keyboard mapping for
some terminal types

Price: $69 (approximately Rs 3,312)

Web site: www.emtec.com

[ L e =
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SPECIFICATIONS
Features: You can stream
files through the net-
work; the preferences
menu gives you a choice
of interface, colour
depth, gamma, and
audio options; other
options include slow
motion, chapter, and lan-
guage and subtitle selec-
tion

verdict | B |
Videolan Client
Ease of use h b b
Features Ah Ai
Performance A A
Value for Money & & & i
OVERALL h b h

+ Good features

- Needs a better interface
Price: Freeware

Web site: www.videolan.org

Articons 3.01

SPECIFICATIONS
Features: You can edit
.bmp or .jpg images up
to a resolution of
127x127; easy drag-and-
drop of icons between
shells and libraries; can
import a variety of image
files for modification and
export them to a format
of your choice; during
modification, you can
zoom in or out, or add
effects such as flip hori-
zontally, roll left and oth-
ers

verdict | B |
Articons 3.01
Ease of use h b h
Features Y
Performance A b &
Value for Money & & i
OVERALL h Ak

+ Good features and tools

+ Easy-to-use

Price: Shareware

Web site: www.aha-soft.com
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For your first site

f you're looking to get your

first Web site on the Net, then
this book should help you with
the task. The book helps
novices as well as HTML veter-
ans plan and build their own
site with the help of tools such
as Flash and JavaScript. The
book opens with a basic tutorial
on building a Flash Web site
and goes on to planning Web
pages, promoting and maintain-
ing your site, etc.

Reviews

Web Design with

HTML/Flash/JavaScript & E-commerce

Publisher: IDG Books India
(P) Ltd

Contact: Computer
Bookshop

Phone: 022-2070989,
2076356

Fax: 022-2623551
E-mail: cbshom@gias-
bmo01.vsnl.net.in
Price: Rs 399 with CD
Rating: & & &

For more of Flash

his book is meant for those

familiar with the essentials
of Flash and need to expand
their knowledge. The book cov-
ers advanced site design prin-
ciples, Flash content creation
and enhancement, ActionScript
concepts and techniques and
more. You can browse through
chapters on topics such as sim-
ple game routines, video in
Flash, sound in Flash and much
more.

E

Publisher: Shroff Publishers
& Distributors
Contact: Computer
Bookshop

Phone: 022-2070989,
2076356

Fax: 022-262 3551
E-mail: chshom@gias-
bmo01.vsnl.net.in

Price: Rs 600

Rating: & & &

Introducing C#

his is a comprehensive refer-

ence manual for all C# pro-
grammers. The book has an
extensive coverage of C#
semantics and .Net framework
compatible with the beta 2
release. The book starts with a
basic introduction to OOP con-
cepts and ends with an in-
depth look at advanced
programming techniques such
as Defensive programming and
Reflection.

Programmers’ introduction to C#

A Programmer’s
Introduction to G

ar

Publisher: Apress
Contact: Computer
Bookshop

Phone: 022-2070989,
2076356

Fax: 022-2623551
E-mail: chshom@gias-
bmo01.vsnl.net.in
Price: Rs 299

Rating: u & &
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Arena

For game reviews
check out,
Playware

On the Stands

Photosho 6 in an
Instant

This book, rather than relying
on text-based instructions,
takes you through all the func-
tions and features of
Photoshop with large-
screenshots and direct
step-by-step instructions.

Publisher: Hungry Minds
Contact: IDG Books India
(P) Ltd

Phone: 011-3260877, 3270877
Fax: 011-3275895

E-mail: idgbooks@vsnl.com,
hungryminds@vsnl.net
Price: Rs 129

Rating: & & &

Dreamweaver 4 in
an instant

Get familiar with the essen-
tials of Dreamweaver 4 with
the help of large screenshots
and direct instructions.

Publisher: Hungry Minds
Contact: IDG Books India
(P) Ltd

Phone: 011-3260877

Fax: 022-262 3551

E-mail:
idgbooks@vsnl.com, hun-
gryminds@vsnl.net

Price: Rs 129

Rating: & & &

Effective E-mail
Communication
This book helps you send out
more effective mails, and
make more effective use
of e-mail as a means of
communication. It covers  [{iFEHEE S|
the origins of e-mail, com- [T
posing effective
e-mail messages and

more. =

Publisher: Dreamtech Press
Contact: IDG Books India (P) Ltd
Phone: 011-3260877, 3270877
Fax: 011-3275895

E-mail: idgbooks@vsnl.com
Price: Rs 99

Rating: & & &
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Illustration: Mahesh Benkar

The best thing about
external modems is
that they are easy to
disconnect

UNDERCOVER

The right connections

Looking to buy a modem? Agent 001 investigates the relative merits of

internal and external modems

he market seems to be increasingly biased

towards internal modems, which are sold

more and recommended more than external
modems. So | decided that an investigation
was the need of the hour.

Down to the Mumbai by-lanes. The first ven-
dor | approached was an external modem advo-
cate since “they’re much easier to install”. That’s
true; the external modem involves nothing more
than getting the cable, plugging it in, and turning
it on. You won't have to bother with IRQ conflicts,
DMA channels, and the likes. But the dealer, on
the contrary, had different statistics in his shop.
The last 20-odd PCs that he had sold were all
installed with internal modems. His explanation:
internal modems have broken the psychological
barrier of Rs 1,000 and they work reasonably well,
so why not?

Internal modems have become extremely
cheap of late and are popular with system inte-
grators as they don’t add too much to the overall
system’s cost. Consumers don’t have to pay extra
for the fancy case and lights. They also save valu-
able desktop space and there’s no need for cables
and power cords.

So what kind of internal modems do these
integrators recommend and use themselves? | get
a view from another shop in Andheri. The ven-
dor says that he stocks only Dax internal 56K
models. The reason: they are priced at Rs 650.

AMR modems are available for Rs 350-500,
but then you need an AMR slot on your mother-
board for them to work. However, these modems
are generally not recommended by most dealers.

Modem Hang-ups

Despite the popularity of internal
modems there are certain issues that
you should be aware of. Internal
modems use a sizable amount of CPU
time. They also come with a minimum
CPU speed requirement and generally
cannot be installed on systems with
less than 150 MHz processing power.

On occasions, we've found CPU util-
isation going as high as 50 per cent on
an underpowered machine, which

severely impacts the PC’s performance.
There are some issues with installation
too. IRQ conflicts are the primary cause
for problems—if you are using an inter-
nal modem, try disabling the serial
ports to free up some IRQs. Apart from
these issues, if you're fairly proficient in
installing drivers and solving minor con-
figuration-related problems, then an
internal modem is the best and cheap-
est way to log on to the Internet.

However, the number of internal modems
which had to be replaced was significant, said the
vendor. He added that most users were confused
when it came to configuring an internal modem,
but once configured, it was a piece of cake.

Strangely, | found that the only vendor who
staunchly recommended the external modem was
someone who had fried a customer’s PC! He nar-
rated a freak incident when during a thunder-
storm the internal modem conked out and, in the
process, destroyed the motherboard and a couple
of other PCI devices. Whether the story is true or
not is not the point—the fact remains that inter-
nal modems are susceptible to freak cases of light-
ning strikes on local phone lines which can
potentially fry the modem as well as the PC. The
same could occur with external modems, it’s just
that the modem would be destroyed, not the PC.

I then moved on to Santa Cruz where a dealer
proudly mentions that he’s sold quite a few USB
modems. He said that USB modems could work
onany PC, Mac, and even workstations, as long as
a USB port is present. And one doesn’t need an
external power supply as the USB cable powers
the modem. However, the dealer added that these
modems have certain issues when it comes to
transfer speeds.

Another vendor recommended the US Robot-
ics Message modem which he found the most reli-
able in terms of speed and connection. This dealer,
more inclined towards external modems, said the
best thing about them is that they’re easy to dis-
connect. On many occasions the modem simply
stops responding and wastes call time. With an
internal modem, the only solution is to restart the
entire machine (waste more time), while to reset

an external modem, all you need to do is turn it

off and then switch it on again. The dealer rec-

ommended the DFM 560E 56K external modem
from D-Link; it gave him the least trouble with
driver installation and configuration.

Another vendor in the same area espoused
external modems. His reasoning: since they have
lights in front, you can tell what’s going on. He
recommended the internal modems from Cre-
ative and said that they were a bit expensive, but
that the component quality was high and the
brand name respectable. [

Want to share insights and experiences in buying computer
hardware and digital products?
Write in to readersletters@jasubhai.com
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HARDWARE
Monitors (14 & 15-inch)

Viewsonic E53

+ OSD support

+ No message signal if power cut off
Contact: Roop Technologies
Phone: 022-6631921/2/3/4

Fax: 022-6103919

Price: Rs 8,000

Monitors (17-inch)

ViewSonic PS775

+ Very good image quality

+ Support for high resolution
Contact: Roop Electronics
Phone: 022-6175213

Fax: 022-6103919

Price: Rs 28,000

Monitors (19 & 21-inch)

Samsung 955DF

+ Good build quality

+ Good colour results

— Screen clarity test fades out on

corners
|_'.‘_f:’ _a_g Contact; Samsung
|_.\_‘;!:___|-— Electronics India
| \ﬁ"}e _g | Information &
e Telecommunica-
L_ _ tion Ltd.

" G‘ Phone: 011-

6322517/8/9

Fax: 011-6932607
Price; Rs 31,000

146 FH

A-LiIst

A listing of the best products in different hardware and software categories

but only the winners get to this page—a list-

ing of the best performing hardware and

software that have been tested till date in differ-
ent categories.

Every month, at the Digital Media Test &

Research Centre, we carry out a series of com-

parison tests as well as individual product

Who’s in, who's out? The competition’s hot,

Graphics card

Contact: Compuage Infocom

reviews. Based on these tests, the best products
have been listed here (detailed reviews in Digit-
Interactive Mindware). As different products get
reviewed over the months, the top products
might find themselves slipping out of the charts
and replaced by the latest entrants in the market.
So, keep your ears sharp and eyes open and keep
yourself abreast of the latest cool products.

CD drives

ASUS CD-5500

+ Good performance

= Slightly inferior build quality
Contact: Rashi Peripherals
Phone: 022-8260258

ASUS V8200 GeForce3 Phone: 022-4913986
Deluxe Fax: 022-4919069

+ Unsurpassed video quality and Price: Rs 14,625
speed

—Needs a fast CPU to get maximum Motherboards
result ASUS PAT

Contact: Mnemonic Systems
Phone: 022-8010871

Fax: 022-8051761

Price: Rs 29,500

+ Good feature list
Phone: 022-8260258
Fax: 022-8221012
Price; Rs 15,500

Processors

+ Fits into any ATX cabinet

Contact: Rashi Peripherals

Fax: 022-8221012
Price: Rs 2,250

CD-RW drives

Plextor PX-W1610TA

+ High write and rewrite speeds
Contact; Zeta Technologies
Phone: 022-4102277

Fax: 022-4102288

Speakers

Creative SoundWorks
DTT2500

+ True Dolby Digital-compliant
sound

—Too clumsy stand for speakers
Contact: Compuage Infocom
Phone: 022-4913986

Fax: 022-4919069

Price: Rs 28,600

+ Good packaging

Contact: Ockam Infotech Pvt Ltd
Phone; 022-6330375/6338764

Fax: 022-6347805
Price: Rs 28,000

‘ Hard disks (IDE)

Pentium4-2 GHz

+ Excellent performance

N Price: Rs 11,500
i
DVD drives

Aopen 1640 Pro DVD

+ 16x DVD speeds; 512 KB cache
+ Good build quality

- Does not support DMA

Contact: Yogi Comp
Phone: 022-8806582

IBM Deskstar

Fax: 022-8806582

IC35L040AVER07-0-41GB Price: Rs 5,650
Soundcards +Silent
SoundBlaster Live! + Remains cool even during peak Laser Printers
Platinum 5.1 *ﬂ performance Lexmark Optra M412
+ Dolby Digital AC-3 "™ Contact: Wales Technologies + Good print speeds
compliant Phone: 022-3828100 —LCD management screen
+ High quality sound Fax: 022-3828200 Contact: T.V.S. Electronics
processing ! Price: Rs 7,300 Phone: 044-2325506
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Fax; 044-2327577
Price: Rs 42,995

Inkjet Printers

Epson Stylus Color 830
+ Very quiet; good results

+ Print resolution of 2880 dpi
Contact: Epson India

Phone: 022-8257286

Fax: 022-8267287

Price: Rs 18,000

Fax: 022-5379719
Price: Rs 1,19,000

External Storage Devices

IOMEGA 2GB Jaz

+ Very good price per MB; hard-
disk-class performance
Contact: Neoteric Infomatique
Phone: 022-4172600

Fax: 022-4163679

Price: Rs 17,300

Pointing devices

Logitech Cordless Mouse-
man Wheel

+ Good accuracy with features;
resilient to dirt

+ Many extra function keys
Contact: Rashi Peripherals
Phone: 022-8260258

Fax: 022-8190766

Price: Rs. 4,500

SOFTWARE
PCs Handhelds Operating systems (Windows)
Dell Dimension 8100 Compagq iPAQ H3630 Windows 2000
+nVidia Geforce3 at work + Very feature packed Professional
+ Good build quality and well + Powerful processor, multimedia + Very stable

designed cabinet

Contact: Dell Computers

Phone: 1600338044 Toll free

Phone: 1600338046 Toll Free (Prod-
uct Specific)

Price: Rs. 98,134/- (varies according
to configuration)

Scanners

Epson Perfection 1640SU
+ Transparency unit included as
standard accessory

+ Fast image scanning

—Too bulky (4.5 kgs)

Contact: Epson India

Phone: 080-5321266

Fax: 080-5581799

Price: Rs 22,500

Laptops

Nishubuki 1 GHz

+ Attractively priced

- Low end graphics card
Contact: Nishubuki Computer
Systems

Phone: 022-5825965

;
|
|

capable

Contact: RADZ Technologies
Phone: 022-3678293/3678297
Fax: 022-3678193

Price: Rs 39,000

MP3 players

Creative NOMAD 2MG
+ Excellent build quality
+ Supports WMA format
and upgradeable
firmware

- Controls not eas-
ily accessible
Contact: Compuage
Infocom

Phone: 022-4913986
Fax: 022-4919069
Price: Rs 22,100

Digital cameras

Sony Cybershot DSC-P1
+ Good features

- Limited memory

Contact: Best International

Phone: 022-2611050

Fax: 022-2624795

Email: bestint@vsnl.com
Price: Rs 49,990

Keyboards

Logitech Cordless Freedom
Navigator

+ Very comfortable

+ Extensive configuration options
Contact: Rashi Peripherals

Phone: 022-8260258

Fax: 022-8190766

Price: Rs 7,900

— Heavy on system requirements
Contact: Integrated Business
Solutions

Phone: 022-8214701

Fax: 022-8328240

Price: Rs 8,200

Office suites
Microsoft Office XP
+Rich features
—Expensive

Contact: Microsoft (India)
Phone: 011-6294600
Price: Rs 19,250

Page layout
Adabe InDesign 1.5.2

(3

+ Intuitive Interface

+ Supports layers, masking, gradient
and text on path

Contact: Adobe Systems India
Phone: 0118-4532026

Fax: 0118-4532010

Price: Rs 42,946

Operating systems

7.2

+ Simple to
install

+ Many bundled
applications

+ Customisable
interface
Contact: G. T. Enterprises
Phone: 080-6606093

Fax: 080-6671407
Price: Rs 3,000

Web authoring

Macromedia
Dreamweaver4 ver.4.0

+ Extensive feature support

+ Integrates with other packages

- Intimidating for first time user
Contact: Wipro Infotech Enterprise
Phone: 080-8440011

Fax: 080-8440187

Price: Rs 14,250

Firewalls

ZoneAlarm Pro 2.6

+ Good performance

— No protection against ActiveX
controls

Contact: www.zonelabs.com
Price: Rs 2,000 (approx)

Image editing software

Adobe Photoshop 6.01
i

e

:.:'-‘.':;Jﬂ‘#

it
+ Inclusion of vector shapes
+ Layers can be grouped and
coloured for easier identification of
images
- Too resource hungry
Contact: Adobe Systems India
Phone: 0118-4532026

Fax: 0118-4532010
Price: Rs. 39,456

Voice recognition

Dragon NaturallySpeaking
v5.0 (Preferred Edition)

+ Impressive speech recognition
—High on system requirements
Contact; HCL Infosystems

Phone: 011-4526518

Fax: 011-4526579

Price: Rs 17,995

Accounting software

FACT 1.90

+ Exhaustive feature list

— No security for database
Contact: Vedika Software
Phone: 022-5006490

Fax: 033-2400824

Price: Rs 14,500
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m digit diary

| am an

or us at the editorial desk at Digit, finding
the right stories, testing the latest in digital
technology or finding the right software for
the CD month after month is an exciting
adventure. An adventure that would start early
every month with long brainstorming sessions,
chats, meetings, interviews, references and
downloads. The stories and reviews

A midnight brush with a
law keeper and an
exposé on the
shenanigans of the
‘news makers’

would then flow into the |[ EHECE PE_;-ﬂI[ "

copydesk for their
master  strokes t,'E;
(strikes) before we "7
are ready to go to &=l
print. There would be q'ﬁ;g.'“ i
heated debates, ot
exciting discus-
sions, flashes of
inspiration

+

and, well, a few ¥ B
goof ups here ‘=t

and  there. i
After that,

there is a big _ st
sigh of relief

on the day the issue

closes and then we stretch ourselves long enough
before we start with the next issue all over again.
But as our Multimedia Coordinator, V. Ravi
Shankar, recently found out, the excitement does
not stop there.

Aaj ki Taazaa khabar...

One of the ways we stay up on our tech toes is

through newsletters created and circulated internal- ye pet maange more ;-))

(Anyone ordering cakes from Monginis? hehehe

Indian

It was late one evening towards the end of the
month, when Akhilesh, our Head of Logis-
tics/Distribution and Ravi decided to hop into
an autorickshaw and supervise the dispatch of
Digit to the various points in town from the
printer. They landed right in the middle of the

action with copies being printed,

bound, packed, labelled and
loaded into waiting tempo

z vans. In an hour the
vans were ready to
move with Akhilesh
and Ravi in the

driver’s cabin.

It was well past
midnight  when
the vans cleared
the Octroi posts in
New Bombay and
wended their way

into town. Just as
they entered

Mumbai, a cop

stopped the vans
and walked towards them

lﬂjh__-'i:‘:ﬁm'fsﬂmﬂ
ie;i |
w 5‘1:'1

lilustration: Mahesh Benkar

waving his torch.

He checked the documents that the driver
produced. He looked unconvinced. “Packet
Kholke Dikhao,” (Open the packets) he ordered.
Akhilesh and Ravi dutifully got out and dug out
a brand new copy of our
Cool Technology magazine
for the cop’s benefit. A big
smile broke across his face.
“Film magazine hai kya?~”
(Is this a film magazine?) he

ly by the team. But with most things Digit, these too

are filled with ‘attitude’. See for yourself... Hi folks,

asked staring at the female
model on the cover. It took

Hi folks,

Nothing exciting happened today. In other non
events that could be called ‘news’ comes SLUGBOT.
No, it's not a new botpack for CS, but a robot that
hunts over hundred slugs an hour.

Your newsletter for the day...

Hi,

The e-mail celebrates its 30th birthday as | send this
mail. It’s old now but comes to you everyday with a
new charming feature, a new mail which would
make your day. With tech takes like this e-mail has
along way to go... Lets sing the song, gang and
wish the e-mail a very happy birthday.

148 BATH

Your Technology take, your Tech lubing, a fresh serv-
ing of low cholesterol, fat-free hi-fibre tech tidbits!

Hi Folks,

I'm in no mood for inane banter here, and luckily for
me, a lot has happened over the weekend. The head-
lines: Gates still the richest man in the world. Comes
as no surprise.

Hi Folks,

Our ‘old’ pal Patty [Anil Patrick] is infected with
Nimda (no not his PC, it's he who is infected, lol) and
retired from the NL service. Now the NL is gonna be
crisper and better as in the interest of the Junta, | am
compiling the NLs, starting today.

Akhilesh and Ravi a while to
explain to him that Digit
was actually a ‘campooter’
magazine. He flipped the
pages and seemed con-
vinced. He let them go and
they boarded the tempo
with a sigh of relief. But the
cop still had a quizzical look
on his face and when they
were ready to wave him a
friendly good night, he
asked, “Phoren hai kya?” (Is
it foreign?). With a dash of
pride, Akhilesh and Ravi
replied, “No. Indian.”fl

November 2001



m backbyte

Seen these
new movies?

m Java waale job le jayenge

m Aao chat karein

m Programmer no. 1

m Memory aur hard disk

m H1 ko aane do

m Mouse ka gulam

m Skill apna apna

m Hum aapke memory mein
rehte hain

m Do processor barah terminal
m Password Apna Apna

® Hum Hain Programmer
Oracle ke

m Ek programmer do body
shopper

m H1 se Citizenship tak

= Mera code chal gaya

= Har Din jo mail Karega

m Mera Resume Kora kagaj
m Khel Virus ka

= Programmer bane
Bodyshopper

= Network Ke Us Paar

m Aayi Production Ki Bela

m Do Gateways

m Debugging koi Khel nahin
m Helpdesk ki Aatma (Ramasay
bandhu ki Horror film)

=m Mera naam developer

m Kaho na Bench hai

m Crash kar di aaapne

m Pati patni aur computer
m Deployment ki raat
m Hum WALK-IN ja chuke
sanam
m Jis Desh mein Bill(gates)
rehtaa Hai
m Hum To US jaayega
m Aa ab KUCH KAAM kare
Contributed by: Deepak Dhingra

Highlight the lighter side of
computing. Mail your contributions
to Backbyte

Digit, Plot D-222/2,

TTC Industrial Area, MIDC,
Shirvane, Nerul,

Navi Mumbai 400 706

or send e-mail to
backbyte@jasubhai.com
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Technology explains
modern art

If appreciating modern art is a problem for you, then
you'll definitely identify with this cartoon!
Contributed by: Anup Rungta, via e-mail

Contributed by: Ankur Raheja, via e-mail

T
)

| RETRO

. How Ping Pong came along
. While we may all go gaga over Counter
Strike today, we still must pay homage to
the game that made it big out there before
. all others. Nolan Bushnell is the man who
created the video game version of Ping
Pong, and in order to market it, set up a
small company whose name is a polite
samurai warning to his opponent before
attacking: Atari!
While Ping Pong made it really big and
1 even managed to knock out the then
favourite, Pinball, it wasn’t exactly the first
game that Bushnell created. In 1971 Bush-
nell and an associate created and sold the
first coin operated game called Computer
Space. But the game bombed in a big way
because players found the game too com-
plex, what with its ‘thrust’, ‘fire’ and
‘rotate’ controls! Go figure!

1

eaders Rants

Copying tracks?
Don’t be stupid!

All you audio buffs out there will agree that CD ripping
software is the next best thing since Napster went out of

I SR S H-Hﬁﬂ’iﬁﬂ
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service. But a lot of people won’t agree with this point of
view, especially the music lables and stars. And Shania
Twain seems to be telling one of our readers here exact-
ly what she thinks as he tries to copy one of her popular
tracks!

Contributed by: Colin D’mello, via e-mail

Catastrophe in the making

No one likes coming across an error when you pop in your
favourite movie CD and are all set to sit back and enjoy the

Ry

rest of the afternoon. But imagine the angst if you were to
come across an error message like this one!
Contributed by: George V, via e-mail

Confused with time

Back in school, probably the
i | most difficult task that a lot of
it us faced was memorising all
those historical dates. While
that’s understandable for us
humans, it does seem a bit
funny when your PC starts hav-
ing a problem with dates too!
Contributed by: Hussain,
via e-mail
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